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Upgrading to Enterprise Developer for
Eclipse

This guide provides information on upgrading applications from earlier Micro Focus mainframe
development environments to Enterprise Developer for Eclipse. It highlights the differences between the
old and new products, and offers solutions on how to keep your application working in the same way as
before. The guide also introduces the new concepts and features of the Integrated Development
Environment.

i Note:

» This documentation uses the name Enterprise Developer to refer to Enterprise Developer for
Visual Studio and Enterprise Developer for Eclipse. The full product names are used only when it
is necessary to differentiate between the two products.

Benefits of Upgrading

You get a number of important benefits by upgrading to Enterprise Developer from earlier Micro Focus
development systems or other COBOL systems.

Enterprise Developer uses a proven industry Integrated Development Environment that supports
thousands of clients for developing and deploying critical business applications. Enterprise Developer
enables unified, collaborative, and cost-effective development through rich, industry-standard tooling and
at the same time it helps minimize skills shortages, expands market reach and accelerates time-to-delivery
to meet today’s agile business requirements.

Licensing Changes

For a number of years Micro Focus used the Micro Focus License Management System on Windows and
Micro Focus License System Administration on UNIX for Net Express and Server Express.

Micro Focus now uses a standard industry technology for license management, Sentinel RMS from
SafeNet. New product releases use Sentinel RMS, as do updates to existing products.

For more on the Micro Focus Licensing Administration Tool, see Licensing or Installing in the Enterprise
Developer help.

Resolving conflicts between reserved keywords and data
item names

Micro Focus continues to enhance the COBOL language, for example, by expanding the list of reserved
COBOL words and adding new keywords to it as part of new levels of the COBOL language. Each Micro
Focus release corresponds to a particular level. You can use the MFLEVEL Compiler directive to enable
Micro Focus-specific reserved words in your code and change the behavior of certain features to be
compatible with a specific level of the language.

If you use Enterprise Developer to compile applications created with an older Micro Focus product, and
these applications use data names that are now reserved keywords in Enterprise Developer, you receive a
COBOL syntax error COBCHO0666 ("Reserved word used as data name or unknown data description
gualifier"). To work around this issue and continue using some of the reserved words as data names in
your source code, you can either:
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» use the REMOVE Compiler directive to remove individual keywords from the reserved words list

» setthe MFLEVEL Compiler directive to a lower level which corresponds to the level your applications
are at (see the information about MFLEVEL of some Micro Focus products further down this section).
This removes all reserved keywords which have been added for levels above that level from the
reserved words list.

You can set both directives from the command line, in your source code, or in the Additional Directives
field in the project's COBOL properties.

Setting directives from the command line
To use REMOVE from an Enterprise Developer command prompt, type the following:
cobol myprogram.cbl remove(title) ;

The command above removes TITLE as a keyword from the language so you can use it as an identifier in
a COBOL program.

To use the set of reserved words that was used for Net Express v5.1 WrapPack 5, use this command line:
cobol myprogram.cbl mflevel"”15" ;

Setting directives in the source code

To set either one of the directives in your source code, type the following starting with $ in the indication
area of your COBOL program:

$set remove ""ReservedWord™

Or:
$set mflevel'nn"

Setting directives in the IDE
To set either one of the directives in the project's properties:

1. Inthe IDE, click Project > Properties > Micro Focus > Project Settings > COBOL.
2. Type MFLEVEL"nn" or REMOVE "ReservedWord" in the Additional directives field.
3. Click Apply and then OK.

Importing Existing COBOL Code into Enterprise
Developer

Enterprise Developer includes a Net Express Project Import Wizard that converts Net Express projects into
Enterprise Developer projects and imports the COBOL source code into the IDE.

To import Net Express projects

The Net Express project format is not the same as the project format in Enterprise Developer for Eclipse so
it is not possible to edit Net Express projects in Enterprise Developer directly.

You can use the Net Express Project Import Wizard to convert existing Net Express projects into Eclipse
projects, and to import the COBOL source into the IDE. Click File > Import > Micro Focus > Convert
NetExpress Projects. The wizard analyzes your Net Express project, converts it to the appropriate project
type and sets directives as needed.
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To import files

In Eclipse, you import files into your project using File > Import. This automatically adds to the project all
files from the project directory, the subdirectories and from any linked directories. To prevent a file from
being compiled, right-click the file and click Build Action > Ignore.

To scan files and set directives

In Eclipse, to set directives on COBOL files, use the file properties, or the Determine Directives command
from the context menu for the files in COBOL Explorer. This triggers file scanning and sets directives as
specified in Window > Preferences > Micro Focus > COBOL > Directives Determination

Recompile all source code

Application executables that were compiled using earlier Micro Focus products must be recompiled from
the sources using Enterprise Developer.

If you do not recompile, you may receive an error. The exact error depends on the operating system you
are running. The error might be similar to this, on UNIX:

Id.so.1: rts32: fatal: libcobrts.so.2: open failed: No such file or directory
Killed

You can recompile from the IDE or the command line.

Upgrading from Mainframe Express to Enterprise
Developer

Note: This document is a work-in-progress. Check the documents available for Enterprise Developer
in the Product Updates section of the Micro Focus SupportLine Web site for its most recent version.

What is Enterprise Developer

Micro Focus Enterprise Developer is specifically designed to upgrade the Micro Focus Mainframe Express
product and provides a contemporary development environment for zEnterprise that enables you to
modernize mainframe applications for deployment back on the mainframe or any of the z/Enterprise
partitions. It provides for mainframe integration, workflow management and supports development and unit
test environments.

Enterprise Developer is a powerful integrated development environment (IDE) that provides the ability to
move development mainframe activities off the mainframe, providing agility, flexibility and direct access to
new technologies and trends. It offers both Eclipse and Microsoft Visual Studio as standard IDEs, and in
addition provides the development tools required to develop applications for deployment on platforms other
than the mainframe.

Enterprise Developer supports COBOL, PL/I 1, IBM Assembler, CICS, IMS-TM, JCL, DB2, IMS-DB, z/0OS
file formats and the common batch utilities, including SORT. As a result of this compatibility, the day-to-day
analysis, edit, compile, and debug tasks - necessary to maintain and improve core online and batch
applications -can all be undertaken on a Windows workstation. You can use a dedicated workstation or
laptop for development and unit testing which means development and testing can be moved away from
the mainframe.

Enterprise Developer is part of the Micro Focus Enterprise product set - a complete solution to help
organizations through the mainframe modernization journey. It includes Enterprise Analyzer, Enterprise
Test Server and Enterprise Server in addition to Enterprise Developer. Applications developed or updated
using Enterprise Developer can then be fully tested under Enterprise Test Server before being deployed
back to the mainframe.
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Alternatively, Micro Focus Enterprise Server can be used to redistribute application workload by providing
an alternative production platform off the mainframe.

Micro Focus Enterprise Developer revolutionizes the way mainframe development is performed.

Different versions of Enterprise Developer

The following Enterprise Developer options are available for either Visual Studio or Eclipse:

Micro Focus Enterprise Developer Connect is for customers looking to use modern and productive
Enterprise Eclipse-based tooling to develop mainframe applications directly on the mainframe.
Developer Close integration to mainframe configuration management systems and the ability to
Connect easily customize the Eclipse-based IDE to include mainframe-based tools and

processes means developers can take full advantage of modern development tools
without having to learn new development processes.

Micro Focus Enterprise Developer is for customers looking to develop and modernize mainframe
Enterprise applications in a productive and modern Windows-based development environment,
Developer targeted for deployment onto an alternate server platforms. Developers have the

choice of either the Visual Studio or the Eclipse-based IDE and development and test
tools are provided for all target environments currently supported by Micro Focus.

Micro Focus Enterprise Developer for IBM zEnterprise gives customers the choice to develop

Enterprise directly on the mainframe or under Windows. Mainframe applications can be

Developer for developed, maintained and modernized regardless of where they will be deployed,

IBM zEnterprise either back onto the mainframe or onto an alternative server environment. Support is
provided for both the Visual Studio and Eclipse-based IDEs and for all the
development and test tools for every target environment currently supported by Micro
Focus - including z/Linux, AIX and x86 environments. Enterprise Developer for IBM
zEnterprise combines all the capabilities of Enterprise Developer Connect and
Enterprise Developer.

Full mainframe integration and the Application Workflow Manager are only available in
the Eclipse-based IDE.

Enterprise Developer Connect

Enables you to develop mainframe applications directly on the mainframe. Close integration to mainframe
configuration management systems and the ability to easily customize the Eclipse-based IDE to include
mainframe-based tools and processes means developers can take full advantage of modern development
tools without having to learn new development processes.

Enterprise Developer

Enables you to modernize mainframe applications and move them to an alternative platform. This option
again uses either the Visual Studio or Eclipse-based IDE and supports development, local and remote
debugging, and testing across all major supported open platforms.

Enterprise Developer for zEnterprise

Enables you to modernize applications for deployment anywhere on zEnterprise. It uses the Visual Studio
or Eclipse-based IDE, mainframe integration and workflow management, and supports development and
testing on z/OS, z/Linux and AIX and x86 environments. Supports local and remote debugging, building
and deploying applications across zEnterprise and includes the Application Workflow Modeling feature.

For more details about the product editions, see Product Editions at: https://www.microfocus.com/products/
enterprise/enterprise-developer.aspx

Advantages to upgrading to Enterprise Developer

Micro Focus recognizes the investment that our mainframe clients have made in Mainframe Express - and
the great working partnerships we have established as these products have evolved. It is these close
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working relationships that have formed the development and release of the new generation of mainframe
development applications.

In Enterprise Developer we have created a product that represents the natural evolution of Mainframe
Express: it's a seamless transition into the next generation of mainframe IDEs. It protects your existing
investment and future-proofs your operation going forwards. Lapsed Mainframe Express users will quickly
become converts - this is a feature-rich product with appeal right across the board.

Whatever your level of engagement with Mainframe Express, as an existing Micro Focus customer we
developed Enterprise Developer to maximize the investment you have made in our technology and protect
it moving forward.

Using the Enterprise Developer enhancements and modern IDEs have numerous advantages such as,
among others:

Improved This is achieved through:

roductivit . : .
P y Using of the very latest IDE technology in a powerful integrated development

environment

« Replicating mainframe environment on Windows; through easier sharing of
development resources.

* Ready access to mainframe-based elements while removing unnecessary burden on
the host.

» Fast and easy customization with major source control systems, integration with
existing development lifecycle, and built-in extended IDE user interface for higher
developer acceptance and productivity gains.

« Provides the tools to allow you to edit, compile, debug, execute and test applications
on all supported Micro Focus UNIX and Linux environments including z/Linux, AlX,
HP UX etc. One development tool can how meet your development requirements
today and in the future.

« Enables cross-language application development which results in better quality and
increased competitiveness.

« Full control of development activities directly on the mainframe through the Eclipse
IDE to edit, execute, debug and unit test applications.

* Achieve faster time to market

» By using workstations to shorten the mainframe development and unit test cycles,
and deliver new products and features faster.

Improved Improve efficiency when performing day to day mainframe development activities on or

efficiency off mainframe, enabling access to standard IDEs of choice, smart editor, instantaneous
compilations, advanced test and debugging capabilities.

Address Using COBOL from within standard IDEs helps reduce the gap between the mainframe

mainframe COBOL and Java or C# developers by providing a unifying, collaborative and dynamic

skills shortage development environment. Non-COBOL developers, can quickly and easily adapt to the
COBOL language, and get up to speed in no time.

For a full list of the advantages of using Enterprise Developer, see the Enterprise Developer data sheet
and white papers on the Micro Focus Web site.

Approaches to upgrading your applications

There are different approaches to upgrading existing mainframe applications to Enterprise Developer in
order to modernize them.

Starting over and rewriting your application in Enterprise Developer is not recommended as this means
more costs, the need to do more testing and, potentially, incurs more risks.
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You can keep the existing application intact and only create new front ends in Enterprise Developer that
will interact with the application.

Or, and this might be the best approach and lower risk one in most situations, is to upgrade your
applications and processes using incremental steps. In order to reduce the maintenance backlog and
ensure that the applications have the flexibility and agility that the business needs. Using this approach:

* You upgrade your application one small step at a time, testing the change and planning for the next one
on each phase.

» Start by only moving a small subset of the files in Enterprise Developer. This could mean only a small
number of the people on your teams are involved with making the changes.
< Maintain the application using both Enterprise Developer and Mainframe Express.

Considerations when upgrading to Enterprise
Developer

The following describes how you can move existing files and data from Mainframe Express to Enterprise
Developer:

Sources

You copy the COBOL programs and copybooks in the Enterprise Developer project directory or,
alternatively, from the Enterprise Developer you link to them in the original location where they are used by
Mainframe Express.

Data

« Datafiles - you can reuse the .dat files in Enterprise Developer. There is a Data File Tools utility for
editing data files.

- DB2

» IMS files - you can reuse the existing .dbd, .psb, and .mfs files after recompiling them in Enterprise
Developer.

« XDB

Metadata

» Data catalog - you need to create a new catalog in Enterprise Developer.

« CICS resource definition files (dfhdrdat.*) - you can copy the existing files and use them in Enterprise
Developer after performing a caspcupg to upgrade them.

Configuration

1. Regions - now available as instances of Enterprise Server which you need to create and configure.

Accessing the Mainframe

Enterprise Developer uses its own version of Mainframe Access OS/390 and z/OS Server that provides
access to host resources for environments. A single installation of Mainframe Access can support all of
these products, providing connectivity to any number of DB2, IMS, and CICS systems located anywhere in
an enterprise. It can also provide access to JES facilities, VSAM and non-VSAM data sets, and data
controlled by external library management products such as Panvalet, Librarian and Endevor. It includes
the Drag and Drop utility, the Remote Job Step Execution (RJSE) facility for execution of one or more
steps of a job on a remote z/OS host, Compare and Synchronization Monitor, and SourceConnect.

Enterprise Developer for Eclipse also provides a mainframe z/Server that provides the mainframe
integration. You use the Remote Systems view to access the mainframe.
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How to upgrade an application created with Mainframe
Express to Enterprise Developer

The following provides an outline of the incremental approach to upgrading a Mainframe Express
application to Enterprise Developer where you use both development products to maintain the application
while gradually moving the sources to the new IDE.

1. Review your Mainframe Express application:

« Create an inventory of the sources it uses, the copybook dependencies, data files, SQL, JCL and
IMS files, third party utilities, integrated preprocessors.

» Check what workgroups are used and what the workflow processes are, what repositories are used
to store the sources, what the build scripts and command line parameters are, how the application
accesses the mainframe.

Note: Use the MFECL command line utility of Mainframe Express to export the project details
to an .xml file which will include all project details at a glance - files in use, workgroups, output
and dependency folders, Compiler directives, project and file options. The command to use is:

mfecl /exportxml project-nane.mvp [ xm -fil ename.xml]
* Review the XML file to see what information it includes:

b —J<project :ane=“hankdemo.b ng
3 + <projectsettings>

83 <Workgroups>

-, -L-q."ﬂnh-.-llw

24 + <level description="System">

04 + <level description="Prodmction">

101 + <level description="Development">

118 < /workgroups>

11¢ + <conmponent name="TUDATECHV.MLC" tyvpe="zouroce assembler'">

125 + <component name="UTWOSCHMP.MLC" type="sonrce assembler">> g
131 + <conponent name="MBANE10D.BMS" type="sonurce bms"> i
135 + <conmponent name="MBANEZ20.BMS" tType="zonurce bms"> F
147 + <conmponent name="MBANEI0D.BMS" type="=zonroce bm=">

155 <component name="MBANEA(QD.BMS" type="sonrce bms">
156 <folder location=".\BMS\MBANE40.BMS" tyvpe="source bms" />

The file provides details about the project and file settings, as well as of the workgroup levels. You

are going to use this information when you are configuring the new projects in Enterprise Developer.

* Analyze the strengths and weaknesses of your application in the Mainframe Express environment
and to what extent it meets the business requirements. The application might be a good candidate
for being modernized by upgrading it to Enterprise Developer.

2. Define a small selection of the source files of your Mainframe Express application that you will move
across to Enterprise Developer as a start — this could be the files responsible for a single operation of
the application.

See Considerations for whether the files need to be recompiled in the new environment.
3. Prepare your original application:

* Replace any hard-coded paths in your Mainframe Express project with concatenated ones — to do
this, in Mainframe Express, click Project > Convert Paths to Relative.
e Backup the sources.
4. Create mainframe subsystem projects in Enterprise Developer.

In Visual Studio:
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a. Click File > New.
b. Under COBOL, click Native > Mainframe Subsystem Application.
c. Click OK.

To emulate workgrouping behavior in Visual Studio, you can create different projects in your solution
that will represent each individual level in the workgroup. For each project, you need to specify the
copybook paths that are for the respective workgroup level.

In Eclipse:
a. Click File > New > Mainframe COBOL Project.

To emulate workgrouping behavior in Eclipse, you can use copybook projects that will define the
copybook paths for each level, and you can add these projects as dependency projects to the ones for
the source files. See Emulating workgroups in Eclipse in this guide.

. Configure the projects in Enterprise Developer.

In Visual Studio, first turn off the automatic directive determination as you will be setting the directives
manually:

a. Click Tools > Options > Micro Focus > Directives > COBOL.
b. Disable Determine directives of files and click OK.

Configure the project properties:

a. Click Project > YourProject Properties and click the individual tabs to specify folder for the
generated files and any other COBOL, IMS, JCL and CICS properties.

You need to set exactly the same project properties as the ones set for the MFE project as taken
from the xm - fi | ename .xml file.

In Eclipse, to specify project properties:

< Navigate to the project properties, expand Micro Focus and set the project properties as taken from
the xm - fi | ename.xml file.

. Import the source files and establish a product baseline — use linking to add the files to the new projects
in order to store the files in their original location:

In Visual Studio:

a. Right-click your project in Solution Explorer, and click Add > Existing Item.
b. Browse to the directory which stores the sources of your Mainframe Express application.
c. Select the files to add, and click Add As Link.

This links the files to the project from within the original location and does not create copies of the
files in the Enterprise Developer project directory.

In Eclipse:

a. Right-click the project, and click New > Folder if you wish to add an entire folder, or New > File.

b. Click Advanced, and click Link to alternate location (Linked Folder) or, respectively Link to File
in the file system.

c. Browse to the folder in your Mainframe Express project that includes the files you wish to add, select
the folder or the file to add, and click Finish.

. Set individual file properties:

e In Solution Explorer in Visual Studio, or in Eclipse, in COBOL Explorer, right-click a file in your
project, and click Properties.
« Set individual file properties as taken from the xni - f i | ename . xml file.

. Compile the sources in Enterprise Developer.

In Visual Studio:
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e Click Build > Build Solution. Check the Output window for the progress and the result of the build.
In Eclipse:

* By default, Eclipse performs a build automatically as you are adding the source files. Check the
Console view to see if there are any errors.

9. Create and configure an enterprise server instance for the projects.

Check the xmi - fi | enane .xml file to see what regions the original application uses, and what its
settings are.
10.Run the application.

* Run JCL applications by submitting the JCL file — right-click the JCL file in your project, and click
Submit JCL (in Visual Studio) or Submit to Enterprise Server (Eclipse).

Use the Micro Focus Rumba emulator supplied with Enterprise Developer to connect to the
enterprise server instance you have created. Run the application in Rumba.

11.Debug and perform thorough testing.
12.Configure MFA and the Mainframe Explorer window or the Remote Systems view.

13.Plan for rolling out Enterprise Developer project and servers to your development and QA teams. Also,
organize relevant training for them.

a. As afirst step, ensure your project is configured as desired and that it builds successfully.
b. Distribute the project:

With Visual Studio:

You can use Visual Studio to create customized templates with the desired set of options and the
required source programs, and share these within your organization. Then, each user would be able
to import the templates from a shared network location into their Visual Studio environments. See
the Visual Studio help for more information on how to create, configure and distribute custom project
templates.

With Eclipse:

In your workspace, copy the project folder with all the files. You can store this on a shared network
location. Users need to import the existing project and sources locally in their workspaces.

Enterprise Server templates:

Create your own templates using the following command at an Enterprise Developer command
prompt:

mfds -x [repository type] [repository address] [server name] <options>
<user id> <password>

Distribute the server .xml files across your development teams. The file should be saved in the
%ProgramFiles(x86)%\Micro Focus\Enterprise Developer\etc\ServerTemplates
subfolder in the local Enterprise Developer installation folders.

Further Information and Assistance

Tutorials

To get up-to-speed with using Enterprise Developer to edit and maintain your mainframe applications,
check the Getting Started book in the help and, more specifically, the Mainframe tutorials. Start with the
tutorial "Getting Started with Enterprise Developer" which provides basic understanding of how the product
operates. Move on to the other tutorials which provide details about developing CICS, JCL and IMS
applications.
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Assistance

If you consider upgrading your development environment to Enterprise Developer, you can contact Micro
Focus' Technical Services for assistance. They have a utility that automatically converts Mainframe
Express projects to Enterprise Developer ones.

In addition, please note:

Differences between Mainframe Express and Enterprise Developer

A number of Mainframe Express features and technologies are not supported in Enterprise Developer or
are superseded by features provided by the new IDEs. The following list shows some of these differences:

Feature in Mainframe Express Feature in Enterprise Developer

Analysis Option Now available as a separate product, Micro Focus
Enterprise Analyzer, which is part of the Micro Focus
Enterprise product set.

AppMaster Builder (AMB) Available as an AddPack for the Eclipse-based Enterprise
Developer. Within the product, AppMaster Builder
projects are available from the AppMaster Builder
Perspective.

Automatic Catalog Import Available through the MFA Drag and Drop interface as
well as the option to catalog from the command line. Data
connect functionality is being checked.

CICS resource definitions You can reuse the CICS resource definition files in
Enterprise Developer after performing caspcupg. The cut-
down resource definition (PCT, FCT, PPT) are not
supported.

Command line utility (MFECL) The equivalent to MFECL is not available in Enterprise
Developer although command line options for much of
the tooling is available. In addition you can use the
standard facilities of the IDE. For example, in Visual
Studio, you can use the MSBUILD utility to compile your
sources, and PowerShell to manage solutions and
projects. In Eclipse you can use Ant scripts to compile the
code.

Easytrieve Not yet available. Micro Focus is investigating how to

Mainframe Express provided integrated support for provide this functionality in Enterprise Developer.

Easytrieve through an add-on option which allowed
Easytrieve applications to be edited, compiled and tested
within the Mgainframe Express IDE.

Editor Autofix Not available.
Interactive AMS Not available.
IMS T™ Enterprise Developer does not support the following IMS

TM and communication features:

e The IMS Message exit

e The IMS MFS Display exit

e The Mainframe Express IMS to CICS LUG6.2 Bridge.
e IMS86ALT

MAS SDK Not available.

a collection of utilities to automatically compile
downloaded source and provide reports on the outcome.
These are part of Mainframe Express and Studio 6.0 (Net
Express) and were developed for Windows.
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Feature in Mainframe Express

Feature in Enterprise Developer

MFA Server

MFENTMAP, the Entry Point Mapping facility

Outline View

Regions

Structured COBOL (S-COBOL) source code

Source code control systems

Mainframe Express used the Microsoft Common Source
Code Control (SCC) Interface to enable you to use the
functions of a SCC-compliant source control manager
with your IDE.

Template projects

Third party preprocessors

14 | Upgrading to Enterprise Developer for Eclipse

You need to update it to the version of MFA server that is
supplied with Enterprise Developer.

Run-time system support for MFENTMAP is available
and any existing configuration files will work.

Enterprise Developer for Visual Studio 2012 displays the
copybook dependencies of projects within Solution
Explorer.

Enterprise Developer for Eclipse includes an Outline
view that shows the program structure. Copybook
dependencies are shown in the COBOL Explorer as well
as in the Copybook Dependency view.

Enterprise Developer provides support for full multi-
tasking enterprise servers.

To upgrade applications that were created with
AppMaster Builder you need to install the AppMaster
Builder AddPack alongside Enterprise Developer for
Eclipse. See Upgrading from AppMaster Builder in
Mainframe Express for more details.

Enterprise Developer come with standard IDEs that
provide access to any SCC tooling with the appropriate
plug-in. For example, in Enterprise Developer for Visual
Studio you can use the Visual Studio Team Foundation
Server (TFS) plug-in or install VisualSVN to be able to
access your sources from SVN.

You can install various plugins with Enterprise Developer
for Eclipse that provide integration of the IDE with the
version control system you are using - for example,
subclipse for connecting to SVN, or eGIT for connecting
to git.

The way to create template projects is different
depending on what IDE you use Enterprise Developer
with.

With Enterprise Developer for Visual Studio, you can use
the Visual Studio functionality to create custom project
templates for COBOL applications. For more information,
see the Visual Studio help.

To distribute projects created with Enterprise Developer
for Eclipse, you need to copy the project folder in the
workspace with all of the contents. The users that are
going to use that project need to import it in their
workspace.

Syntax checking is supported for ECMs and for COBSQL.

In Enterprise Developer for Eclipse, to use third party
preprocessors or ones you have created yourself, open
the project's properties dialog box and select Micro
Focus > Project Settings > COBOL > Additional
Preprocessors. If you have a preprocessor currently
installed you can select it from the drop-down list,
otherwise check Use additional preprocessor and
directives and specify a preprocessor to use by entering
the PREPROCESS compiler directive and associated
values.




Feature in Mainframe Express Feature in Enterprise Developer

Time-Sharing Option (TSO) Mainframe Express supported the use of TSO
commands, CLISTs and REXX execs, which could be run
in TSO interactive (or foreground) sessions or in TSO
batch (or background) sessions, using the IDAEFT01
(IKJEFFO1) utility.

Enterprise Developer does not support the TSO
interactive. TSO batch (IKJEFTxx) is supported.

WinRunner You can now use the Micro Focus Borland testing suite.

A screencapture utility that was supplied with some
versions of Mainframe Express.

Workgrouping Workgrouping behavior is supported in a different way
through the use of dependency folder configuration and
configuring the loadlib paths for an enterprise server.

XDB tooling The XDB tools in Enterprise Developer are available from
the Start menu group for Enterprise Developer. In your
project, you need to set XDB as your precompiler in order
to view a list of the available XDB directives.

Emulating workgroups in Eclipse

The following is an example of how you can set workgroup levels Enterprise Developer. There are
numerous other ways in which the projects can be configured to work in this type of system. You can add a
larger number of additional directories to each copybook project (either as relative paths to the workspace
variable or as variables in their own right) which would allow for even more configurability.

Introduction

Enterprise Developer does not provide the Mainframe Express workgrouping mechanism out-of-the-box. It
can be emulated, though.

There are a number of features in the Eclipse framework, many of them relating to how projects are
created and operate together, which can help in creating a workgroup environment.

Using COBCPY

The Micro Focus Compiler uses the COBCPY environment variable to find all of the copybooks used in a
program compilation. Setting up a workgrouping environment by setting COBCPY so that the IDE can
inherit the settings has a few disadvantages.

« The IDE is not aware of any of the copybook locations used in the application which can lead to
undefined behavior.

« The COBCPY path is typically of such a length that some of the tools cannot handle, which could lead
to unexpected behavior.

» Each paths defined in COBCPY will always be searched during a when a compilation is performed.
With Eclipse using a background parse to provide a number of key features, this can cause excessive
delays in everyday operation. Though background parse can be switched off, this means you are not
going to receive the instant feedback in the editor.

Using copybook projects

Another approach you can take to include copybooks is to use copybook projects to store your copybook
directories. You can then add these projects as dependent projects to any other source projects which
allows the IDE to identify the copybooks for build operations.

As you can add multiple paths to each copybook project, each one of these projects can then represent a
"level" in the workgroup hierarchy. Multiple copybook projects can then be used to represent the set of
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levels in a potential workgrouping environment. There are many ways in which the final organisation can
be arranged; the important thing is that the IDE 'knows' about the files to be used for compilation.

The following sections show how you can recreate the various workgroup levels and use copybook
projects to manage the levels.

Creating folders for the workgroup levels
In your workspace, create folders that will represent your workgroup levels. For example:

« <workspace_dir>\PROD
o <workspace dir>\TEST
o <workspace_ dir>\DEV

Set up the project variables

To avoid having to set too many hardcoded paths, you can use the workspace local variables (visible to all
projects) to locate the root directories of the code.

1. Inthe IDE, click the Windows >Preferences.
2. Expand General > Workspace, and click Linked Resources.

This opens the Linked Resource configuration page:

fe Preferences
type filter text Linked Resources PrT v
4 General “ [#/] Enable linked resources
- Appearance ] ]
Capabilities I?.rag and u:Iru:uE iterns Dr?_.a fu:ulder.?r project
Compare/Patch ® Prompt () Copy (_'Link (_)Linkand create virtual folders
CD_”tE”tT}rF'ES’ Drag and drop itemns on a virtual folder
- Editors (®) Prompt () Link () Link and create virtual folders
Keys
. Metwork Connections
Perspectives Path variables specify locations in the file system. The locations of linked resources
Search may be specified relative to these path variables,
- Security Defined path variables:
Service Policies
- Startup and Shutdown Name Value New..
Tracing Edit
Web Browser
4 Workspace Remove
Build Order
|Linked Resources
Local History

. Ant

3. Click New to create a variable pointing to the root level of the workgroup level you want to use.

You can use a mapped drive letter, UNC name or a predefined location (such as c:\source\prod)
which then allows the projects to be shared among multiple users without having to make any changes:
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I Edit ¥ariable

Edit an Existing Path Variable

Edit: wariable's name and path value.

=] E3

Mame: | “rodws
Location: | M:HUN|PROD File... Falder...
@::l (04 I Cancel |

4. Repeat for each level that you need to set:

[l Preferences _ O]

Linked Resources =

= I
) ?n:.::uearance = | ¥ Enable linked resources
Capabilities Drag and drop ikems on a folder or praject -
Compare/Patch & prompt " Copy ¢ Link ¢ Link and create virtual Folders
Conkent Types
+| Editors Drag and drop ikems on & virtual Folder
Keys & prompt © Link © Link and create virtual Folders
#- Metwark Connections
Perspectives
Search Path variables specify locations in the file system. The locations of linked resources
M- Security may be specified relative to these path variables,
- Startup and Shutdown Defined path variables:
i WWeb Browser Name | walue | New... |
E-Workspacs (= ACPN M:\HUNVACPN :
E‘ﬁ;:; (= DEVD Wi\ HUNIDEVD
L' o i sk = INTB M:\HUN|INTE
o Ac calistory (=MOoDS M:HUNIMODS
5 Help (= PREP ME\HUN|PREP
% InstsljUpdate = Prodws Mz HUN PRCD
& Java [=5YST MAHUSYST
0T ‘Weaving
(- Micra Focus COBOL
- Plug-in Development
[ Remote Systams
#]- Fun/Debug t
4| 3
'ff) oK. Cancel
5. Click OK.

Remember that workspace variables are each defined on a per workspace basis - in a multi-user
environment, each user needs to perform this step themselves for each workspace they need when
developing their application.
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Create the copybook projects

For each level in the workgroup, you need to create a copybook project. To do this, use the COBOL
Copybook Project type and, for each project, give a name which reflects the name of the workgroup level
you want it to represent (for example, PROD, INT, DEV).

If you check the properties of a copybook project, you can notice there are no Builders set for it. This
means no compilation operation will take place if source code is found in the project location.

Adding files to the copybook projects

The quickest way to do this is by adding a single linked directory item which points to the physical location
of the root of the copy file location on disk. If you have never encountered linked resources in Eclipse
before, they work in a similar manner to a UNIX/Linux symbolic link.

1.

5.

Click File >New > Folder.

2. Click Advanced and click Link to alternate location (Linked Folder).
3.
4. Select the workspace variable that you created earlier which matches up with the root directory of your

Click Variables.

workgroup level. In this case, our variable was called PROD. Click OK and it should populate the folder
dialog as shown below:

[ Mew Folder M= E3

Folder

1, Location ‘m:ihuniprod’ may overlap another resource, This can { !
cause urepacted side-affects,

Enter or salect the parent folder:
|LeveI_F'm-:l

L L

E- 1 Level_ACPN -
41 (22 Level_DEVD

s 1 Level_INTE

1 Level_MODS

#-{ Level_PREP

13 Level_Prod

1 05 § aal SYST ﬂ

Folder name: |F"F!.DEI

<< Advanced

™ [ Usa default location
i~ [z, Folder is not located in the file system (Victual Folder)
(¥ [ Link to altarnate location (Linked Foldar)

|PrOD Browse... | [ yarisbes. . |

Choose file systern: |defaulk =

Ressobved bocation: Fils: fim: fhun/prod

Rm.meF#aws...I

(?) Frish | Concel |

Click Finish.

The IDE inspects the directory hierarchy for recognised COBOL types so they can be identified at a later
time when working with your source code.
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This project can be treated as a normal COBOL project and can have any directories it contains added to
the copy path as well as the ordering of any such directories altered.

1. Open the project properties dialog, expand Micro Focus > Build Path, and then click the Dependency
Paths tab.

2. Set Path type to COBOL Copybook Paths tab item

The set of paths that will be added to the copybook path is shown. If necessary, you can reorder the
paths as well as enable or disable directories.

The default is not to include any paths so some paths almost certainly have to be switched on. Here is a
typical entry for the copybook paths:

m Properties for Level _DEVD -HE
[Eros fte b Build Path ' £ 5
= Fesouron [
Buddsrs | Eud Precedsnce | 1= Projects “4 Copybook Paths |
= Micro Focus COBOL The copybook paths define the search onder of locations in whach COBOL copybooks will be searched For,
+1- Build Configurstions
B The currently defined copybock pathes ane:
| Project Settings o Level_DEVD
- R tirne Configur stion O s Level DEVDDEVD
Propect References [ e Lwel_DEVDDEVIEMESRIE ;Q
Refactoring History O e Lewel_CEWDDEVDICOBOL
PuunThtus) Setkings B (g Level DEVEDEVDICORETCH —I
B Lo Lewel_DEVDIDEVDICORYCICS
B Lo Lewel_DEVD/DEVECORYLIE —lEm"m'
B Lo Lewel_DENVDDEVDICORTIMAR
O (o Level_DEVDIDEVDERDEVOR Select i
[ g Lewel_DEVDDEVDWILFROC
O L Level DEVDDEVDPARMS it
O (o Level_CEVDIDEVDIFRUN
O Lo Level_DEVD, axternaiTockudders
7 ok | comel |

You have now created one level of your workgroup. You have created a single project with a workspace
variable pointing to the top level of the physical location of the code for your level in the workgroup. You
have also filtered out the COBOL source code items and have defined the copybook directory ordering for
this level.

Repeat the same process for each level of your workgroup that you wish to use. In this particular example,
there are seven levels defined.

Add the copybook projects as a dependency to a COBOL project

Once you have defined all your copybook projects, you can add them as dependent project to a COBOL
project for the source files:

1. Create a COBOL project to hold your source files.
2. Add the source code items which you are going to working with.

You do not need to add every item in the entire application - just the one with which you are likely to be
changing and/or debugging.

3. In the project properties, expand Micro Focus, and click Build Paths.

4. Click the Projects tab, and then click Add.
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This enables you to select the projects on which this one depends. The following example shows seven
levels have been added:

[0 Properties for ONLINE _ [O0] x|
Build Path - - -
+ Resouroe —
Buiders | Builld Precedence L= Projects Iﬂv prml
=) Micro Foous COBOL Usa this page b manage the projects on which the project depends.
- Buikd Configurations = =
Build Path 15[[! !I-‘DEL:'-'D" = |
g ; el
= Pm}e'_:t ‘Sel:l:nqs Bavel 1B Remove I
=1~ Run-tire Configuration -t -
Project References = Level_MODS
Ref actoring History = Level_PREP
FuunyDebuig Settings =HLevel_Prod
1 Level_SY5T

o] cmu |

5. Click the Dependency Paths tab and ensure Path type is set to COBOL Copybook Paths.

6. You can alter the order of the copybook projects as well as turn levels on and off according to what
workgroup levels you may be working with. This provides a highly configurable and user friendly way in
which to alter the copybook paths:

20 | Upgrading to Enterprise Developer for Eclipse



O Properties for OMLINE =] E

|| Build Path - L
+ Resource
Buiders Buid Precedence | L= Projects ' Copybook Paths ]
= mmmﬁom The copybook paths define the seanch order of locations in which COBOL copyboaks will be searched For,
+]- Build Configurations
Buld Path The currently defined copybook paths are:
&1 Project Settings E] S onme |
- Run-tire Conifigur ation O | & OMLINE] . settings
Project References [ L ONLINE Listing =28 |
Refactoring History O | o ONLINEJCOPYLIE (missing)
RunDebug Settings B & Levei_evn |
B B Level_INTE
S Level_sYsT - l
B 15 Level_acPn
 HLevel_PREP Select Al |
S Level_MODS =
B 15 Level_prod o |

@ ok | cowel

Distributing the copybook projects to multiple users

Once created, you can use the copybook projects as any other projects. Due to the way in which they
utilize workspace variables, if all users in a multi-user environment are using the same locations for the
source code on their local machines (or similarly named mapped drives) then the projects can be easily
shared.

If a user imports the copybook projects into their own workspace (provided that they have also defined the
workspace variables), then it should be a quick task to configure a workgroup hierarchy for all of your
teams. The copybook projects can be committed to SVN (or any other SCCS) and should not have to be
changed once created.

Differences between Enterprise Developer and Net
Express, Server Express and Mainframe Express

You can upgrade COBOL applications that were developed in Net Express, Server Express and Mainframe
Express to Enterprise Developer. The majority of the existing applications will continue to run in Enterprise
Developer without the need to change their code.

This guide lists the differences between Net Express, Server Express, Mainframe Express and Enterprise
Developer in the following areas:

Compiling and Having created a project in Enterprise Developer, you can either use the IDE or the
building command line to build.

Run-time systems There are some differences between the run-time systems supplied with Enterprise
Developer and those supplied with Net Express, Server Express and Mainframe
Express. This, however, will not affect your existing applications and they will
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Run-time system
technologies

Restrictions and
unsupported
features

Editing and
debugging

Eclipse integration

continue to run under Enterprise Developer - you only need to recompile the
applications from the source code with Enterprise Developer.

Some technologies behave differently and require some upgrade work.

Some features of Net Express, Server Express and Mainframe Express are not
available in Enterprise Developer. However, there are alternative techniques for
many of these features.

Much of the Net Express, Server Express and Mainframe Express functionality for
editing and debugging is available in Enterprise Developer, but sometimes with a
different name and with a slightly different behavior. In addition there are some new
features such as background parsing, which highlights errors as you type and code
completion techniques that provide easy access to language elements, enabling
you to select and insert them simply.

Enterprise Developer is integrated with the Eclipse IDE. The development
environment provides all the functionality to manage projects and debug
applications.

Applications previously built in Net Express, Server Express and Mainframe
Express can be developed and run within the Eclipse IDE.

Summary of Differences

The majority of the applications created with Net Express, Mainframe Express or Server Express will
continue to work in Enterprise Developer without any changes. However, there are some differences
between these development systems you should consider when you upgrade to Enterprise Developer.

Compiling and Building Differences

There are several aspects of compiling and building applications that behave differently in Enterprise
Developer. You might need to change the project properties and update some of the Compiler directives
and settings that you previously used.

Output File Formats
on page 30

Each project compiles into a single file (.dll, .so or .exe), or to multiple files of
the same file type with one output file for each source file (.dll, .so, .exe, .int,

or .gnt). As well as an .Ibr file, which contains a collection of .int and .gnt files on
Windows, you now can use a .dll as the container for application components.

Compiler directives on When you upgrade your source code to Enterprise Developer some Compiler

page 30

Linking on page 31

directives that were specifically designed for 16-bit systems now produce an
error on compilation because they are no longer relevant. You should remove
them from your code and directives files before you compile.

The static run-time system and the single-threaded run-time system on
Windows are no longer required and they are not shipped with Enterprise
Developer. Applications built with Enterprise Developer are now linked to the
shared or dynamic run-time systems. On UNIX, you can link to the single-
threaded or multi-threaded shared or dynamic run-time system.

Called Programs and At run time, called programs are found in the same way as before. However,

Dependencies on
page 31

File Handler on page
32

there are some new ways to set COBPATH and copy files into a common
folder.

The File Handler .obj files are not available in Enterprise Developer. Enterprise
Developer uses the File handler packaged in the mffh._.dl1 file instead.
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Makefile Conversion  You cannot use existing makefiles from Enterprise Developer for Eclipse,
on page 32 although where they invoke commands supported by Enterprise Developer they
will continue to work as before.

SQL Compiler When you upgrade your SQL appplications to Enterprise Developer, some
Directive Options on  applications could require additional SQL compiler directive options to avoid
page 32 compiler errors.

XML PARSE In Net Express, the default setting for the XMLPARSE Compiler directive is
Statement on page COMPAT, which causes the XML PARSE statement to return information and
32 events for IBM Enterprise COBOL Version 3. In Enterprise Developer, the

default is XMLPARSE(XMLSS), which returns information and events for IBM
Enterprise COBOL Version 4.

Run-Time System Differences

There are some differences between the run-time systems supplied with Enterprise Developer and those
supplied with Net Express, Server Express and Mainframe Express. These, however, do not affect your
existing applications if you recompile them from the source code in Enterprise Developer.

OpenESQL on page 32 Enterprise Developer sets the BEHAVIOR SQL Compiler directive option
to MAINFRAME by default to provide optimal performance. To revert to the
default behavior exhibited in Net Express, set the BEHAVIOR directive to
UNOPTIMIZED.

Single-Threaded Run-Time The single-threaded run-time system is not available in Enterprise

System on page 32 Developer on Windows. Instead, both single-threaded and multi-threaded
applications run using the multi-threaded run-time system. This has no
effect on your existing applications. On UNIX, the single-threaded run-time
system is available, so that applications can link with third-party code.

Static-Linked Run-Time The static-linked run-time system is not available in Enterprise Developer.
System on page 33 Instead, you now link native code to the shared or dynamic run-time
system. This has no effect on your existing applications.

Setting the environment You use the cobsetenv script to set your COBOL environment on UNIX.
on UNIX on page 33

Enterprise Developer Co-  Some additional configuration is required to ensure Enterprise Developer
existing with Earlier Micro and Studio Enterprise Edition work properly when installed on the same
Focus Products on page machine.

33

Restrictions and Unsupported Features

Some features in earlier Micro Focus products are not available in Enterprise Developer. However there
are alternative techniques for many of these features.

CBL2XML Utility on page The CBL2XML utility is currently available as a command line tool only.
33

DBMS Preprocessors on Earlier Micro Focus products supported DBMS preprocessor versions that

page 33 are not supported in Enterprise Developer. For a list of currently supported
DBMS preprocessors, see the Database Access Support with Native
COBOL topic.

Dialog System on page Dialog System applications are not supported in Eclipse but you can
33 upgrade the non-GUI components of an application to Eclipse, and then
recreate the GUI components using the GUI tools in Eclipse.
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Form Designer on page
33

GNT Analyzer on page
34

Host Compatibility
Option (HCO) on page
34

INTLEVEL Support on
page 34

NSAPI on page 34

Online Help System on
page 34

OpenESQL on page 34

SQL Option for DB2 on
page 34

TX Series

Form Designer is the Net Express tool for creating user interfaces for CGI-
based Internet and intranet applications. Form Designer and the HTML page
wizard are not available in Enterprise Developer.

GNT Analyzer is not available in Enterprise Developer. It has been replaced
by Test Coverage.

Mainframe Express provided a user interface for the Host Compatibility
Option (HCO) feature. This user interface is not available in Enterprise
Developer; however the HCO Create Database, DDL Processor, DCLGEN,
Export Data, and Import Data tools are available via batch command line
invocation.

The INTLEVEL directive is rejected by the Compiler in Enterprise Developer.

There is no support for NSAPI in Enterprise Developer.

Net Express provided the Online Help System for creating online help from
character-based applications, and displaying it on screen. It is not available
in Enterprise Developer and the Online Help System information file type
(.HNF) is not supported.

In both Net Express and Studio Enterprise Edition, support is provided for
Oracle OCI in OpenESQL. Enterprise Developer does not support Oracle
OCI in OpenESQL.

In the Mainframe Express and Net Express IDEs, you could invoke SQL
Option for DB2 from the main menu within the IDE. For Enterprise
Developer, SQL Option for DB2 is not available from the main menu in the
IDE. Instead, all SQL Option for DB2 tools are available from Start > All
Programs > Micro Focus Enterprise Developer > Data Tools > SQL
Option for DB2.

The IBM TX Series product used to interface with Websphere in Net
Express is not supported in Enterprise Developer.

Run-Time Technology Differences

Some technologies behave differently in Enterprise Developer and this might affect how you upgrade

existing applications.

File Handling on page The way you integrate your own security modules into Fileshare has changed.

34 Also, the FILEMAXSIZE setting is different for Enterprise Developer and for Net
Express and Server Express .

Java and COBOL on
page 35

The cobsje script is not available in Enterprise Developer for Eclipse on UNIX.
Enterprise Developer uses the COBOL run-time system to load JVM based on
LIBPATH, LD_LIBRARY_PATH, SHLIB_PATH, JAVA_HOME etc.

Test Coverage on Enterprise Developer supports Test Coverage from the command line only.

page 35

Editing and Debugging Differences

Much of the edit and debug functionality in Net Express, Mainframe Express and Server Express is
available in Enterprise Developer, but some of it has a different name or slightly different behavior. In
addition there are some new features such as background parsing.

The Interface Mapping Toolkit is available in Enterprise Developer for Eclipse;
however it does not support CICS or IMS service interfaces.

Interface Mapping
Toolkit on page 35
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Program Breakpoints  Program breakpoints are breakpoints that stop execution each time a specified
on page 35 program or entry point within the program is called. They are supported in
Enterprise Developer.

Remote Debugging on The Net Express animserv utility used for debugging programs remotely has
page 35 been replaced by cobdebugremote (or cobdebugremote64 when
debugging 64-bit processes) in Enterprise Developer.

Source Pool View on The source pool view in Net Express showed all source files available in the
page 36 project directory, regardless of whether or not they are used in the current
build type. This view is not available in Enterprise Developer.

Backward Compatibility with Earlier Micro Focus
Products

COBOL applications developed and built using previous Micro Focus products can be developed and built
with Enterprise Developer. However, there are some differences in behavior and in terminology.

Executables requiring recompilation

If you are on the AIX platform, due to an internal change, you must recompile and/or relink your programs
to make them compatible with this run-time system.

Terminfo files

The following terminfo files have been removed:
o AT&T

e atte05
* tty5420
« IBM

e ibm3151
¢ Qume

e Qqutl02
« Wyse

* wyl20

e wyl20-25
« wy50

e wy60

*  wy60-w

e Wwy75

* wy85

Diagnostic tools

The FaultFinder tool has been removed from the current version of Enterprise Developer. This includes the
removal of the following tunables:

« faultfind_level
 faultfind_outfile
 faultfind_recsize
 faultfind_config

« faultfind_cache_enable
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You should either remove these tunables from your application or set the tunable
cobconfig_error_report=false in your configuration file.

You should also remove any calls to the library routine CBL_FFND_REPORT, as this now produces a
COBRT107 Operation not implemented in this run-time system (fatal) error.

Backward Compatibility with Studio Enterprise Edition

File Control The FCD format for file handling operations in 32-bit applications defaults to

Description (FCD) FCD3 in Enterprise Developer; in Studio Enterprise Edition, it defaulted to
FCD2.

Copybook A number of COBOL copybook files that were part of Studio Enterprise Edition had names

name in uppercase, whereas, in Enterprise Developer, most copybooks are provided with

changes lowercase names.

This affects the following copybooks - DFHAFCD, IDADDSA, IDADTCA, IDAS99RB,
IDAS99TU, IEESMCA, IEFJFCBN, IEFJSSIB, IEFTIOT1, IEZJSCB, IHAACEE, IHAASCB
IHAASVT, IHAASXB, IHACDE, IHAPSA, IKJTCB, MFJCTLBC, MFIDCUSR, MFJIDSXIT,
MFJIDXIT, MVSFINDM, MVSGETCT, SPOOLHK.

If your code refers to any of these files in uppercase, and you are compiling with Enterprise
Developer on UNIX, this may result in the code failing to compile, because it cannot locate
the copybooks.

You can work around this issue in on of the following ways:

1. Change the names of the copybooks referred to from your code to lowercase.

2. Create copies of the copybooks, and save them with uppercase names.

3. Set up symbolic links to point the uppercase names to their lowercase equivalents as
follows:

a. Create a script file, copylink.sh, which creates symbolic links for the above
copybooks.
b. Paste the following contents into the file:

In -s dfhafcd.cpy DFHAFCD.CPY
In -s idaddsa.cpy IDADDSA.CPY
In -s i1dadtca.cpy IDADTCA.CPY
In -s 1das99rb.cpy IDAS99RB.CPY
In -s idas99tu.cpy [IDAS99TU.CPY
In -s ieesmca.cpy IEESMCA.CPY
In -s i1efjfcbn.cpy IEFJFCBN.CPY
In -s iefjssib.cpy IEFJSSIB.CPY
In -s ieftiotl.cpy IEFTIOT1.CPY
In -s iezjscb.cpy IEZJSCB.CPY
In -s ihaacee.cpy IHAACEE .CPY
In -s ihaascb.cpy IHAASCB.CPY
In -s i1haasvt.cpy IHAASVT .CPY
In -s i1haasxb.cpy IHAASXB.CPY
In -s ihacde.cpy IHACDE . CPY
In -s ihapsa.cpy IHAPSA.CPY
In -s ikjtcb.cpy IKJTCB.CPY
In -s mfjctlbc.cpy MFJCTLBC.CPY
In -s mfjdcusr.cpy MFJDCUSR.CPY
In -s mfjdsxit.cpy MFJIDSXIT.CPY
In -s mfjdxit.cpy MFJIDXIT.CPY
In -s mvsfindm.cpy MVSFINDM.CPY
In -s mvsgetct.cpy MVSGETCT.CPY
In -s spoolhk.cpy  SPOOLHK.CPY
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c. As superuser, execute the script in the folder which contains the copybooks
($COBDIR/cpylib).

Backward Compatibility with Earlier Versions of Enterprise Developer

Casspool As part of an enhancement to improve performance when browsing the spool queue of
performance  an Enterprise Server, you must update the casspool file for any Enterprise Server
enhancement created before Enterprise Developer 2.2 Update 1 before you can submit jobs to it.

To update the casspool for each Enterprise Server, from a command prompt, run
Fixcasspool .bat (Windows) or Fixcasspool .sh (UNIX), located in %COBD IR%
\bin and %COBDIR%\bin64 (Windows) or $COBDIR\bin (UNIX), using the following
syntax:

Fixcasspool .bat casspool .dat backup.dat

or
Fixcasspool .sh casspool.dat backup.dat

Where:
casspool.dat

The spool file, located in the same directory as the Enterprise
Server's system catalog, that will be updated.
backup.dat

A file that will be created with a backup of the old casspool .dat
file. If backup . dat already exists, the update is not run.

If you do not update casspool and attempt to start Enterprise Server, the following
messages are displayed in the console:

JESO00011E Batch Spool File Error; Status [39]

JESO00130E Note JES000011 Error - New casspool indexes may need
generating. See error description in product docs

Using parentheses In managed COBOL syntax, you may only use parentheses when referencing

in member methods. You can no longer specify parentheses when referencing fields or
reference properties, as this will produce a syntax error.
For example:

set intLength to testString::Length()

must change to:
set intLength to testString::Length

Calling RM/COBOL  Previously, to call an RM/COBOL compatible library routine, you had to set the

compatible library =~ DIALECT"RM" Compiler directive, which ensured the correct call-convention was

routines used. To set this functionality now, you must explicitly use the correct call-
convention in the CALL statement.

DIALECT"ENTCOBOL" DIALECT"ENTCOBOL" now sets NSYSMBOL"NATIONAL"; previously, this set
NSYMBOL"DBCS".

DIALECT"RM" DIALECT"RM" now sets PERFORM-TYPE"RM". If you recompile an application that
uses DIALECT"RM", the behavior may change for nested PERFORM statements. If that
is the case, explicitly set PERFORM-TYPE"MF" after DIALECT"RM" to continue with the
previous behavior.

Upgrading to Enterprise Developer for Eclipse | 27



ILREF Previously, you could specify . jar files and other formats as a parameter when using this
Compiler directive. Now, you can only specify .class files.

ILUSING If you set this Compiler directive using the $set command, the imported namespace is only
applicable to programs, classes and referenced copybooks in that file. If you set the directive
through the IDE or from the command line, the imported namespace is applicable to all
programs and classes in the project or specified on the command line.

FLAGCD This Compiler directive is no longer available in Enterprise Developer. Remove it from your
code, otherwise you receive a COBCHO053 Directive invalid or not allowed here
error.

CALLFH If your code specifies the ACUFH parameter, it may now produce adverse effects when used.
You should replace it with the methods described in Configuring Access to Vision Data Files or
Configuring Access to RM/COBOL Data Files. Both of these methods offer a fuller-functioning
solution to handling these types of data files.

Compatible The following environment variables, introduced for ACUCOBOL-GT compatibility,
ACUCOBOL-GT file have been replaced with other environment variables or configuration options that
handling you add to your File Handler configuration file. No other ACUCOBOL-GT file
environment handling environment variables are supported.
variables Redundant variable Replaced with
FILE_CASE FILECASE configuration option
FILE_PREFIX COBDATA environment variable
FILE_SUFFIX FILESUFFIX configuration option
APPLY_FILE_PATH n/a
FILE_ALIAS_PREFIX dd_ mapping

Setting these environment variables will have no effect.

Backward Compatibility with the Net Express and Mainframe Express IDE
The main differences between the Net Express, Mainframe Express and Eclipse IDEs are:

» Perspectives. The COBOL perspective shows the views and menus relevant to COBOL development,
such as the COBOL Explorer, Program Outline, Outline and Console views. There are other
perspectives for Debugging, the Interface Mapper and CTF.

* Project > Build automatically. Whenever changes to a resource are saved, an incremental build
starts, which rebuilds all the resources modified since the last build. You can force a rebuild by using
Project > Clean.

« Build settings. These are available in three places:

* Project > Properties > Micro Focus > Project Settings. You can specify any additional directives
to be passed to the compiler at build time. These settings do not depend on the active build
configuration and are always passed to the compiler.

* Project > Properties > Micro Focus > Build Configurations. You can have multiple build
configurations for different build scenarios and swap between them. You choose the configuration
you want to use, by setting it as the current active configuration. This then overrides the project
language settings.

* Properties on the context menu for a single file. To set this, right-click the COBOL file in the COBOL
Explorer pane. The settings are specifically for this file and they override the currently active build
configuration and the Project Language Settings.

« Debug and run configurations. You need one of these before you can debug or run a program. They are
available from:
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* Project > Properties > Micro Focus > Run-time Configuration. These are the run-time settings
for this project, such as run-time arguments, run-time tunables, COBOL switches and so on.

* Run > Debug Configurations. Like build configurations, you can have multiple debug
configurations and swap between them. These override the project run-time configuration.

* Run > Run Configurations. These behave in the same way as debug configurations, but provide
slightly different options.

e Cheat sheets. These are like tutorials and give step-by-step instructions on how to do a task, together
with brief explanations. See Help > Cheat Sheets > COBOL Development. There are cheat sheets to:

« Create a project to say "Hello COBOL World".
» Import existing COBOL files into Eclipse
« Debug a program

Changes in some options and files delivered with the product include:

ADIS In earlier Micro Focus products, the default location for the ADISCTRL file was $COBDIR. The
default location of the file in Enterprise Developer is $COBDIR/etc.

Default In Server Express and in versions of Visual COBOL R4 and earlier, the default working
working mode mode set by the COBMODE environment variable was 32-bit. With the current release of
Visual COBOL and Enterprise Developer, it is 64-bit.

Format of the index In Net Express and Server Express, the default setting of the IDXFORMAT option
files was 4. With the current release of Enterprise Developer, it is 8.

FILEMAXSIZE File Handler |y Net Express and Server Express, the default setting for FILEMAXSIZE
configuration option was 4. With the current release of Enterprise Developer, it is 8.

Coexisting with Earlier Micro Focus Products

Run-time system A run-time system error occurs if either the COBCONFIG or COBCONFIG_

error due to environment variable is set when you run an Enterprise Developer application or

COBCONFIG when you use Enterprise Developer to edit or create projects and the configuration file
it refers to contains entries that are not valid for Enterprise Developer.

For example, this might happen if you have Net Express or Studio Enterprise Edition
installed and either COBCONFIG or COBCONFIG _ is set for it.

To work around this issue, ensure that Enterprise Developer is not running and then
modify the configuration file by doing one of the following:

« If the invalid tunable is not needed by another application, remove it from the run-
time configuration file.

* Add the following as the first line in the configuration file:
set cobconfig_error_report=false

» Unset COBCONFIG (or COBCONFIG_) or set it to another configuration file that
does not contain the invalid tunable for the particular session you are running in.

Licensing error due to The message "Micro Focus License Manager service is not running" can occur

environment settings  when you invoke a Net Express, Mainframe Express or Studio Enterprise

(applies to Windows Edition utility from Enterprise Developer. This happens when the tool is

environments only) invoked with Enterprise Developer environment settings while it requires the
Net Express or Studio Enterprise Edition ones.

This happens when you edit files such as .dat that have a file association with
Net Express or Studio Enterprise Edition.
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Compiling and Building Differences

There are several aspects of compiling and building applications that behave differently in Enterprise
Developer. You might need to change the project properties and update some of the Compiler directives
and settings that you previously used.

Output File Formats

Supported file formats - .exe and .dll

Each project compiles into a single file (.dll, .so or .exe), or to multiple files of the same file type with one
output file for each source file (.dll, .so, .exe, .int, or .gnt). As well as an .lbr file, which contains a collection
of .int and .gnt files on Windows, you now can use a .dll as the container for application components.

Building to multiple output files

Each project compiles into a single file (.dll, .so or .exe), or to multiple files of the same file type with one
output file for each source file.

Instead of an .lbr file, which contained a collection of .int and .gnt files on Windows, you now use a .dll as
the container for application components.

Your application can consist of multiple projects, each one building a single output file, with the projects
linked together so that they can access each other.

1. Click File > New > Other.

Expand General and click File.

Enter the name to use for the linked resource. You can enter an alias.
Click Advanced.

Select Link to file in the file system and browse to the file to link to. You can also click Variables and
define a path variable, so that you can link to files using a relative path.

a kv

Compiler directives

When you upgrade your source code to Enterprise Developer some Compiler directives that were
specifically designed for 16-bit systems now produce an error on compilation because they are no longer
relevant.

The following Compiler directives are no longer relevant and we recommend that you remove them from
your code and directives files before you compile:

01SHUFFLE
64KPARA
64KSECT
AUXOPT
CHIP
DATALIT
EANIM
EXPANDDATA
FIXING
FLAG-CHIP
MASM
MODEL
OPTSIZE
OPTSPEED
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PARAS
PROTMODE
REGPARM
SEGCROSS
SEGSIZE
SIGNCOMPARE
SMALLDD
TABLESEGCROSS
TRICKLECHECK

COBOL programs that interface with Assembler modules must be compiled with the AMODE directive. The
AMODE directive was set by default in MSS; it is not set by default in Enterprise Developer.

Linking

The static run-time system and the single-threaded run-time system on Windows are no longer required
and they are not shipped with Enterprise Developer. Applications built with Enterprise Developer are now
linked to the shared or dynamic run-time systems. On UNIX, you can link to the single-threaded or multi-
threaded shared or dynamic run-time system.

Linking from the command line

You can link applications from the Enterprise Developer command prompt with the cbl link or cblInames
commands. For example, to produce an .exe file, use:

cbllink myprogram.cbl

To compile and link your code to produce a -dl1 file, use:
cbllink -d myprogram.cbl

With these commands, the single-threaded and static-linking options are automatically mapped onto the
multi-threaded and shared run-time systems respectively.

Linking from the IDE
To specify what to link:

1. Click Project > Properties.
2. Expand Micro Focus > Build Configurations.
3. Click Link and specify your link settings.

Called Programs and Dependencies
At run time, called programs are found in the same way as before. However, there are some new ways to
set COBPATH and copy files into a common folder.

To build the called programs

When you build the called programs into a .dll or .so file, you can set a property to output the built file into
the same folder as the main application executable. To do this the called programs and the application
main program must be in the same project. To set this:

Create a project that contains the programs that are called.

In the project properties, expand Micro Focus > Build Configurations and click COBOL.

In Target Settings, select Single Native Library File.

Set the Output Path to the subfolder where the main application executable is output.

If you want to debug the .dll file together with the application, click Override COBOL project settings
and check Compile for debugging.

ok wbhpE
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6. Build the project.

To set the COBPATH environment variable
Add the COBPATH environment variable to the run-time configuration, as follows:

1. In the properties of the calling application project, expand Micro Focus > Run-time Configuration >
Environment Variables.
2. Add the COBPATH variable and specify the full path to your called files.

File Handler

The File Handler .obj files are not available in Enterprise Developer. Enterprise Developer uses the File
handler packaged in the mFfh_dl1 file instead.

If the application you are upgrading from Net Express used the File Handler .obj files, when you link your
application in Enterprise Developer the linker will emit a warning. The application will continue to operate
as before provided that you supply the mFfh_d11 file with it.

Makefile Conversion
You cannot use existing makefiles from Enterprise Developer for Eclipse, although where they invoke
commands supported by Enterprise Developer they will continue to work as before.

It is not possible to use or convert existing makefiles and Visual Studio MSBuild files.

SQL Compiler Directive Options

If you get errors in Enterprise Developer when compiling an object application that was created in Net
Express or Studio Enterprise Edition, recompile specifying the GEN-CLASS-VAR SQL Compiler directive
option in addition to other appropriate options.

XML PARSE Statement

In Net Express, the default setting for the XMLPARSE Compiler directive is COMPAT, which causes the
XML PARSE statement to return information and events for IBM Enterprise COBOL Version 3. In
Enterprise Developer, the default is XMLPARSE(XMLSS), which returns information and events for IBM
Enterprise COBOL Version 4.

To emulate the Net Express behavior in Enterprise Developer, specify the XMLPARSE(COMPAT)
Compiler directive option.

For a summary of the differences in event information between XMLPARSE(XMLSS) and
XMLPARSE(COMPAT), see the Special Registers topic in your Enterprise Developer documentation.

Run-time System Differences

There are some differences between the run-time systems supplied with Enterprise Developer and those
supplied with Net Express, Server Express and Mainframe Express. These, however, do not affect your
existing applications if you recompile them from the source code in Enterprise Developer.

The changes in the run-time system are described in the following sections.

OpenESQL

Enterprise Developer sets the BEHAVIOR SQL Compiler directive option to MAINFRAME by default to
provide optimal performance. To revert to the default behavior exhibited in Net Express, set the
BEHAVIOR directive to UNOPTIMIZED.

Single-Threaded Run-Time System

The single-threaded run-time system is not available in Enterprise Developer on Windows. Instead, both
single-threaded and multi-threaded applications run using the multi-threaded run-time system. This has no
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effect on your existing applications. On UNIX, the single-threaded run-time system is available, so that
applications can link with third-party code.

Static-Linked Run-Time System
The static-linked run-time system is not available in Enterprise Developer. Instead, you now link native
code to the shared or dynamic run-time system. This has no effect on your existing applications.

See Linking Native COBOL Code in the product Help.

Setting the environment on UNIX

Before you start developing applications with Enterprise Developer for Eclipse on UNIX you need to set the
environment. We recommend that you use the cobsetenv script to do this:

. /opt/microfocus/EnterpriseDeveloper/bin/cobsetenv

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is not
compatible with C-shell or pre-XPG4 Bourne shell.

Enterprise Developer Co-existing with Earlier Micro Focus Products

If you have Enterprise Developer and Net Express or Studio Enterprise Edition installed on the same
machine, you sometimes receive a run-time system error if either the COBCONFIG or COBCONFIG_
environment variable is set when you run an Enterprise Developer application the configuration file it refers
to contains entries that are not valid for Enterprise Developer.

To work around this issue, ensure that Enterprise Developer is not running and then modify the
configuration file by doing one of the following:

< |If the invalid tunable is not needed by another application, remove it from the run-time configuration file.
« Add the following as the first line in the configuration file:

set cobconfig_error_report=false

* Unset COBCONFIG (or COBCONFIG ) or set it to another configuration file that does not contain the
invalid tunable for the particular session you are running in.

Restrictions and Unsupported Features

Some features in earlier Micro Focus products are not available in Enterprise Developer. However there
are alternative techniques for many of these features.

CBL2XML Utility

The CBL2XML utility is currently available as a command line tool only.

DBMS Preprocessors

Earlier Micro Focus products supported DBMS preprocessor versions that are not supported in Enterprise
Developer. For a list of currently supported DBMS preprocessors, see the Database Access Support with
Native COBOL topic.

Dialog System
Dialog System applications are not supported in Eclipse but you can upgrade the non-GUI components of
an application to Eclipse, and then recreate the GUI components using the GUI tools in Eclipse.

Form Designer
Form Designer is the Net Express tool for creating user interfaces for CGl-based Internet and intranet
applications. Form Designer and the HTML page wizard are not available in Enterprise Developer.

In Enterprise Developer for Eclipse, you can install one of the available plug-ins to replicate these features.
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GNT Analyzer

GNT Analyzer is not available in Enterprise Developer. It has been replaced by Test Coverage.

Host Compatibility Option (HCO)

Mainframe Express provided a user interface for the Host Compatibility Option (HCO) feature. This user
interface is not available in Enterprise Developer; however the HCO Create Database, DDL Processor,
DCLGEN, Export Data, and Import Data tools are available via batch command line invocation.

INTLEVEL Support
The INTLEVEL directive is rejected by the Compiler in Enterprise Developer.

An INTLEVEL of 1, 2, or 3 is no longer supported and causes compilation errors. Other values are
reserved for internal use and should not be used.

NSAPI

There is no support for NSAPI in Enterprise Developer.

Online Help System

Net Express provided the Online Help System for creating online help from character-based applications,
and displaying it on screen. It is not available in Enterprise Developer and the Online Help System
information file type (.HNF) is not supported.

OpenESQL
In both Net Express and Studio Enterprise Edition, support is provided for Oracle OCI in OpenESQL.
Enterprise Developer does not support Oracle OCI in OpenESQL.

SQL Option for DB2

In the Mainframe Express and Net Express IDEs, you could invoke SQL Option for DB2 from the main
menu within the IDE. For Enterprise Developer, SQL Option for DB2 is not available from the main menu in
the IDE. Instead, all SQL Option for DB2 tools are available from Start > All Programs > Micro Focus
Enterprise Developer > Data Tools > SQL Option for DB2.

TX Series

The IBM TX Series product used to interface with Websphere in Net Express is not supported in Enterprise
Developer.

Run-Time Technology Differences

Some technologies behave differently in Enterprise Developer and this might affect how you upgrade
existing applications.

File Handling
The way you integrate your own security modules into Fileshare has changed. Also, the FILEMAXSIZE
setting is different for Enterprise Developer and for Net Express and Server Express .

Using security modules

The way you integrate your own security modules (Fhrdrpwd, fsseclog and fssecopn) into Fileshare
has changed.

In Enterprise Developer, you no longer relink Fileshare but you need to supply your own separate files,
which are .dll files on Windows or shared objects on UNIX. For more information, see Writing Your Own
FHRdrPwd Module, File Access Validation Module and Logon Validation Module in the File Handling
section of your product Help.
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To use fsseclog and fssecopn, you need to link one or both of them into a cobfssecurity.dll ora
shared object and place on the search path. Fileshare will issue a message indicating that it has loaded
user security modules.

On UNIX, you no longer use fsclose to call Fileshare Manager. You need to use cobfsclose instead.

Sharing data files between applications built in Enterprise Developer and others built using Net
Express or Server Express

If you have applications that access the same data files, all those applications should be built with the
same FILEMAXSIZE setting. However, applications built with Enterprise Developer use a default setting of
FILEMAXSIZE=8 while those built in Net Express or Server Express use FILEMAXSIZE=4.

In Enterprise Developer you need to set the FILEMAXSIZE setting in the file handler configuration file
(EXTFH.CFG). This ensures Net Express, Server Express, and Enterprise Developer are all using the
same setting and that programs running under the Net Express or Server Express run-time systems do not
access the same files as programs running under the Enterprise Developer run-time system.

Java and COBOL

The cobsje script is not available in Enterprise Developer for Eclipse on UNIX. Enterprise Developer uses
the COBOL run-time system to load JVM based on LIBPATH, LD_LIBRARY_PATH, SHLIB_PATH,
JAVA_HOME etc.

Test Coverage
Enterprise Developer supports Test Coverage from the command line only.

Test Coverage replaces GNT Analyzer, which was available in Server Express.

Editing and Debugging Differences

Much of the edit and debug functionality in Net Express, Mainframe Express and Server Express is
available in Enterprise Developer, but some of it has a different name or slightly different behavior. In
addition there are some new features such as background parsing.

Interface Mapping Toolkit
The Interface Mapping Toolkit is available in Enterprise Developer for Eclipse; however it does not support
CICS or IMS service interfaces.

Program Breakpoints
Program breakpoints are breakpoints that stop execution each time a specified program or entry point
within the program is called. They are supported in Enterprise Developer.

Remote Debugging
The Net Express animserv utility used for debugging programs remotely has been replaced by
cobdebugremote (or cobdebugremote64 when debugging 64-bit processes) in Enterprise Developer.

To debug locally-developed programs on a remote machine you must start cobdebugremote (or
cobdebugremote64 when debugging 64-bit processes) before communication can be established. See
the Enterprise Developer help for more information on cobdebugremote.

To debug remotely-developed programs on a remote machine:

« If you have developed a COBOL remote project on a machine using a local Eclipse installation and a
remote UNIX machine, you use debug configurations in the same way as locally-developed projects.
However you do not need to start the cobdebugremote (or cobdebugremote64 for a 64-bit process)
or identify a port for it to listen on, merely select the remote project in the debug configuration.

« To enable remote debugging using a COBOL Application debug configuration, you need to have an X
window implementation installed and running, so that the output of a remote application running on a
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UNIX machine can be viewed on your local machine. You do not need X window for other debug
configuration types.

For more information, see the section on Remote Debugging in your product help.

Source Pool View
The source pool view in Net Express showed all source files available in the project directory, regardless of
whether or not they are used in the current build type. This view is not available in Enterprise Developer.

Tips: Eclipse IDE Equivalents to IDE Features in Earlier
Products

The following table shows Mainframe Express and Net Express IDE features and their corresponding
equivalents and locations in Eclipse.

Functionality In Mainframe Express In Net Express In Enterprise Developer
for Eclipse

Project Control

Project filename * _MVP *_APP .cobolProj in Project
directory
Add file to project All files in the project

directory and its
subdirectories are
automatically part of the
project. You can exclude
programs or subdirectories
from a build using the Build
Action option on the
context menu.

Copybook path Via Workgrouping By default, all directories
within a project and their
subdirectories are included
in the initial copybook
path.To make changes,
click Project > Project
Properties > Micro Focus
> Build Path and select the
Dependency Paths tab.

Build settings for the ALT+F7 or click Project > Right-click the project name
project: Build Setting for Project and select Properties, (or

and select the click Project > Properties
+ COBOL corresponding tabs. from the main menu).

¢ CICS including BMS
¢ Preprocessor
« Additional Directive

Execution environment The execution environment
settings: is Enterprise Server.

¢ General

¢ Assembler

e COBOL

« JCL
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Functionality

In Mainframe Express

In Net Express

In Enterprise Developer
for Eclipse

Debug settings:

* DateWarp
¢ Stored Procedures

Editing

Suggest Word/Content
Assist

Locate

COBOL Find

Compress

Bookmark

Compiling

Single file Compile

Build

Build All

Debugging
Start Debugging

Stop Debugging

Restart Debugging

Run

CTRL+G

F12 (or context menu
Locate)

CTRL+Shift+F12 (or
context menu COBOL
Find)

IL
Tool bar compress ¥ (or
context menu Compress)

CTRL+F2

CTRL+F7 (or click check
v

mark )

F7 (or click build )

ALT+B A

Alt+D A

Shift+F5

Ctrl+Shift+F5

F5

CTRL+G

F12 (or context menu
Locate)

CTRL+Shift+F12 (or
context menu COBOL
Find)

:L
Tool bar compress ¥ (or
context menu Compress)

CTRL+F2

CTRL+F7 (or click check
v

mark )

F7 (or click build )

ALT+B A

Alt+D A

Shift+F5

Ctrl+Shift+F5

F5
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DateWarp is present in the
debug launch
configurations.

CTRL+Space

F3 (or context menu Goto
Definition)

CTRL+Shift+G (or context
menu Find References)

Double-click on an item to
jump to the line in the
program.

Click Edit > Add
Bookmark.

Right-click a program name
and select Single File
Compile.

Note: This applies
to native code only.

By default, Eclipse
automatically builds
projects to keep them up to
date. You can also build on
request. To turn off the
automatic build, click
Project > Build
Automatically.

Cleaning a project forces a
rebuild. To access this,
click Project > Clean.

Choose Debug or F11
Before launching the
session, create an
appropriate debug launch
configuration.

CTRL+F2 (or context menu

From the executable in the
debug stack view, right-
click and select Relauch
from the context menu.

CTRL+F11

Terminate)




Functionality In Mainframe Express In Net Express In Enterprise Developer
for Eclipse

Step , , F5
F11 (or click step * ) F11 (or click step * )

Step All Ctrl+F5 Ctrl+F5 i
Click Resume on the
debug toolbar.

R _
un Thru )
F6 (or Step Over )

Run Return
F7 (or Step Return ~ )

Run to Cursor Shift+F10 (or context Shift+F10 (or context CTRL+R (or context menu

menu menu
) ) -

Run to Line )

Skip to Cursor CTRL+Shift+F10 CTRL+Shift+F10 ALT+F12, R (or Reset

Execution Point -t )

Skip Statement ALT+D, | or click Debug > No equivalent. Use ALT
Skip Statement . +F12, R (or Reset

Execution Point )

Skip Return ALT+D, K or Click Debug > No equivalent. Use ALT
Skip Return +F12, R (or Reset

Execution Point =~ 7 )

Examine ' data item' Shift+F9 Shift+F9 The Variables View
automatically shows
variable values on the
current and previous lines.

Breakpoint set F9 F9 Double click in the left
margin to toggle a
breakpoint.

Conditional Breakpoint From the Breakpoints View,
select a breakpoint and edit
the properties.

Break on Data Change Via list view Via list view To set a WatchPoint,
double-click in the margin
of line containing a WS
item, or set it from the
Outline View context menu.

Upgrading from ACUCOBOL-GT

There are conceptual and behavioral differences between Enterprise Developer and ACUCOBOL-GT, part
of the Micro Focus extend® product family, and these differences can affect the way you upgrade existing
applications to Enterprise Developer.

Refer to the Compatibility with ACUCOBOL-GT section for guidance and best practice on moving your
applications to Enterprise Developer. It covers:

e Supported ACUCOBOL-GT features, including detailed information on support for compiler options and
standard library routines.
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« Syntactical differences between the two COBOL dialects, including workarounds or equivalent syntax
where applicable.

« Detailed support of compatible ACUCOBOL Windowing syntax.

« Details on how to configure your applications to continue using your Vision data files.

« Details on converting your GUI projects using an import wizard (AddPack required).

Compatibility with ACUCOBOL-GT

The following sections describe supported ACUCOBOL-GT features and how to enable them.

Converting ACUCOBOL-GT Applications

With Enterprise Developer you can build, compile and debug ACUCOBOL-GT applications. Certain
Compiler directives are provided to enable compatibility with some of ACUCOBOL-GT's language
extensions, data files, and other behaviors.

There is also a modernization tool available that helps to locate and transform incompatibilities in your GUI
and character mode projects, and makes them compliant in this COBOL system. This tool is available as
an AddPack; see the Product Updates section of the SupportLine website (http://
supportline.microfocus.com) for details on the ACUCOBOL-GT to Visual COBOL Modernization AddPack.

Users of this AddPack should also join the ACUCOBOL-GT Modernization community group. Through this
group, you will have direct access to Micro Focus SupportLine, Technical Services, and Development staff
members, as well as other users who are modernizing their code. To join the group, first join the Micro
Focus Community (community.microfocus.com) if you have not already done so, then provide your
Community account name to your sales representative, who will request access on your behalf. You will
receive email notification when you have been added to the group.

After you have converted your application, you must run, license, and distribute your programs in the same
manner as other Micro Focus programs. There is currently no clone of the ACUCOBOL-GT runtime known
as wrun32 (Windows) or runcbl (UNIX).

This section describes the ACUCOBOL-GT compatibility features, such as how they are enabled within
Enterprise Developer, and also the potential problems you may encounter with some aspects of the
converted source code.

Enabling ACUCOBOL-GT Compatibility

Compile your ACUCOBOL-GT source code with certain Compiler directives that enable support for
ACUCOBOL-GT syntax, data types, and other behaviors. A number of traditional ACUCOBOL-GT compiler
options are also available.

Compiler Directives for ACUCOBOL-GT Compatibility
There are a number of Compiler directives that provide compatibility with ACUCOBOL-GT. Use the
DIALECT"™ACU" directive to set all of these directives at once.

By setting DIALECT"ACU" you enable certain reserved words, data type storage behavior, and more. See
ACU DIALECT setting for full details of the directives that are set.

You can set this directive in your source code directly, through the COBOL project options interface in your
IDE or from the command line.

Compiler Option Support

You can use many of the ACUCOBOL-GT compiler options when compiling, by setting then with the
ACUOPT Compiler directive. A list of the supported options is listed in this section.

Alternatively, you can compile using a clone of the ACUCOBOL-GT compiler known as ccbl _.exe
(Windows) or ccbl (UNIX). This executable is located in the bin directory found here:
%ProgramFilles(x86)%\Micro Focus\Enterprise Developer . ccbhl.exe (Windows) or ccbl
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(UNIX) compiles to - int code unless you specify one of the ccbl's native code options, in which case it
produces .gnt code.

Setting Compiler Options
You can set the ACUCOBOL-GT compiler options by using the ACUOPT Compiler directive, or from a
command line utility.

This COBOL system supports many of the compiler options available with the ACUCOBOL-GT (Acu)
compiler. To specify these options use the ACUOPT Compiler directive along with the traditional ACU
compiler option name.

For example:

ACUOPT (-opti on)

Or:

ACUOPT(--opt i on)

ACUOPT automatically sets the ACU directive, which turns on overall ACUCOBOL-GT compatibility.
NOACU or NOACUOPT are not allowed.

Alternatively, you can compile using a clone of the ACUCOBOL-GT compiler known as ccbl .exe
(Windows) or ccbl (UNIX). This executable is located in the bin directory found here:
%ProgramFiles(x86)%\Micro Focus\Enterprise Developer. ccbl.exe (Windows) or ccbl
(UNIX) compiles to . int code unless you specify one of the ccbl's native code options, in which case it
produces .gnt code.

Supported ACUCOBOL-GT Compiler Options
There are a number of ACUCOBOL-GT Compiler options supported in Enterprise Developer, which you
enable using the ACUOPT Compiler directive.

General Support Notes

Enterprise Developer supports the following ACUCOBOL-GT compiler functionality:

« Grouping of options
e CBLFLAGS environment variable
* Replacement of @ by the base name of the source file.

The following compiler options are available:

Standard Options

The standard options enable you to control certain compile time options, such as verbose output and
renaming the object file.

The following compiler options are supported in Enterprise Developer when using ccbl (Windows) or
ccbl132 and ccb164 (UNIX) from the command line or the ACUOPT Compiler directive.

Option Definition

-e This option must be followed by a file name (as the next
separate argument). When specified, this option causes
the error listing to be written to the specified file instead of
the screen. This file is removed if no errors are found.

-0 This option must be followed by a file name (as the next
separate argument), which becomes the name of the
object file instead of source-name. int. This file is
removed if the compiler detects errors in the source.
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-V This option has multiple applications:

e Ifitis the first and only option on the command line,
then the compiler runs in "Version" mode. Using -V,
you can display version information, the copyright
notice, and other information.

* Otherwise, if it is used in combination with other
options, it causes the compiler to be verbose about its
progress.

Because -V is the lead-in sequence for the video
options, this option should be specified by itself.

-w This option causes warning messages to be suppressed
(a warning condition is never a fatal compilation error).
Suppressing warning messages can be helpful when you
are converting programs from another COBOL dialect
that uses slightly different syntaxes.

-X This causes the CBLFLAGS environment variable to be
ignored.

Native Object Code Options

The native object code option enables you to execute object files that contain native instructions for select
families of processors.

The following compiler option is supported in Enterprise Developer when using ccbl (Windows) or
ccbl32 and ccb164 (UNIX) from the command line.

Option Definition

-n The Compiler produces native code specific to the bit
arrangement and local machine. There is no support for
cross-generation of native code.

Listing Options
The listing options enable you to control listing information generated with an object file.

The following compiler options are supported in Enterprise Developer when using ccbl (Windows) or
ccbl132 and ccb164 (UNIX) from the command line or the ACUOPT Compiler directive.

Note: The results of these options will differ from how they appear in ACUCOBOL-GT COBOL, as
they map to listing Compiler directives in Enterprise Developer.

Option Definition

-La This option maps to the ERRLIST Compiler directive.

-Lc This option maps to the XREF and RESEQ Compiler
directives.

-Lf This option maps to the COPYLIST Compiler directive.

-Li This option maps to the ERRLIST Compiler directive.

-LI This option maps to the FORM Compiler directive.

-Lo This option maps to the LIST Compiler directive.
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-Ls

-Lw

This option maps to the DATAMAP Compiler directive.

This option maps to the LISTWIDTH Compiler directive.

Internal Table Options

The Internal Table options available in ACUCOBOL-GT are not required in Enterprise Developer. The
following options are accepted by the compiler, but are ignored.

Option Definition

-Td Identifier and statement table — sets the maximum
number of items in each statement. The default value is
4096.

-Te Subscript statement table — sets the maximum size for
OCCURS statements. The default value is 256.

Compatibility Options

The compatibility options enable you to control the compatibility with certain other COBOL systems.

The following compiler options are supported in Enterprise Developer when using ccbl (Windows) or
ccbl132 and ccb164 (UNIX) from the command line or the ACUOPT Compiler directive.

Option

Definition

-Ca

This option causes simple ACCEPT and DISPLAY
statements to be treated in accordance with ANSI
semantics. Specifying this option is the same as
specifying FROM CONSOLE for all simple ACCEPT
statements and UPON CONSOLE for all simple DISPLAY
statements. You can control this behavior for individual
ACCEPT or DISPLAY statements by specifying an
explicit FROM/UPON phrase.

This option sets the compiler to be compatible with
ICOBOL for certain COBOL constructs.

This option sets the compiler to RM/COBOL compatibility
mode.

This option sets the compiler to IBM DOS/VS
compatibility mode.

Source Options

The source options enable you to modify the way that the Compiler treats the physical source files.

The following compiler options are supported in Enterprise Developer when using ccbl (Windows) or
ccbl132 and ccb164 (UNIX) from the command line or the ACUOPT Compiler directive.
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-Sa This causes the compiler to assume that the input source
is in the standard ANSI source format.

-Sd Setting this option causes debugging lines marked with D

in the indicator area to be treated as normal source lines
instead of comment lines. This is equivalent to supplying
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the phrase WITH DEBUGGING MODE in the SOURCE-
COMPUTER paragraph.

-Sp With this option you can specify a series of directories to
be searched when the compiler is looking for COPY
libraries. This option is followed (as the next separate
argument) by the set of directories to search.

-St This option forces the compiler to use the terminal source
format.
-S1..-S9 Specifying a digit with -S uses alternate tab stops in

source files. When this option is used, tabs will be set
every # columns apart, where # is the number specified.
For example, -S4 will set tab stops at every fourth
column. Tab stops always start in column 1.

Reserved Word Options
The reserved word options enable you to override the behavior of reserved words and synonyms.

The following compiler options are supported in Enterprise Developer when using ccbl (Windows) or
ccbl132 and ccb164 (UNIX) from the command line or the ACUOPT Compiler directive.

Option Definition

-Rc Allows you to change a reserved word. This option must
be followed by two separate arguments: The first is the
reserved word you want to change. The second is the
word that you want to use instead. For example,

-Rc TITLE NAME

will allow you to use "TITLE" as a user-defined word and
will cause the word NAME to be treated as the reserved
word TITLE. You may not specify a word that is already
reserved as the new reserved word. This option may be
repeated to transform multiple reserved words.

-Rn Allows you to make a reserved word a synonym for
another reserved word. This option must be followed by
two separate arguments: The first is the reserved word
for which you want a synonym. The second is the word
that functions as the synonym. For example,

-Rn COMP COMP-5

causes COMP-5 to be treated the same as the reserved
word COMP. This option may be repeated to make
multiple synonyms.

-Rw This option allows you to suppress a particular reserved
word. The option must be followed (as the next separate
argument) by the reserved word you want to suppress.
This option may be repeated to suppress multiple
reserved words. This option also allows you to suppress
some non-reserved words, such as control names (for
example, entry-field and label) or property
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names (for example, max-text and bitmap-
number).

Data Storage Options

The data storage options control the behavior of certain data items and how they are stored.

The following compiler options are supported in Enterprise Developer when using ccbl (Windows) or
ccbl32 and ccb164 (UNIX) from the command line or the ACUOPT Compiler directive.

Option

Definition

-D1

-D2

-D5

-D6

-D7
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This option causes any data item whose underlying type
is binary to be stored in one byte if that data item has only
one or two digits. Normally, such a data item would be
stored in two bytes.

This option causes COMPUTATIONAL data items to be
treated as if they were declared as COMPUTATIONAL-2.
This is the default when you are using RM/COBOL
compatibility mode.

This option causes data items declared as BINARY to be
treated as if they were declared as COMPUTATIONAL-5.
This causes the values to be stored in the host machine's
native byte-ordering instead of the machine-independent
byte-ordering normally used. This option should be used
with caution, because it can lead to programs that are not
portable.

This option causes unsigned data items declared as
PACKED-DECIMAL to be treated as if they were
declared as COMPUTATIONAL-6. This saves one-half of
a byte because the compiler will not generate any storage
for the sign.

This option allows you to match one of the binary storage
conventions used by Micro Focus COBOL. That
convention is identical to the ACUCOBOL-GT -Dm
convention, except that a PIC 9(7) data item (unsigned) is
stored in 3 bytes instead of 4 and a PIC 9(12) data item
(unsigned) is stored in 5 bytes instead of 6. When you
use this option, the size of a binary item is determined as
follows (the value in the table is the number of bytes
occupied by the data item):

Number of Signed
Unsigned

9"s in PIC Storage
Storage

1-2 1

1

3 -4 2

2

5-6 3

3

7 4

3
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8 -9
4
10 - 11
5
12
5
13 - 14
6
15 - 16
=
17 - 18
8

0o N o o O @ »H

-Da This allows you to specify the data alignment modulus for
level 01 and level 77 data items. Normally, level 01 and
level 77 data items are aligned on a 4-byte boundary
(modulus 4). This is optimal for 32-bit architectures. You
can specify an alternate alignment boundary by following
this option with the desired modulus. This should be
specified as a single digit that immediately follows the -
Da as part of the same argument. For example, —-Da8
specifies that data should be aligned on 8-byte
boundaries, which can provide improved performance on
a 64-bit machine.

-Db This causes COMPUTATIONAL data items to be treated
as if they were declared as BINARY data items. This is
the default when you are using VAX COBOL compatibility
mode.

-DCa This selects the ACUCOBOL-GT storage convention. It is
the default setting. This convention is also compatible
with data produced by RM/COBOL (not RM/COBOL-85)
and previous versions of ACUCOBOL-GT. It also
produces slightly faster code.

-DCb This selects the MBP COBOL sign storage
convention.Note that the MBP COBOL sign storage
convention for USAGE DISPLAY directly conflicts with
that used by IBM COBOL and some other COBOLs. As a
result, signed USAGE DISPLAY items in the MBP format
are correctly understood only when the program is
compiled with —Dcb. This is unlike the other sign
conventions in which the runtime can usually extract the
correct value even when a mismatched sign convention is
specified at compile time.

Also note that MBP COBOL does not have the COMP-2
storage type. The convention that ACUCOBOL-GT
implements (Positive: X"0C"; Negative: X"0D") was
chosen because MBP COBOL most closely matches the
sign storage of other COBOLs that use that convention.

-DCi This selects the IBM storage convention. It is compatible
with IBM COBOL, as well as with several others including
RM/COBOL-85. It is also compatible with the X/Open
COBOL standard.
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-DCm

-DCn

-DCr

-DCv

-Dd31

-Df

46 | Upgrading to Enterprise Developer for Eclipse

This selects the Micro Focus storage convention. It is
compatible with Micro Focus COBOL when the Micro
Focus ASCII sign-storage option is used (this is the Micro
Focus default).

This causes a different numeric format to be used. The
format is the same as the one used when the -DcCi
option is used, except that positive COMP-3 items use
X" OB"" as the positive sign value instead of X"'0C"". This
option is compatible with NCR COBOL.

This selects the Realia sign storage convention. Sign
information for S9(n) variables is stored using the
conventions for Realia COBOL, and their conversion to
binary decimal is the same as that performed by the
Realia compiler.

This creates numeric sign formats that are compatible
with VAX COBOL. These are identical to the IBM formats,
except that unsigned COMP-3 fields place X"*0C™" in the
sign position, instead of X""OF"". The ANSI definition of
COBOL does not state how signs should be stored in
numeric fields (except for the case of SIGN IS
SEPARATE). As a result, different COBOL vendors use
different conventions. By using the options -Dca, -Dci,
-Dcm, -Dcn, or -Dcv, you may select alternate sign-
storage conventions. Doing so is useful in the following
cases:

» If you need to export data to another COBOL system
and need to match its sign-storage convention.

e If you are importing data from another COBOL
system, and that data contains key fields with signed
data. Keys are treated alphanumerically, so if you use
the incorrect sign-storage convention, ACUCOBOL-
GT will not find a matching key when it is doing a
READ.

The storage-convention affects how data appears in
USAGE DISPLAY, COMP-2, and COMP-3 data types.

This option supports data items with up to 31-digits or 16
bytes. When this option is in effect, you may use as many
as 31 X or 9 symbols in a PIC, instead of the usual 18.
The maximum number of bytes in a COMP-X or COMP-N
data item, whose picture contains only "X" symbols, is 16,
instead of the usual 8. Intermediate results are calculated
to 33 digits instead of the usual 20.

This option changes the way the compiler treats data
items declared as COMP-1 and COMP-2. Some
compilers use COMP-1 and COMP-2 to specify single-
and double-precision floating-point data items.
ACUCOBOL-GT, however, assigns a different meaning to
COMP-1 and COMP-2 and uses FLOAT and DOUBLE to
specify floating-point data items.When the —D¥ option is
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used, the compiler treats data items declared as COMP-1
as if they were declared FLOAT and data items declared
as COMP-2 as if they were declared DOUBLE. With the
-DT option, you have the following correspondence:

COMP-1 FLOAT single precision
COMP-2 DOUBLE double precision

The -DTF option makes it easier to compile code originally
written for another compiler — one that used COMP-1
and COMP-2 to specify floating point data items. The -
DT option lets you compile such code without having to
change COMP-1 and COMP-2 to FLOAT and DOUBLE.

-Di This option causes the compiler to initialize Working-
Storage. Normally, the compiler will initialize all data
items to spaces or the value specified with the -Dv
option, except for those items given a VALUE clause. If
this option is specified, data items are initialized
according to their type:

e Alphabetic, alphanumeric, alphanumeric edited, and
numeric edited items are initialized to spaces.

« Numeric items are initialized to zero.

« Pointer items are initialized to null.

¢ Index items are initialized to 1.

Automatic initialization applies only to Working-Storage
and does not apply to any item that (a) is given a VALUE
clause, (b) is EXTERNAL, or (c) is subordinate to a
REDEFINES phrase.

-DI1/2/4/8 This option allows you to limit the maximum alignment
modulus that will be used for SYNCHRONIZED data
items. Normally, a synchronized data item is aligned on a
2-, 4-, or 8-byte boundary depending on its type. This
option allows you to specify an upper bound to the
modulus used. This is specified as a single digit that
immediately follows the -D1 as part of the same
argument. For example, -DI4 specifies that the
maximum synchronization boundary is a 4-byte
boundary. If you want to make programs that are
compliant with the 88/0Open COBOL specification, you
should specify -D14.

-Dm This option causes any data item whose underlying type
is binary to be stored in the minimum number of bytes
needed to hold it. Normally, binary types are stored in
two, four, or eight bytes. This option allows storage in any
number of bytes ranging from one to eight.

-Dg Causes the QUOTE literal to be treated as an
apostrophe, or single quotation mark, rather than as a
double quotation mark (). One exception to this is the HP
€3000 TRANSFORM verb, in which QUOTE is always
treated as a double quotation mark.
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-Ds

-Dv

-Dw32

-Dw64

This causes USAGE DISPLAY numeric items with no
SIGN clause to be treated as if they were described with
the SIGN IS TRAILING SEPARATE clause. Several
versions of RM/COBOL behave this way (all versions
before 2.0, and some versions afterward).

This option allows you to specify the default byte (initial
value) used to initialize any data item not otherwise
initialized when the program is loaded. The option must
be followed by an equals sign (=) and the decimal value
of the byte to use (for all current platforms, this is the
ASCII value of the desired character). For example, to fill
memory with the NULL character, use -Dv=0. To fill
memory with the ASCII space character, use -Dv=32.

This option is checked for compatibility with the system's
bit arrangement.

This option is checked for compatibility with the system's
bit arrangement.

Truncation Options

The truncation options enable you to control the truncation of certain data items.

The following compiler options are supported in Enterprise Developer when using ccbl (Windows) or
ccbl132 and ccb164 (UNIX) from the command line or the ACUOPT Compiler directive.

Option

Definition

-Dz

-noTRUNC

-truncANSI

All binary and packed-decimal data types ignore their
PICTURE when determining the largest value they can
hold. The PICTURE is not used when moving to a
nonnumeric destination (the largest possible value
determines the number of digits moved instead).

All binary data types ignore their PICTURE when
determining the largest value they can hold. However, the
PICTURE is used when moving data from a binary
number to a nonnumeric data item. The name of this
option is similar to the name used by some other COBOL
systems that behave this way.

Full ANSI COBOL rules are in place. Each numeric data
item stores values up to its PICTURE in size. A small
number of USAGE types provide exceptions (such as
COMP-X and COMP-5). Values larger than allowed by
the PICTURE are truncated using the standard size rules
when the data item is the target of a MOVE statement;
however, COMP-5 items do use their PICTURE when
moving a value to a nonnumeric data item. The results of
an arithmetic overflow (without the SIZE phrase) are
undefined.

Comments:

The -Dz truncation option is not supported in Managed COBOL.
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Video Options
The video options enable you to control the behavior of certain items displayed to screen.

The following compiler options are supported in Enterprise Developer when using ccbl (Windows) or
ccbl132 and ccb164 (UNIX) from the command line or the ACUOPT Compiler directive.

Option Definition

-Vc This option causes any ACCEPT statement that contains
a numeric or numeric edited receiving field to be treated
as if the CONVERT phrase were also specified.

-vd This option causes non-USAGE DISPLAY numeric items
to be converted to USAGE DISPLAY before the screen
display occurs.

This option is always on.

Warning and Error Options
The warning and error options enable you to set the error threshold before a object file will stop executing.

The following compiler options are supported in Enterprise Developer when using ccbl (Windows) or
ccbl132 and ccb164 (UNIX) from the command line or the ACUOPT Compiler directive.

Option Definition
-a This flag is now obsolete and should not be used.
-Qm This option specifies the number of errors the compiler

reports before it exits. The option must be followed by a
positive numeric argument, which is the maximum
number of errors the compiler reports before it exits. The
default value is 100.

Debugging Options
The debugging options enable you to generate and execute object files suitable for debugging.

The following compiler options are supported in Enterprise Developer when using ccbl (Windows) or
ccbl32 and ccb164 (UNIX) from the command line or the ACUOPT Compiler directive.

Note: The results of these options may differ slightly from how they appear in ACUCOBOL-GT
COBOL, as they map to the debugging Compiler directives in Enterprise Developer.

Option Definition

-Ga, -Gd, -G, -Gs, -Gy These options map to the ANIM Compiler directive
setting.

-Gz This option maps to the NOANIM Compiler directive
setting.

Miscellaneous Options

The miscellaneous options enable you to control a number of aspects of the generated object files, such as
bounds checking and optimization.

The following compiler options are supported in Enterprise Developer when using ccbl (Windows) or
ccbl132 and ccb164 (UNIX) from the command line or the ACUOPT Compiler directive.
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-Zr0
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Causes the compiler to generate code to test array
references at runtime. If an index is used which is out-of-
bounds, the runtime system displays an error message
showing the index value and the allowed bounds. (This
causes some extra code to be generated and prevents
certain table optimizations from occurring, so it should be
turned off once a program is fully debugged.) With this
option, the compiler does not re-use previously computed
index values.

This compact option optimizes for smaller code instead of
faster code.

This option is accepted by the compiler, but is ignored.

Although still supported, this option has been replaced by
the —Gd option. Both options produce the same results.

Enables the use of segmentation (overlays) in the source.
If this option is not used, section numbers will be ignored.

This option is accepted by the compiler, but is ignored.

Causes the program to be compiled as if it had the 1S
INITIAL PROGRAM phrase specified in its
PROGRAM-ID paragraph.

All data items may be larger than 64 KB. This option is
obsolete.

This turns off ACUCOBOL-GT's local optimizer. This is
useful primarily to see if the optimizer is introducing errors
in the generated object code. This option also prevents
the compiler from re-using previously computed index
values.

This option is accepted by the compiler, but is ignored.

Although still supported, this option has been replaced by
the -Gy option. Both options produce the same results.

This option lets you treat ACCEPT FROM DATE as
ACCEPT FROM CENTURY-DATE, and ACCEPT FROM
DAY as ACCEPT FROM CENTURY-DAY. If you use this
option, the 4-digit year format will be used for ACCEPT
FROM DATE providing that:

* The receiving field is numeric or numeric edited and
contains eight or more integer digits; or

e The receiving field is not numeric or numeric edited
and contains eight or more character positions.

If neither of the above conditions applies, then ACCEPT
FROM DATE will return its normal 6-digit format even if
you use -Z2y.

This option tells the compiler not to allow recursive
PERFORMSs. Event procedures require the ability to do
recursive PERFORMSs.
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-Zrl This option tells the compiler to allow recursive
PERFORMSs. Event procedures require the ability to do
recursive PERFORMSs.

32- and 64-Bit Code Generation
When compiling with the DIALECT"ACU" directive, the Compiler generates intermediate code that is bit
independent. By using ccbl, you can specify 32 or 64-bit intermediate code.

When compiling for generated code you must specify 32 or 64-bit. Enterprise Developer is bit-specific and
does not support cross-bit generation.

For UNIX environments

ccbl is sensitive to the current COBMODE setting. There are also the ccb132 and ccb164 commands,
which generate 32 or 64-bit code respectively. This is all analogous to cob.

For Windows environments

To produce bit-specific code, use ccbl from either a 32-bit or 64-bit command prompt.

ACUCOBOL-GT Conversion Issues

The syntax of most ACUCOBOL-GT source programs when submitted to run on this COBOL system will
be accepted and run successfully. However, sometimes this COBOL system might reject some of the
syntax in the original source program, or might cause your program to behave unexpectedly at run-time.

The following is not an exhaustive list of the restrictions of using ACUCOBOL-GT source code in
Enterprise Developer. In most cases, if your code includes ACUCOBOL-GT features not supported by
Enterprise Developer, you will receive a Compiler error.

Complementary ACUCOBOL-GT Technologies
In ACUCOBOL-GT, you can utilize a number of complementary technologies in your applications. In
Enterprise Developer, there are a number of technologies that provide equivalent or similar functionality.

You should compile your source code with the DIALECT"ACU" Compiler directive to give the fullest
ACUCOBOL-GT emulation in Enterprise Developer. If problems persist relating to any of the ACUCOBOL-
GT technologies listed below, refer to the documentation for the corresponding Micro Focus technology to
help remediate your code.

ACUCOBOL-GT technology Corresponding technology Notes

AcuConnect Thin Client None All syntax relating to this technology
should be removed from your source.

AcuServer Fileshare You can connect to your Vision files
through AcuServer, but the
functionality is limited.

Acu4GL Database Connectors Full documentation is available from
the Product Documentation section of
the SupportLine website (http://
supportline.microfocus.com).

AcuXDBC and AcuODBC XDBC Full documentation is available from
the Product Documentation section of
the SupportLine website (http://
supportline.microfocus.com).
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ACUCOBOL-GT technology Corresponding technology Notes

Xcentrisity for BIS Xcentrisity for BIS Full documentation is available from
the Product Documentation section of
the SupportLine website (http://
supportline.microfocus.com).

XML Extensions XML Extensions Full documentation is available from
the RM/COBOL product
documentation set in the Product
Documentation section of the
SupportLine website (http://
supportline.microfocus.com).

AcuSQL OpenESQL preprocessor Set the DIALECT"ACU" Compiler
directive in your source to enable this
preprocessor.

Graphical Technology (GT) There are various JAVA toolkits (for

example, Swing) that you can plug
into the Eclipse IDE that provide GUI
elements.

Configuration Files and Configuration Variables
ACUCOBOL-GT configuration files and configuration variables are not supported in Enterprise Developer.

Enterprise Developer uses different configuration files and variables. You need to review your existing
ACUCOBOL-GT configuration to determine which settings are relevant for use and which settings have
Enterprise Developer equivalents.

For example, some configuration settings for handling Vision files can be set in the default File Handler in
Enterprise Developer.

Some ACU configuration variables are not necessary or applicable in Micro Focus COBOL (for example,
PERFORM_STACK), and the functionality of others is covered by the Micro Focus compile and run-time
options (for example, A_CHECKDIV).

Multi-threading Implementation
The ACUCOBOL-GT multi-threading model differs from the multi-threading model implemented in
Enterprise Developer.

The ACUCOBOL-GT model contains some additional syntax not supported in Enterprise Developer. Refer
to Multi-threaded Programming for details of supported syntax and concepts in Enterprise Developer.

Screen Descriptions
Enterprise Developer and extend® differ in their support for some of the Screen Description phrases.

In Enterprise Developer, the following phrases of the Screen Description entry are not supported and
should be removed from your programs:

AFTER
BEFORE
EXCEPTION

Truncation Options in Managed Code
The -Dz truncation option is not supported in Managed COBOL.

It is, however, supported in native COBOL, using the ACUOPT Compiler directive.
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Unsupported Library Routines

The following ACUCOBOL-GT library routines are not (or will ever be) supported in Enterprise Developer
and will produce a COBRT097 Acu library routine is and will remain unimplemented
error. You should remove any calls to the following routines from your source code to avoid producing the

error.

Note: This list may contain customer-specific routines that are not found in the ACUCOBOL-GT

product documentation.

C$ASYNCPOLL C$RESOURCE W$GETC
C$ASYNCRUN C$SERVER-EXTENSION WS$GETCHAR
C$CHAIN C$SETERRORFILE W$GETCGI
C$CHARTERR C$SETEVENTDATA WS$GETURL
C$CONFIG C$SETEVENTPARAM WS$INPUTMODE
C$EXCEPINFO C$SETVARIANT WS$KEYBUF
C$GETVARIANT C$TOJIS W$MENU
C$GETEVENTDATA KEISEN1 W$MOUSE
C$GETEVENTPARAM KEISEN2 WS$PALETTE
C$GETERRORFILE KEISEN-SELECT W$POSTURL
C$GETNETEVENTDATA SYSID WS$STATUS
C$KEYMAP W$BROWSERINFO $HP-CURRENT-DATE
C$PRODKEY W$FORGET $HP-TIME-OF-DAY

There is also another list of library routines that are not currently supported, but may be in the future.
These also produce a run-time error COBRT098 The library routine is not available in
Visual COBOL (routine-name) Please contact Micro Focus Customer Care for
information and must be removed from your source code whilst they are not supported.

ASCIIZHEX C$RCONVERT REG_CREATE_KEY_EX
ASCII20CTAL C$RECOVER REG_DELETE_VALUE
HEX2ASCII C$REDIRECT REG_ENUM_VALUE
KEISEN C$SOCKET REG_QUERY_VALUE_EX
OCTAL2ASCII C$SYSLOG REG_SET_VALUE_EX
C$CODESET R$IO S$io

C$DISCONNECT REG_OPEN_KEY $WINHELP

C$EXTINFO REG_CLOSE_KEY W$BITMAP

C$FILESYS REG_CREATE_KEY W$FLUSH

CS$JAVA REG_DELETE_KEY WS$FONT
C$KEYPROGRESS REG_ENUM_KEY W$PROGRESSDIALOG
CSLOCALPRINT REG_QUERY_VALUE WS$TEXTSIZE
C$OPENSAVEBOX REG_SET_VALUE WIN$PLAYSOUND
C$PARSEXFD REG_OPEN_KEY_EX WINS$PRINTER

C$PING

For a list of currently supported library routines, refer to ACUCOBOL-GT Library Routines.

Using Pipes to Assign Filenames When Using the Vision File Handler
When assigning filenames, you cannot use certain pipes to assign a filename in the ASSIGN clause of the
SELECT statement if you are using the Vision file handler.
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The ACUCOBOL-GT syntax of assigning a file using the -P, -D, and -F syntax is not supported in
Enterprise Developer; for example:

select test-file assign to "-P %TMP% cmd /c dir *.* > %TMP%"

select test-file assign to "-P Is *"

If your applications use this syntax, you should remove it from your SELECT statements.

For more information on the pipes that are supported, read Programming > File Handling > File Handling
Guide > Filenames > Setting Up Pipes.

ACUCOBOL-GT File Handling

Enterprise Developer allows you to continue to use your existing ACUCOBOL-GT data files, including
Vision indexed data files.

Those files can also continue to be used through AcuServer, with minimal changes to your code required.

Alternatively, you can convert your Vision files to Micro Focus format. There is no need to convert your
sequential data files.

Configuring Access to Vision Files
To handle Vision files, you map a file to a compatible IDXFORMAT in the File Handler configuration file.

Within the configuration file, you can map an IDXFORMAT to all files in a particular folder, all files with a
specific file extension, or a single file. See Format of the Configuration File for the tags that you can use for
the mapping, and the order in which settings in these tags are applied.

The order that the mapping is applied is important, as conflicting settings can be overwritten; for example,
the following excerpt of the configuration file sets all files in c:\Files\rmfiles (Windows) or usr/
files/rmfiles (UNIX) to IDXFORMAT 21 and all files with a .DAT extension to IDXFORMAT 17:

Windows:

[FOLDER:C:\\Ffiles\\rmfiles]
IDXFORMAT=21

[*.DAT]
IDXFORMAT=17

UNIX:

[FOLDER:usr/files/rmfiles]
IDXFORMAT=21

[*.DAT]
IDXFORMAT=17

If there is a .DAT file in c:\Files\rmfiles (Windows) or usr/files/rmfiles (UNIX), the mappings
are applied according to the type of tag. In the case above, mappings in the extension tag are applied after
mappings in the FOLDER tag, and so the .DAT file in that directory has an IDXFORMAT of 17.

By default, the File Handler handles all sequential and relative data files, but if you want to handle them
through the Vision file handler, use the INTEROP=ACU configuration option; however, in cases where the
INTEROP and IDXFORMAT mappings conflict, the INTEROP setting will override IDXFORMAT for your
Vision indexed data files.

Vision Related Utilities
Vision provides a series of utilities that enable you to manipulate Vision files from the command line.
Windows Platforms:

Each utility is available in a 32-bit and a 64-bit version, located in %ProgramFiles(x86)%\Micro
Focus\Enterprise Developer\binn and \binn64 respectively.
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UNIX Platforms:

Each utility is available in a 32-bit and a 64-bit version, located in $COBDIR/bin. The version executed is
determined by the COBMODE environment variable.

Commands

vutil32 (Windows) and
mfvutil (UNIX)

vio32 (Windows) and
mfvio (UNIX)

logutil32 (Windows) and
mflogutil (UNIX)

acusort (Windows) and
mFvissort (UNIX)

Converting Vision Files

Rebuilds a file that has become corrupt, or one that contains a large
number of deleted records that you want to remove from the file.

Enables you to collect a group of files together into archives, and allows
you to extract some or all of these files from these archives.

Enables you to examine and edit an ACUCOBOL-GT transaction log file.

Enables you to sort or merge Vision files.

You can access your Vision files using the File Handler, but if you prefer to convert them to Micro Focus
format, as part of a migration, using the following:

ACU2MFDataMigration
utility

complete the conversion wizard.

Data File Converter

Focus format.

Use ACU2MFDataMigration.exe, a utility available from the folder in which
the product samples are installed. The utility contains Help on how to

Use the Micro Focus Data File Converter to convert your Vision files to Micro

Characher sat convarsion

[~ Convert characher st

[ Data File Convert
Inpiat ke
Filename : Lok \d st atooishEnample Files'\Multiple F.epshac
Fairnat iz Chasackes et ; |AMSI | g
Diganization:  Irdexed Sequential Miew ke, |

=
e file
Fiename | Browse
Frrmnat : Micia Focus it Chatactes s=t ; ANSI|
Drganization |5|::pcnlla" B |
[T Wariabde length recods
:|| Magmmum length : '-T'L

[~ Compress data ecords

Load peafile, | Save profile.. I Canverl | Cancel I

DFCONV command line Use DFCONYV from the command line, specifying Vision as the input format

utility

for the file.
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Configuring Access to Data Files Through AcuServer
Configure your converted applications to access data files through AcuServer.

Note: It is assumed that your environment and server is already configured correctly for using
AcuServer.
Syntax:
To access a data file through AcuServer, the following syntax must be passed to the file handler:
Windows:

acurfap://servername: [port]:path\to\file

UNIX:
acurfap://servername: [port]:/path/to/file

acurfap://
The protocol to use for AcuServer. This does not change.

servername
The name of the AcuServer server.

port

The server port to use when connecting to AcuServer. This is optional, and if omitted, the
default port number is used.

path/to/file
The path name to the file.

Specifying the file explicitly:

You can specify the full syntax in the SELECT statement. For example, the following statement connects to
the server asvrl, on port 3011, then locates the file 1dx1 at C:\idx\ (Windows) or /7home/idx/
(UNIX).

Windows:

select acusvridx assign to acurfap://asvrl:3011:c:\idx\idx1l.

UNIX:

ééiect acusvridx assign to acurfap://asvrl:3011:/home/idx/idx1.

Specifying the file implicitly:

If you are not explicitly using the AcuServer syntax in your SELECT statement, for example:

select acusvridx assign to idxl.

you must specify it in the COBDATA environment variable using the syntax described above:

Windows:
set COBDATA=%COBDATA%; "acurfap://servername:port:path/to/file"

UNIX:
export COBDATA=$COBDATA: ""acurfap://servername:port:path/to/file""

The following example connects to the server asvr2, on the default port, then locates the file in the
SELECT statement at c:\idx\ (Windows) or Zhome/idx/ (UNIX).
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Windows:
set COBDATA=%COBDATA%; "acurfap://asvr2::c:\idx"

UNIX:
export COBDATA=$COBDATA: ""acurfap://asvr2::/home/idx""

Note: An additional set of quotation marks is required around the AcuServer syntax to preserve the
original quotation marks. (UNIX only)

If a path name is specified in COBDATA, it is prepended to the file name before file name mapping takes
affect.

You must also compile with FILETYPE=17 if you are using a sequential file, or if your file handling
configuration file does not specify IDXFORMAT=17 for the Vision file.

File name mapping:

If you have used any ACUCOBOL file name mapping techniques to specify an AcuServer file, you will
need to update the configuration to use Micro Focus file name mapping. Use the following table as a guide
to some of the equivalents in this COBOL system.

ACUCOBOL variable Replace with

FILE_CASE FILECASE configuration option
FILE_PREFIX COBDATA environment variable
FILE_SUFFIX FILESUFFIX configuration option
APPLY_FILE_PATH n/a

FILE_ALIAS_PREFIX dd_ mapping

Restrictions

The encryption and password protection features are not supported in Enterprise Developer.

ACUCOBOL-GT Library Routines

This COBOL development system provides a number of ACUCOBOL-GT library routines in native and
managed code.

C$CALLEDBY
Returns the name of the caller of the currently running COBOL program or spaces if no caller exists or if
the caller is unknown.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

Usage

CALL "C$CALLEDBY"
USING CALLING-PROGRAM
GIVING CALL-STATUS

Parameters

CALLING-PROGRAM PIC X(n) Contains the name of the calling program or spaces if no
caller exists or if the caller is unknown. The runtime will
use as much space for the name or spaces as the
COBOL program allows. If the object being called is in an
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object library, the program returns the PROGRAM-ID. If
the object is not in an object library, the disk name is
returned.

CALL-STATUS PIC S99 This parameter receives one of the following values:

1 - Routine called by another COBOL program

0 - Routine is the main program; no caller exists

-1 - Caller unknown; routine not called by a COBOL
program

Compatibility Issues

None.

C$CALLERR
Retrieves the reason why the last CALL statement failed. For accurate information, it must be called before
any other CALL statement is executed.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

Usage
CALL "C$CALLERR™

USING ERR-CODE, ERR-MESSAGE
Parameters
ERR-CODE PIC X(2)

This parameter receives one of the following values:

01 Program file missing or inaccessible

02 Called file not a COBOL program

03 Corrupted program file

04 Inadequate memory available to load program

05 Unsupported object code version number

06 Recursive CALL of a program

07 Too many external segments

08 Large-model program not supported (returned only by runtimes that do not support large-model
programs)

09 Exit Windows and run "share.exe" to run multiple copies of "wrun32.exe" (returned only by Windows
runtimes)

14 Japanese objects are not supported (returned only by runtimes that do not support Japanese objects)

ERR-MESSAGE PIC X(n) (optional)

This routine may optionally be passed a second alphanumeric parameter. This parameter is filled in with a
descriptive message about the error encountered.

Compatibility Issues

e Only ERR-CODE 01 is returned in this COBOL system.
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» ERR-MESSAGE is always set to SPACES.

C$CHDIR
Changes the current working directory.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

Usage

CALL "C$CHDIR™
USING DIR-NAME, ERR-NUM

Parameters
DIR-NAME PIC X(n) Contains the name of the new directory, or spaces.
The "@[DISPLAY]:" for Thin Client support is allowed.
For example:
C$CHDIR "@[DISPLAY]:C:\path"
In Thin Client environments, to get the current default
directory on the display host, DIR_NAME should contain
"@[DISPLAY]:" followed by spaces.
ERR-NUM PIC 9(9) COMP-4 (optional) Holds the returned error number, or zero on success.
Comments

If a second USING parameter is passed, it must be described as PIC 9(9) COMP-4. This parameter will be
set to ZERO if the directory change is successful. Otherwise, it will contain the operating system's error
number.

If DIR-NAME contains spaces, then the current default directory is returned in it. In this case, ERR-NUM is
not used. Otherwise, DIR-NAME should contain the name of a directory to make the new default directory.
On Windows machines, this can include a drive letter. If you pass ERR-NUM, it will be set to zero if the
change was successful. Otherwise, ERR-NUM will contain the error value returned by the operating
system.

On some systems (such as VMS), it is legal to switch to a directory that does not exist, while other systems
(Windows, UNIX) do not allow it.

The behavior of this routine is affected by the FILENAME_SPACES configuration variable. The value of
FILENAME_SPACES determines whether spaces are allowed in a file name.

IMPORTANT

If you use C$CHDIR, create a CODE_PREFIX configuration entry to locate your object files. Ensure that all
of the search locations specified by the CODE-PREFIX are full path names. Do not use the current
directory or any relative path names in the CODE_PREFIX. Without a full path name, the runtime system
may be unable to find your object files if it needs to re-open them.

For example, the runtime system must occasionally re-open an object file when:

e you are using the source debugger
« the program contains segmentation (overlays)
e you are using object libraries

If the object file was initially found in the current directory or a directory specified relative to the current
directory, and you then change the current directory with the C$CHDIR routine, the runtime system will not
be able to find the object file if it needs to re-open it. This will cause a fatal error and your program will halt.
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If you use C$CHDIR and you are running in debug mode, be sure to set CODE_PREFIX in the
configuration file, not in the environment. You may set CODE_PREFIX in the environment when you are
not in debug mode.

Compatibility Issues

e In JVM COBOL, this routine is not supported.
o "@[DISPLAY]" is not supported in this COBOL system.

« The FILENAME_SPACES configuration variable is not supported in this COBOL system. To use
filenames that contain spaces, enclose them in quotation marks.

« The CODE_PREFIX configuration variable is not supported in this COBOL system.

C$COPY
Creates a copy of an existing file.

Syntax:

CALL "CS$COPY™
USING source-file, dest-file, [file-type,]
[GIVING status]

Parameters:
source-file

PIC X(n)
dest-file

PIC X(n)
file-type

PIC X
status

Any numeric type

On Entry:
source-file

The path name of the file to be copied

dest-file
The path name of the destination file
file-type

The file organization of the source file.It must be one of: S (for sequential), R (for relative)
or | (for indexed).

This defaults to S if not specified.

On Exit:
copy-status

Returns zero if the copy is successful, or non-zero if not.

Comments:

To obtain an extended file status code for this operation, define status as comp xx comp-x and follow the
example in Extended File Status Codes.

C$DELETE
Deletes a file.
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Syntax:

CALL "C$DELETE™
USING file-name, [file-type,]
[GIVING status]

Parameters:
file-name

PIC X(n)
file-type

PIC X
status

Any numeric type

On Entry:
file-name

The pathname of the file to be deleted
file-type

The file organization of the filename. It must be one of: S (for sequential), R (for relative) or
| (for indexed).

This defaults to S if not specified.

On Exit:
status

Returns zero if the delete is successful, or non-zero if not.
Comments:

To obtain an extended file status code for this operation, define status as comp xx comp-x and follow the
example in Extended File Status Codes.

CS$FILEINFO
Retrieves some operating system information about a given file.

Syntax:

CALL "CS$FILEINFO"
USING file-name, file-info
GIVING status

Parameters:
file-name

PIC X(n)
file-info
Define the following group
01 file-info
03 file-size pic x(8) comp-x.
03 file-date pic 9(8) comp-X.
03 file-time pic 9(8) comp-X.
status
Any numeric type
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On Entry:
file-name

The name of the file

On Exit:
file-info
The group item to receive the file information

status
Returns zero if the delete is successful, or non-zero if not.

Comments:

To obtain an extended file status code for this operation, define status as comp xx comp-x and follow the
example in Extended File Status Codes.

C$GetlLastFileOp
Retrieves the last COBOL /O operation performed.

Use this library routine within a declarative procedure after an 1/O error has occurred.

Syntax:
CALL "C$GetLastFileOp"™ USING operation

Parameters:
operation

PIC X(20)

On Exit:

operation The name of the last I/O operation performed. The valid operations returned are:

Close ReadPreviousLock
Commit ReadPreviousNoLock
Delete Rewrite

DeleteFile Rollback

Open Start

ReadLock StartTransaction
ReadNextLock Unlock
ReadNextNoLock UnlockAll
ReadNoLock Write

Comments:
If the operation is longer than 20 characters, it is truncated to the right.

If the value SPACES is returned that indicates that no operation is available.

C$IUSTIFY
C$JIUSTIFY performs left or right justification of data and centering of data.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.
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Usage
CALL "C$SJUSTIFY"

USING DATA-ITEM, JUSTIFY-TYPE

Parameters

DATA-ITEM Any data item

This data item contains the data to be justified.

JUSTIFY-TYPE PIC X

This optional parameter contains one of three literal values:

L indicates left justification
R indicates right justification
C indicates centering

If this parameter is omitted, then "R" is implied.

Description

This routine removes all leading and trailing spaces from DATA-ITEM and justifies the remaining data as
indicated by JUSTIFY-TYPE. The resulting string is returned in DATA-ITEM. If centering is chosen, there
will be one more space on the right than on the left if an odd number of spaces is used.

Compatibility Issues
None

CS$LIST-DIRECTORY

The C$LIST-DIRECTORY routine lists the contents of a selected directory. Each operating system has a
unigue method for performing this task. C$LIST-DIRECTORY provides a single method that will work for all
operating systems.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

Usage

CALL "CSLIST-DIRECTORY"
USING OP-CODE, parameters

Parameters

OP-CODE PIC 99 COMP-X Indicates which C$LIST-DIRECTORY operation to
perform. The operations are described below.

Parameters vary depending on the op-code chosen.

Parameters provide information and hold results for the op-code specified. These parameters are
described below.

Description

CS$LIST-DIRECTORY allows you to get the names of files residing in a given directory. It accomplishes this
through three distinct operations. The first operation opens the specified directory. The second operation
returns the filenames in the list, one-at-a-time. The third operation closes the directory and deallocates all
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memory used by the routine. C$LIST-DIRECTORY has the following operation codes (defined in
acucobol .def):

LISTDIR-OPEN (VALUE 1)
Opens the specified directory. It has two parameters:
Directoryname PIC X(n)
Contains the name of the directory to open. This directory must exist, and you must have
permissions to read the directory. You may use remote name syntax if AcuServer is
installed on the remote machine. The "@[DISPLAY]:" for Thin Client support may be used.
For example:

CSLIST-DIRECTORY using listdir-open,
"@[DISPLAY]:C:\path™, pattern

Pattern PIC X(n)

Specifies the type of filename for which to search. This routine supports "wildcards,"
meaning that the character "*" will match any number of characters, and the character "?"
will match any single character. For example, you can search by file suffix (*.def) or by a
common part of a file name (acu*).

If the call to LISTDIR-OPEN is successful, RETURN-CODE contains a handle to the list. The value in
RETURN-CODE should be moved to a data item that is USAGE HANDLE. That data item should be
passed as the directory handle to the other C$LISTDIRECTORY operations. If the call to LISTDIR-OPEN
fails (if the directory does not exist, contains no files, or you do not have permission to read the directory),
RETURN-CODE is set to a NULL handle.

LISTDIR-NEXT (VALUE 2)

Reads each filename from the open directory. It has two parameters:
Handle USAGE HANDLE

The handle returned in the LISTDIR-OPEN operation.

Filename PIC X(n)

The location of the next filename to be returned. If the directory listing is finished, it is filled
with spaces.

The call to LISTDIR-NEXT can include an additional argument, LISTDIR-FILE-INFORMATION (defined in
"acucobol.def"), which receives information about the returned file name. This is an optional group item
which returns information about the following data items:

LISTDIR-FILE-TYPE
The file type can be one of the following:

B = block device
C = character device

D = directory

F = regular file
P = pipe (FIFO)
S = socket

U = unknown

LISTDIR-FILE-CREATION-TIME
The creation time is the date (and time) that the file was originally created.
LISTDIR-FILE-LAST-ACCESS-TIME

The last access time is the date (and time) that the file was last accessed by some
application (usually when the file was queried in some way).

LISTDIR-FILE-LAST-MODIFICATION-TIME
The last modification time is the date (and time) the file was last written to.

LISTDIR-FILE-SIZE
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The size of the file is given in bytes.

LISTDIR-CLOSE (VALUE 3)

Releases the resources used by the other operations. It must be called to avoid memory
leaks. It has one parameter, handle, which is the same data item used by the LISTDIR-
NEXT operation.

Handle USAGE HANDLE
The handle returned in the LISTDIR-OPEN operation.
Note: Because the supported file types vary by operating system, The data items in the above list
have slightly different meanings depending on your operating system. Even on operating systems that
support these values, some file systems may not. Some versions of the UNIX® operating system may

change these values when permissions are changed. Refer to your operating system documentation
for specific definitions.

Example

The following example lists the contents of a directory with repeated calls CSLISTDIRECTORY:

WORKING-STORAGE SECTION.
copy "‘def/acucobol.def".

01 pattern pic x(5) value "*.vbs".

01 directory pic x(20) value "/virusscan™.
01 filename pic x(128).

01 mydir usage handle.

PROCEDURE DIVISION.

MAIN.

* CALL LISTDIR-OPEN to get a directory handle.
call "CSLIST-DIRECTORY"
using listdir-open, directory, pattern.
move return-code to mydir.
if mydir = 0
stop run
end-if.
CALL LISTDIR-NEXT to get the names of the files.
Repeat this operation until a filename containing only
spaces is returned. The filenames are not necessarily
returned in any particular order. Filenames may be
sorted on some machines and not on others.
perform with test after until filename = spaces
call "CSLIST-DIRECTORY"
using listdir-next, mydir, filename
end-perform.
* CALL LISTDIR-CLOSE to close the directory and deallocate
* memory. Omitting this call will result in memory leaks.
call "CSLIST-DIRECTORY" using listdir-close, mydir.
stop run.

* ok ok ok %

Compatibility Issues

e You must compile with the DIALECT"ACU" Compiler directive when using this library routine.

e "@|[DISPLAY]" is not supported in this COBOL system.

* Under the optional LISTDIR-FILE-INFORMATION group item, the fields LISTDIR-FILE-CREATION-
TIME and LISTDIR-FILE-LAST-ACCESS-TIME only return zeroes.

C$LOCKPID

This routine returns the Process ID (PID) of the process holding the lock responsible for the previous file
lock or record locked condition encountered. This library routine works only with the Vision file system and
the UNIX platform.

Upgrading to Enterprise Developer for Eclipse | 65



Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

Usage

CALL "C$LOCKPID™"
GIVING PROCESS-I1D.

Parameter
PROCESS-ID PIC 9(n) This contains a numeric data item large enough to hold a
PID. On most platforms, PIC 9(5) is sufficient. On 64-bit
systems, PIC 9(7) is recommended.
Comments

C$LOCKPID returns a PROCESS-ID of 0 if you have not yet encountered a locked file or record, if the PID
is otherwise not found, or if you've used this routine with a non-UNIX runtime.

Compatibility Issues
None

C$MAKEDIR
Creates a new directory.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

C$MAKEDIR can make a directory only one level lower than an existing directory and cannot create more
than one level at a time.

Usage

CALL "C$MAKEDIR™"
USING DIR-NAME GIVING STATUS-CODE

Parameters

DIR-NAME PIC X(n) Contains the name of the directory to be created. This
should be either a full path name or a name relative to the
current directory. You may use remote name syntax in
combination with AcuServer to create a directory on a
remote machine.

The "@[DISPLAY]:" annotation for Thin Client support
may also be specified. For example:

C$MAKEDIR "@[DISPLAY]:C:\path"

STATUS-CODE Numeric data item. Receives the return status of the call to create a directory.
A return status of zero indicates that the directory was
successfully created; a status of one ("1") indicates
otherwise.

The behavior of this routine is affected by the
FILENAME_SPACES configuration variable. The value of
FILENAME_SPACES determines whether spaces are
allowed in a file name.
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Compatibility Issues

e "@|[DISPLAY]" is not supported in this COBOL system.

e The FILENAME_SPACES configuration variable is not supported in this COBOL system. To use
filenames that contain spaces, enclose them in quotation marks.

CSMEMCPY (Dynamic Memory Routine)
Copies bytes between any two memory locations.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

Usage

CALL "C$MEMCPY"
USING, BY VALUE, DEST-PTR, SRC-PTR, NUM-BYTES

Parameters

DEST-PTR USAGE POINTER or USING BY Contains the address of the first byte of the destination.
REFERENCE

SRC-PTR USAGE POINTER or USING BY Contains the address of the first byte of the source.
REFERENCE

NUM-BYTES USAGE UNSIGNED-INT or an unsigned Indicates the number of bytes to copy.
numeric literal

Description

This routine copies NUM-BYTES bytes of memory from the address contained in SRC-PTR to the address
contained in DEST-PTR. This routine is functionally similar to the MSCOPY (Dynamic Memory Routine)
routine except that parameters are passed by value instead of by reference. This routine can be used in
cases where M$PUT and M$GET are not adequate. Note that this routine is relatively dangerous to use. It
does not perform any error checking and can easily cause memory access violations if you pass it incorrect
data. In other words, this routine is a very low-level routine and should be used cautiously.

You do not need to pass POINTER data items for SRC-PTR and DEST-PTR. If you prefer, either or both

can be replaced by a data item passed BY REFERENCE. If you do this, then the address of the data item
is passed to CSMEMCPY. For example, you can copy 10 bytes to DEST-ITEM from the memory address
contained in SRC-PTR with:

CALL ""C$MEMCPY"
USING BY REFERENCE DEST-ITEM, BY VALUE SRC-PTR, 10

Compatibility Issues

None.

C$SMYFILE
Returns the filename of the disk file containing the currently executing program.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

This is especially useful if the disk file is an object library.

Usage

CALL ""C$MYFILE™
USING PROGRAM-NAME
GIVING CALL-STATUS
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Parameters

PROGRAM-NAME PIC X(n) Indicates the name of the disk file containing the currently
executing program, if known. The runtime will use as
much space for the name of the file as the COBOL
program allows. This parameter will contain the filename
just as the runtime received it. For example, if an object
library is loaded as . .Zardir/myarlib.lib, and a
program in myar 1 ib. Lib calls this routine,
PROGRAM-NAME will have a value of . .Zardir/
myarlib_lib.

CALL-STATUS PIC S99. This parameter receives one of the following values:

1 - PROGRAM-NAME was filled successfully

-1 - Program name unknown

Compatibility Issues

None.

CSNARG
This routine returns the number of parameters passed to the current program.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

Usage

CALL "C$NARG"
USING NUM-PARAM

Parameter

NUM-PARAM COMP-1

Description

This routine must be called with one USING parameter that must be a COMP-1 data item. This data item is
filled in with the number of parameters. If the calling program is a subprogram, then this will be the number
of USING items in the CALL statement that initiated the program. If the calling program is a main program,
then this will be the number of CHAINING parameters passed from the runcbl command line or the CHAIN
statement that initiated the program. CSNARG works only when the program is a called subroutine. It does
not work with the "CALL RUN" form of the CALL verb.

Compatibility Issues

« This routine is not supported in managed COBOL.
« Set the Compiler directive COMP1(BINARY) to set ACUCOBOL-GT behavior for COMP-1 data items.
e The "CALL RUN" statement is not supported in this COBOL system.

e In ACUCOBOL-GT COBOL, the number of parameters passed is calculated by the number of
parameters specified in the USING phase of the CALL statement in the calling program. In this COBOL
system, the number of parameters passed is calculated by the number of parameters the calling
program actually receives.
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C$PARAMSIZE
This routine returns the number of bytes actually passed by the caller for a particular parameter.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

Usage

CALL "C$PARAMSIZE"
USING PARAM-NUM,
GIVING PARAM-SIZE

Parameters
PARAM-NUM numeric parameter This value is the ordinal position in the Procedure
Division's USING phrase of the parameter whose size
you want to know.
PARAM-SIZE any numeric data item This item receives the number of bytes in the data item
actually passed by the caller.
Description

This routine returns the actual size (in bytes) of a data item passed to the current program by its caller. You
pass the number (starting with 1) of the data item in the Procedure Division's USING phrase, and C
$PARAMSIZE will return the size of the corresponding item that was actually passed. This can be useful
for handling data items of unknown size.

For example, suppose that you wanted to write a routine that could convert any data item to upper-case,
up to 10000 bytes in size. This routine could look like this:

IDENTIFICATION DIVISION.
PROGRAM-1D. MAKE-UPPERCASE.

DATA DIVISION.
WORK ING-STORAGE SECTION.
77 PARAM-SIZE  PIC 9(5).

LINKAGE SECTION.
77 PASSED-ITEM PIC X(10000).

PROCEDURE DIVISION USING PASSED-ITEM.
MAIN-LOGIC.
CALL "C$PARAMSIZE™ USING 1, GIVING PARAM-SIZE
INSPECT PASSED-ITEM( 1 : PARAM-SIZE )
CONVERTING "abcdefghi jkImnopgrstuvwxyz"
TO "ABCDEFGHIJKLMNOPQRSTUVWXYZ"
EXIT PROGRAM.

In this example, if you do not use C3PARAMSIZE, you have to pass a full 10000 bytes to this routine or
you get a memory usage error. By using C3PARAMSIZE and reference modification, only the memory

actually passed is referenced, and there is no error. CSPARAMSIZE works only when the program is a
called subroutine. It does not work with the "CALL RUN" form of the CALL verb.

If you pass a subitem of a linkage item in a CALL statement and the subprogram calls CSPARAMSIZE with
requesting the size of the parameter, it will get the size as described in the linkage section of the calling
program, unless that subitem is the first item of the linkage item. In that case, the size returned will be the
size of the original item.

Compatibility Issues

e This routine is not supported in managed COBOL.
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* In this COBOL system, the size of the item as specified in the calling program is always returned.

C$RERR
Returns extended file status information for the last I/O statement.

Syntax:
CALL "C$RERR"™ USING extend-stat [text-message, status-type]

Parameters:
extend-stat

PIC X(5) or larger
text-message

PIC X(n)

/ Note: This optional parameter is ignored in this COBOL system.
status-type

PIC9

/ Note: This optional parameter is ignored in this COBOL system.
On Exit:
extend-stat Returns the extended file status caused by the last file I/O
Comments:

The statuses returned are listed in the file status table found in Appendix E of the ACUCOBOL-GT product
documentation. If the file status (first two characters) is 30, the remainder of the information is the
operating system's status code explaining what caused the error. On some systems, the operating system
requires more than two digits for its status codes. That is why the C$RERR routine may be passed a field
that is larger than four characters.

Whenever an error 30 occurs, the operating system's status value is returned in this extended field. The
number returned is a left-justified decimal value. If the receiving field is too small, the right-most digits are
returned. If the receiving field is too large, the excess characters are filled with spaces.

C$RERRNAME
Returns the name of the last file used in an 1/O statement.

Use it in conjunction with C3RERR to diagnose file errors.

Syntax:
CALL "C$SRERRNAME'™ USING file-name

Parameters:
file-name

PIC X(n)

On Exit:

file-name The name of the last file that was involved in an I/O statement.
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i Note: The filename is the one specified in the ASSIGN clause.

C$RUN

ACUCOBOL-GT for Windows supports an alternate method for running other programs. This is through the
library routine C$RUN. This library routine works identically to the SYSTEM library routine, except that the
calling program does not wait for the called program to finish. Instead, both programs run in parallel.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

Usage

CALL "C$RUN"
USING COMMAND-LINE,
GIVING STATUS-VAL

Parameters

COMMAND-LINE PIC X(n) Contains the operating system command line to execute.
STATUS-VAL Any numeric data item Returns O if successful or -1 if not.

Description

C$RUN sets STATUS-VAL to -1 if the call fails or to O if it succeeds.

C$RUN is implemented only under the Windows and Windows NT versions of ACUCOBOL-GT. On other
systems, it always returns 1.

C$RUN is supported in Thin Client environments. To execute a program on the display host in a thin client
environment, add the prefix @ DISPLAY] : to the name of any program that resides on the client machine.
For example:

C$RUN "@[DISPLAY]:C:\notepad myfile.txt

Compatibility Issues
"@[DISPLAYT" is not supported in this COBOL system.

C$SLEEP
This routine causes the program to pause in a machine efficient fashion.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

Usage

CALL "C$SLEEP"
USING NUM-SEC

Parameter

NUM-SEC Numeric or alphanumeric parameter The number of seconds to sleep.

This parameter is a an unsigned fixed-point numeric
parameter, or an alphanumeric data item containing an
unsigned fixed-point number.
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Description

This routine can be used to impose slight delays in loops. For example, you might want to introduce a
delay in a loop that is waiting for a record to become unlocked. Calling C$SLEEP will allow the machine to
execute other programs while you wait.

The C$SLEEP routine is passed one argument. This argument is the number of seconds you want to
pause. For example, to pause the program for five and a half seconds, you could use either of the
following:

CALL "CS$SLEEP™ USING 5.5
CALL "C$SLEEP'™ USING "5.5"

The amount of time paused is only approximate. Depending on the granularity of the system clock and the
current load on the machine, the time paused may actually be shorter or longer than the time requested.
Typically, the time paused will be within one second or one-tenth of a second of the amount requested
(unless the machine is excessively loaded).

If the sleep duration is zero, this function does nothing. If the sleep duration is signed, this function
generates a runtime error.

Compatibility Issues
None

C$TOUPPER and C$TOLOWER
These routines translate text to upper- or lower-case.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

Usage

CALL "C$TOUPPER™
USING TEXT-DATA, VALUE TEXT-LEN

CALL "C$TOLOWER'
USING TEXT-DATA, VALUE TEXT-LEN

Parameters

TEXT-DATA PIC X(n) Contains the data to translate to upper- or lower-case.
TEXT-LEN USAGE UNSIGNED-INT, or a numeric literal  Contains the number of characters to translate.

Description

C$TOUPPER translates the first TEXT-LEN characters in TEXT-DATA to upper-case. CSTOLOWER
translates them to lower-case. No size checking is done on TEXT-DATA, so you must ensure that TEXT-
LEN has a valid value. VALUE must be included in the calling statement. If it is omitted, the program will
very likely encounter memory errors. These routines only translate characters with a numeric value of
0-128. Anything above that (such as é, with a value of 130) must be mapped to its associated upper- or
lower-case character using the configuration variable UPPER-LOWER-MAP.

Compatibility Issues

« Calls to these routines immediately call the Micro Focus library routines CBL_TOUPPER and
CBL_TOLOWER.

I$10
The I$10 routine provides an interface to the file handler.
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Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

An operation code and some number of additional parameters (depending on the operation called) are
passed to the routine. The return code is set automatically after the call. The external variable F-ERRNO is
set according to any errors found. F-ERRNO may not be reset on entry to I1$10, and should be checked only
if 1$10 returns an error condition.

Usage
CALL "I1s$10"

USING OP-CODE, parameters

Parameters

OP-CODE Numeric parameter

Specifies the file handling routine to be performed. This table shows which operation corresponds to
each operation code. The operations are detailed in the description below:

Code Operation

1 OPEN-FUNCTION

2 CLOSE-FUNCTION

3 MAKE-FUNCTION

4 INFO-FUNCTION

5 READ-FUNCTION

6 NEXT-FUNCTION

7 PREVIOUS-FUNCTION
8 START-FUNCTION

9 WRITE-FUNCTION

10 REWRITE-FUNCTION
11 DELETE-FUNCTION
12 UNLOCK-FUNCTION
13 REMOVE-FUNCTION
14 SYNC-FUNCTION

15 EXECUTE-FUNCTION
16 BEGIN-FUNCTION

17 COMMIT-FUNCTION
18 ROLLBACK-FUNCTION
19 RECOVER-FUNCTION
21 IN-TRANSACTION-FUNCTION

parameters vary depending on the op-code chosen

The remaining parameters vary depending on the operation selected. They provide information and
hold results for the operations specified. All parameters are passed by reference. Parameters may be
omitted from those operations that do not require them.
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Description

All parameters passed to I1$10 are passed by reference. This applies even to parameters that are integer
values in the corresponding file handling routines. All numeric parameters should be passed to I1$10 as
SIGNED-SHORT values. The I$I0 routine provides any necessary addressing conversions. Note that a
parameter must be in the correct format for its type. Parameters that are PIC X must be terminated by a
LOW-VALUES character.

Except for the MAKE function, I$IO will automatically terminate any PIC X parameters with a LOW-
VALUES byte for you. Also, you do not have to specify SYNC for level 01 or level 77 parameters because
they are automatically synchronized by ACUCOBOL-GT.

The file Filesys.def is a COBOL COPY file that contains many useful definitions for use with 1$10. It
contains definitions for the 1$10 codes along with the F-ERRNO error values and many useful pre-declared
variables that are of the proper type and usage.

The behavior of this routine is affected by the FILENAME_SPACES configuration variable. The value of
FILENAME_SPACES determines whether spaces are allowed in a file name.

f Note: The runtime configuration variable FILE_PREFIX is ignored by the I1$1O routine.

Compatibility Issues

« TFfilesys.def is not supplied in this COBOL system.
« The FILENAME_SPACES configuration variable is not supported in this COBOL system.

MS$ALLOC (Dynamic Memory Routine)
Allocates a new area of dynamic memory.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

Usage

CALL "*M$ALLOC™
USING ITEM-SIZE, MEM-ADDRESS

Parameters
ITEM-SIZE Numeric parameter This indicates the number of bytes to allocate. This must
be greater than zero.
MEM-ADDRESS USAGE POINTER This holds the return value, either the address of the
allocated memory or NULL if the allocation fails.
Comments

The maximum amount of memory you may allocate in one call depends on the host machine, but is at least
65260 bytes for all machines (providing that much memory is available). MSALLOC adds some overhead
to each memory block allocated. This ranges between 4 and 16 bytes depending on the machine
architecture. Also, each operating system will typically add its own overhead. The debugger's U command
reports the amount of memory you have currently allocated via MSALLOC. The overhead added by M
$ALLOC is included in the total shown, but the operating system's overhead is not. Memory allocated by M
$ALLOC is initialized to binary zeros (LOW VALUES).

If you try to allocate more memory than the environment can give you, M$SALLOC will return NULL, and no
memory will be allocated.

Compatibility Issues

None.
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M$COPY (Dynamic Memory Routine)
Copies a region of memory from one location to another.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

Usage

CALL ""M$COPY"
USING DEST-PTR, SRC-PTR, NUM-BYTES

Parameters

DEST-PTR USAGE POINTER Contains the address of the first byte of the destination
region.

SRC-PTR USAGE POINTER Contains the address of the first byte of the source
region.

NUM-BYTES Numeric parameter Indicates the size of the memory region to be copied.

Description

This routine copies NUM-BYTES from the address contained in SRC-PTR to the address contained in
DEST-PTR. Note that this routine is relatively dangerous to use. No boundary checking is performed to
ensure that the address range is valid, so memory access violations may result if you pass it incorrect data.

This routine is functionally similar to the CSMEMCOPY routine except that parameters are passed by
reference instead of by value. For example, you can copy 10 bytes to DEST-PTR from the memory
address contained in SRC-PTR with:

CALL ""M$COPY"
USING DEST-PTR, SRC-PTR, 10

Compatibility Issues

None.

MS$FILL (Dynamic Memory Routine)
Sets a region of memory to a constant value.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

Usage

CALL "MS$FILL™
USING DEST-PTR, BYTE-VALUE, NUM-BYTES

Parameters

DEST-PTR USAGE POINTER Contains the address of the first byte of the region to be
filled.

BYTE-VALUE Alpha-numeric parameter Contains the value with which to fill the memory region.

NUM-BYTES Numeric parameter Indicates the size of the memory region.

Description

This routine fills NUM-BYTES with BYTE-VALUE starting at address DEST-PTR. The parameters are
passed BY REFERENCE. This routine does not do any boundary checking to make sure that the address
range is valid.
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Compatibility Issues

None.

M$FREE (Dynamic Memory Routine)
Frees a previously allocated piece of memory.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

Usage

CALL "MS$FREE™"
USING MEM-ADDRESS

Parameter
MEM-ADDRESS USAGE POINTER Must point to a memory area previously allocated by M
$ALLOC.
Comments

Use M$FREE to release a memory block allocated by M$SALLOC. This memory is returned to the pool of
memory available for use by the runtime. On most operating systems, this memory is still associated with
the runtime's process, so it cannot be used by any other processes. On a few systems, this memory may
be made available to the operating system for re-use by other processes.

It is an error to attempt to use a block of memory once it has been freed. It is also an error to free a block of
memory more than once or to free a memory address that has never been allocated. Any of these errors
can lead to memory access violations. The runtime attempts to detect these errors and avoid them, but it
cannot detect all such errors.

Compatibility Issues

None.

MS$GET (Dynamic Memory Routine)
Retrieves data from an allocated memory block.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

Usage

CALL "M$GET"
USING MEM-ADDRESS, DATA-ITEM, DATA-SIZE, DATA-OFFSET

Parameters
MEM-ADDRESS USAGE POINTER Must point to a memory area previously allocated by M
$ALLOC.
DATA-ITEM Any data item Data from the memory block will be stored in this item.
DATA-SIZE Numeric parameter (optional) The number of bytes to move from the memory block. If
omitted, then the number of bytes is set to the size of the
memory block (excluding overhead bytes).
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DATA-OFFSET Numeric parameter (optional) The location within the memory block from which to start
the move. The first location is position 1. If omitted, this
value defaults to 1.

Description

This routine retrieves data from the memory block at MEM-ADDRESS and stores it in DATA-ITEM.
Regardless of the value of DATA-SIZE, no bytes are copied from past the end of the memory block. Note
that the size of DATA-ITEM is not checked.

Compatibility Issues

None.

M$PUT (Dynamic Memory Routine)
Stores data in an allocated memory block.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

Usage

CALL "M$PUT"
USING MEM-ADDRESS, DATA-ITEM, DATA-SIZE, DATA-OFFSET

Parameters

MEM-ADDRESS USAGE POINTER Must point to a memory area previously allocated by M
$ALLOC.

DATA-ITEM Any data item This is the data that will be stored in the memory block.

DATA-SIZE Numeric parameter (optional) The number of bytes to move to the memory block. If

omitted, then the number of bytes is set to the size of the
memory block (excluding overhead bytes).

DATA-OFFSET PIC 9(n), USAGE DISPLAY or COMP-4  The location within the memory block from which to start
(optional) the move. The first location is position 1. If omitted, this
value defaults to 1.

Description

This routine copies DATA-ITEM into the memory pointed to by MEM-ADDRESS for DATA-SIZE bytes.
Regardless of the value of DATA-SIZE, no bytes are copied that exceed the size of the memory block at
MEM-ADDRESS.

Compatibility Issues

None.

RENAME
Renames a file.

Syntax:

CALL ""RENAME™
USING source-file, dest-file, [status,] [file-type]
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Parameters:
source-file

PIC X(n)
dest-file

PIC X(n)
status

Any numeric type
file-type

PIC X

On Entry:
source-file

The path name of the file to be copied
dest-file

The path name of the destination file
file-type

The file organization of the source file. It must be one of: S (for sequential), R (for relative)
or | (for indexed).

This defaults to S if not specified.

On Exit:
status

Returns zero if the rename is successful, or non-zero if not.
Comments:

To obtain an extended file status code for this operation, define status as comp xx comp-x and follow the
example in Extended File Status Codes.

WINSVERSION
Returns version information for Windows and Windows NT host platforms.

Note: This ACUCOBOL-GT library routine is available in this COBOL version. Any compatibility
issues in this COBOL system are in the Compatibility Issues section at the end of the topic.

This routine provides more information about the system than is returned by the ACCEPT FROM
SYSTEM-INFO statement.

Usage

CALL "WINSVERSION"
USING WINVERSION-DATA

Parameters
WINVERSION-DATA Group item as follows: 01 WINVERSION-DATA.
03 WIN-MAJOR-VERSION PIC X
COMP-X.
03 WIN-MINOR-VERSION PIC X
COMP-X
03 WIN-PLATFORM PIC X
COMP-X
88 PLATFORM-WIN-31 VALUE
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1.
88 PLATFORM-WIN-95 VALUE
2.
88 PLATFORM-WIN-9X VALUE
2.
88 PLATFORM-WIN-NT VALUE
3.
03 WIN-WORDSIZE PIC X
COMP-X.
88 WIN-WORDSIZE-16 VALUE
1.
88 WIN-WORDSIZE-32 VALUE
2.
88 WIN-WORDSIZE-64 VALUE
3.
03 WIN-
BUILDNUMBER PIC X(4)
COMP-X.
03 WIN-
CSDVERSION PIC
X(128).
03 WIN-SERVICEPACK-
MAJOR PIC X COMP-X.
03 WIN-SERVICEPACK-
MINOR PIC X COMP-X.
03 WIN-
SUITEMASK PIC X(4)
COMP-X.
03 WIN-
PRODUCTTYPE PIC X
COMP-X.
88 WIN-NT-
WORKSTATION VALUE 1.
88 WIN-NT-DOMAIN-
CONTROLLER VALUE 2.
88 WIN-NT-
SERVER VALUE 3.
WINVERSION-DATA is found in the COPY library
winvers.def.

Comments

Upon return from WIN$VERSION, all of the data elements contained in WINVERSION-DATA are filled in. If
you call WIN$SVERSION and the host machine is not a Windows or Windows NT system, the fields are set
to zero.

The WINVERSION-DATA fields have the following meaning:

«  WIN-MAJOR-VERSION - The major version number reported by Windows. See table below for possible
values.

e WIN-MINOR-VERSION - The minor version number reported by Windows. See table below for possible
values.

Windows Version WIN-MAJOR-VERSION WIN-MINOR-VERSION Other
Windows 98 4 10

Windows ME 4 90

Windows XP 5 1 Not applicable.
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Windows Version WIN-MAJOR-VERSION WIN-MINOR-VERSION Other

Windows XP Professional 5 2 OSVERSIONINFOEX.wPro

x64 Edition ductType ==
VER_NT_WORKSTATION)
&&
(SYSTEM_INFO.wProcess
orArchitecture==PROCESS
OR_ARCHITECTURE_AM
D64

Windows NT 4 0
Windows 2000 5 0 Not applicable

Windows Vista 6 0 OSVERSIONINFOEX.wPro
ductType ==
VER_NT_WORKSTATION

Windows 7 6 1 OSVERSIONINFOEX.wPro
ductType ==
VER_NT_WORKSTATION

Windows Server 2008 R2 6 1 OSVERSIONINFOEX.wPro
ductType !=
VER_NT_WORKSTATION

Windows Server 2008 6 0 OSVERSIONINFOEX.wPro
ductType !=
VER_NT_WORKSTATION

Windows Server 2003 R2 5 2 GetSystemMetrics(SM_SE
RVERR?2) =0

Windows Home Sever 5 2 OSVERSIONINFOEX.wSuit
eMask &
VER_SUITE_WH_SERVE
R

Windows Server 2003 5 2 GetSystemMetrics(SM_SE
RVERR?2) ==

* WIN-PLATFORM - Provides a general description of the host system. If the host is Windows NT/
Windows 2000, the value is set to PLATFORM-WIN-NT. If the host is Windows 98, the value is set to
PLATFORM-WIN-9X.

e WIN-WORDSIZE - This item is set to WIN-WORDSIZE-32 for a 32-bit runtime.

* WIN-BUILDNUMBER - Identifies the build number of the operating system.

« WIN-CSDVERSION - Indicates the latest Service Pack installed on the system. If no Service Pack has
been installed the string is empty.

e  WIN-SERVICEPACK-MAJOR - Indicates the major version number of the latest Service Pack installed
on the system. If no Service Pack has been installed the value is 0.

e WIN-SERVICEPACK-MINOR - Indicates the minor version number of the latest Service Pack installed
on the system. If no Service Pack has been installed the value is 0.

« WIN-SUITEMASK - This is a bit mask that identifies the product suites available on the system. Refer to
the operating system documentation for a list of possible values.

« WIN-PRODUCTTTYPE - Identifies additional information about the system.

Compatibility Issues

The copybook winvers.def is not available in this COBOL system.
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The following fields are not supported in this COBOL system:

o WIN-BUILDNUMBER

« WIN-CSDVERSION

o  WIN-SERVICEPACK-MAJOR
o WIN-SERVICEPACK-MINOR
o WIN-SUITEMASK

« WIN-PRODUCTTTYPE

These fields will return spaces or zeroes, as appropriate.

ACUCOBOL-GT Windowing Syntax

Your COBOL system provides some support for ACUCOBOL-GT windowing syntax that enables you to
draw lines and boxes on the terminal screen, and create virtual terminal windows on a physical terminal. All
ACCEPT and DISPLAY statements then act within the current window (except for ACCEPT format 1, 2, or
3 statements, DISPLAY format 1 statements, and DISPLAY WINDOW/LINE/BOX statements). The syntax
also enables underlying displays to be kept and restored.

f Note: This functionality is supported in native COBOL only.

Windowing Syntax Summary
Your COBOL system includes the following syntax to support windowing:
* BEFORE TIME phrase in ACCEPT statement

Format 5 of the ACCEPT statement has the BEFORE TIME phrase, which enables you to specify a
timeout period. If the user does not enter data during this period, the statement is terminated
automatically.

» DISPLAY WINDOW

DISPLAY WINDOW creates a terminal window (a rectangular region of the screen) and makes it the
current window. This is like a virtual terminal, in which screen positions used by subsequent ACCEPT/
DISPLAY statements are relative to the top left corner of the window.

« DISPLAY LINE

DISPLAY LINE enables you to draw lines on the terminal (real or virtual). The best mode available on
the terminal is used automatically. Used with the DISPLAY BOX statement, the DISPLAY LINE
statement enables you to draw forms on the terminal.

* DISPLAY BOX

DISPLAY BOX enables you to draw boxes on the terminal. The best mode available on the terminal is
used automatically. Used with the DISPLAY LINE statement, the DISPLAY BOX statement enables you
to draw forms on the terminal.

» CLOSE WINDOW

CLOSE WINDOW removes a window. If you specify the window as being a POP-UP window, the
underlying display can be restored.

Enabling Windowing Support
In order to use the windowing syntax, you must use the PREPROCESS"window1" Compiler directive.
You can specify this directive in one of two ways.

* Inyour source file, use the following line:
$SET preprocess"windowl"
e From the command line, include the PREPROCESS"windowl" directive:
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Windows:
cobol prog.cbl preprocess"windowl' color endp;

UNIX:
cob -C preprocess=windowl prog.cbl

The PREPROCESS "window1" directive must be the last Compiler directive apart from NOERRQ,
AUTOCLOSE or COLOR. If an error is encountered, the Compiler asks if you wish to continue, and waits
for your response. In order to disable this function, you must specify the NOERRQ directive after
PREPROCESS"windowl".

Windowing Support Syntax

The following sections give details of the windowing syntax enabled by the PREPROCESS"window1"
directive.

The ACCEPT Statement
BEFORE TIME time-out

General Rules:

1. The BEFORE TIME phrase allows you to automatically terminate an ACCEPT statement after a certain
amount of time has passed. The timeout value specifies the time to wait in hundredths of a second. For
example, "BEFORE TIME 500" specifies a timer value of 5 seconds.

2. The user must enter data to the ACCEPT statement before the timer elapses. As soon as the user
starts entering data, the timer is canceled and the user may take as much time as desired to complete
the entry. If the user does not enter any data before the timer elapses, then the ACCEPT statement
terminates.

The CLOSE WINDOW Statement

Format:
CLOSE WINDOW window-save-area

Syntax Rules:

1. window-save-area must be an elementary data item described with a PIC X(10) clause. It must have
been the object of a POP-UP AREA phrase in a DISPLAY WINDOW statement.

General Rules:

1. The CLOSE WINDOW statement is used to remove popup windows created by the POP-UP AREA
option of the DISPLAY WINDOW statement.

2. window-save-area must have been the object of a POP-UP phrase of a DISPLAY WINDOW statement
that has been executed in this run unit. Furthermore, since that execution, it must not have been the
object of a CLOSE WINDOW statement, nor can it have been modified by any other statement.
Violation of these rules causes undefined results.

3. The CLOSE WINDOW statement restores the contents of the terminal screen that was in the active
window when the corresponding DISPLAY WINDOW statement executed. In other words, the window
that was created by that DISPLAY WINDOW statement is removed from the screen and replaced by the
contents of the screen which were under that popup window.

4. The window that was active when the corresponding DISPLAY WINDOW statement executed becomes
the active window, thereby becoming the top window and overlaying any other windows that might be
present.
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Comments:

The current window is selected by closing windows identified by their respective window-save-area data
items, as in the following example:

If five popup windows are created, a, b, c, d and e in that order:

If d is closed, c becomes current.

If b is then closed, a becomes current.

If e is subsequently closed, ¢ becomes current again.

The DISPLAY Statement

Format: for Format 1

DISPLAY WIN DA

AT LINE MURMBER line-num

AT {COLUMN} MUMBER col-num
E

REVERSE

REVERSE-%IDEC
REVERSED

HIGHLIGHT
LOWYLIGHT

WITH COLoR | Idertifier—3
intecer—3

FOREGROUMD-COLOLR

BACKGROUND-COLOUR

BOXED
SHADCWA

RIGHT

WITH MO SCROLL
WITH NO WRAP
POP-LP AREA |5 save-area

Format: for Format 2

FOREGROUNMD-COLOR = identifier-1
integer-1

BACKGROUND-COLOR 1= identifier-2
integer—2

ToOP CENTERED _
BoTToM [ §LEEL TITLE IS title

}
}
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AT LINE MUMBER ling-rim

AT COLUMN_} MUMBER col-num

REVERSE-%IDEC
REVERSE
REVERSED

HIGHLIGHT
LOWYLIGHT

WITH COLoR | Idertifier—3
intecer—3

CENTERED
LEFT TITLE |5 title
RIGHT

Format: for Format 3

DISPL&" Box

AT LINE MURMBER line-num

T {COLUMN} NUMBER col-num

coL
SIZE lergth
LIMES height
REVERSE-VIDED
REVERSE
REVERSED
HIGHLIGHT
LCWMLIGHT
WATH CoLoR | identifier3
| integer-3
{T o CENTERED
Lok LEFT TITLE |5 titls
BOTTOM} RIGHT

Syntax Rules:

1. line-num is a numeric literal or data item that specifies the line position on the terminal screen. It must
be a non-negative integer.

2. col-num is a numeric literal or data item that specifies the column position on the terminal screen. It
must be a non-negative integer.
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3. length is a numeric literal or data item that specifies the window-width, line-width or box-width in
character positions. It must be a non-negative integer.

4. height is a numeric literal or data item that specifies the number of lines in the window, line or box. It

must be a non-negative integer.

title is a non-numeric literal or alphanumeric data item.

save-area is an elementary data item described by a PIC X(10) clause.

COLUMN and COL are equivalent.

REVERSE and REVERSED and REVERSE-VIDEO are equivalent.

The COLOR phrase is supported only when the preprocessor directive COLOR is used. This adds
support for existing non-Micro Focus syntax.

10.Exactly one of the SIZE or LINES phrases must be specified for a Format 2 DISPLAY statement.
11.identifier-1, identifier-2, integer-1 and integer-2 must take a value in the range 0 through 7 as follows:

© NG

black
blue
green
cyan
red

magenta

S o0 A W N L, O

brown or yellow

7 white

12.identifier-3 and integer-3 must take a value which is obtained by adding together the appropriate values
from the following:

Color Foreground Background
Black 1 32

Blue 2 64

Green 3 96

Cyan 4 128

Red 5 160

Magenta 6 192

Brown 7 224

White 8 25

Note:

The foreground color values for use with the COLOR phrase are different from the standard Micro Focus
color values for FOREGROUND-COLOR, BACKGROUND-COLOR and so on.

In addition you can specify the following video attributes with the following values:

Reverse video 1024
Low intensity 2048
High intensity 4096
Underline 8192
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Blink 16384

13.1f a COLOR phrase is present at the same time as FOREGROUND-COLOR and/or BACKGROUND-
COLOR, then the colors defined in the COLOR phrase are ignored, but any non-color attributes are
actioned (where appropriate).

General Rules: for All Formats

1. The LINE and COLUMN phrases must specify a line or column on the physical screen.

2. On color systems, both the settings given in COLOR or FOREGROUND-COLOR and BACKGROUND-
COLOR and other attribute settings (for example blink) are used. On monochrome systems, all color
information supplied is ignored, and only other attribute settings used.

3. Not all combinations of attributes are supported on all systems. For example, on a standard DOS PC,
set to monochrome mode, REVERSE and UNDERLINE are mutually exclusive - only one of these
attributes is actioned.

General Rules: for DISPLAY WINDOW statement Format 1 (DISPLAY WINDOW)

1. The DISPLAY WINDOW statement creates and makes current a terminal window. The terminal window
is a rectangular region of your screen. Any ACCEPT or DISPLAY statements (apart from another
DISPLAY WINDOWY/LINE/BOX or a Format 1, 2 or 3 ACCEPT or Format 1 DISPLAY as described in
your Language Reference) affect only the current window. Furthermore, line and column numbers for all
ACCEPT and DISPLAY statements (apart from another DISPLAY WINDOW/LINE/BOX or a Format 1,
2 or 3 ACCEPT or Format 1 DISPLAY as described in your Language Reference) are computed from
the upper left-hand corner of the current window. That is, the current window defines a virtual terminal
screen which occupies some area of your physical screen.

2. The initial window is set to the entire screen.

3. The only way to change the current window is with another DISPLAY WINDOW statement or with the
CLOSE WINDOW statement.

4. The LINE NUMBER phrase sets the top line of the window. Line number one refers to the top line of the
screen. Line numbers are relative to the screen, and not to the current window.

5. If the LINE NUMBER phrase is not specified, is specified as zero, or is off the physical screen, the top
line of the screen is used.

6. The COLUMN NUMBER phrase sets the left-most column of the window. Column number one refers to
the left side of the screen. Column numbers are relative to the screen, and not to the current window.

7. If the COLUMN NUMBER phrase is not specified, is specified as zero, or is off the physical screen,
column number one is used.

8. The SIZE phrase sets the number of columns the window contains. If this causes the window to extend
past the right edge of the screen, the window's width extends off the screen.

9. If the SIZE phrase is not specified or is specified as zero, the window extends to the right edge of the
screen.

10.The LINES phrase sets the number of rows the window contains. If this causes the window to extend
past the bottom of the screen, the window extends off the screen.

11.1f the LINES phrase is not specified or is specified as zero, the window extends to the bottom edge of
the screen.

12.When the ERASE phrase is specified, the window is cleared immediately after it is created. Otherwise
the window's contents are not changed. Clearing a window sets it to spaces.

13.The BOXED phrase causes a box to be drawn around the new window. The box is drawn outside the
window. Any portions of the box that lie off the screen are not drawn.

14.The terminal's line drawing set is used to draw the box. If the terminal does not have a line drawing set,
equivalent ASCII characters are used. If the POP-UP phrase is also specified, the box overlays any
other boxes on the screen. If this phrase is not specified, the box drawn is attached to any other boxes
it intersects. When a boxed non-popup window intersects a boxed popup window, if the popup window
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is created first, when it is closed the points where the two window boxes intersected is not redrawn.
That is, intersection characters remain even though there is no longer an intersection.

15.The ERASE phrase is implied by the BOXED phrase.

16.The REVERSED phrase exchanges the window's foreground and background colors. This affects every
ACCEPT and DISPLAY statement in the new window.

17.The REVERSED phrase implies the ERASE phrase. This usually causes the entire window to be set to
reverse video spaces when it is initially created.

18.The SHADOW phrase causes the window to appear to float over the screen giving a three-dimensional
effect.

19.1f the color value for either foreground or background is set to 0 in the COLOR field, then the
corresponding color of the default system attribute is used.

20.The TITLE phrase causes the title to be printed in the window's border. This has its effect only if the
BOXED phrase is also specified.

21.Titles can be placed in one of six positions in the border region: top left, top center, top right, bottom left,
bottom center and bottom right. If TOP or BOTTOM is not specified, TOP is used. If LEFT, CENTERED
or RIGHT is not specified, CENTERED is used.

22.The NO SCROLL phrase is treated as documentary only; the Windows preprocessor displays a
message confirming this.

23.The NO WRAP phrase is treated as documentary only; the Windows preprocessor displays a message
confirming this.

24.The POP-UP AREA phrase causes your COBOL system to save system information prior to creating
the new window. This information can be used by the CLOSE WINDOW statement to subsequently
remove the new window and restore the underlying windows. This gives a popup window.

25.The save-area data item is filled in with system information. This data item must not be subsequently
modified in any way or results are undefined. It can be referenced in a CLOSE WINDOW statement to
restore an earlier window to the screen and re-establish that window as the current window.

General Rules: for DISPLAY LINE statement Format 2 (DISPLAY LINE)

1. The DISPLAY LINE statement enables you to draw vertical and horizontal lines in a machine- and
terminal-independent manner. The lines are drawn using the best mode available on the display device.
Used together with the DISPLAY BOX statement, this provides the ability to draw forms on your screen.
The DISPLAY LINE statement does not affect the positioning of full screen ACCEPT and DISPLAY
statements.

2. Lines are drawn so that when they intersect other lines on the screen, the appropriate intersection
character is used. This is done so that when the end of a line intersects another line, the appropriate
corner or three-way intersection is used.

3. If the SIZE phrase is specified, the line drawn is horizontal. The value of length gives the size of the line
in screen columns. If the LINES phrase is used instead, the line drawn is a vertical line and height
describes the number of screen rows to use.

4. Lines never wrap around or cause scrolling. If the LINES or SIZE phrase would cause the line to leave
the current window, the line is truncated at the edge of the window. If LINES or SIZE is zero, no line is
drawn.

5. The value of line-num gives the starting row of the line. The value of col-num gives the starting column.
Lines are always drawn to the right or downward as appropriate. line-num and col-num must specify a
position that is contained in the current window.

6. If the LINE NUMBER or COLUMN NUMBER phrases specify a point outside the physical screen, that
is, line-num = 0 or 24 (or your screen's maximum), or col-num = 0 or > 80, no line is drawn.

7. The TITLE phrase has effect only when drawing horizontal lines. When specified, title-string is printed in
part of the line.

8. The title can be printed near the right side, near the left side or in the center of the line depending on
the RIGHT, LEFT or CENTERED phrase specified. If none is specified, CENTERED is used.
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9.

The REVERSE phrase exchanges the foreground and background color of the line.

General Rules: for DISPLAY BOX statement Format 3 (DISPLAY BOX)

1.

5.
6.

The DISPLAY BOX statement enables you to draw a box in a machine- and terminal-independent
manner. The boxes are drawn using the best mode available on the display device. If the lines used in
drawing a box intersect other lines already present on the screen, the appropriate intersection
characters are used. The DISPLAY BOX statement does not affect the positioning of full screen
ACCEPT and DISPLAY statements.

. The location of the box is specified by providing the location of the upper-left corner. The size of the box

is specified by providing a height and a width.

If the LINE NUMBER or COLUMN NUMBER phrases specify a point outside the physical screen no box
is drawn.

The SIZE phrase specifies the width of the box. The LINES phrase specifies its height. If the SIZE
phrase is not specified, or zero, or such that the box would extend beyond the physical screen or the
edge of the window, the box extends to the right edge of the current window. If the LINES phrase is not
specified, or zero, or such that the box would extend beyond the physical screen, the box extends to the
bottom of the current window.

The REVERSE phrase operates in the same manner as it does for a DISPLAY WINDOW statement.
The TITLE phrase operates in the same manner as it does for the DISPLAY WINDOW statement.

Windowing Restrictions

This feature is not guaranteed to be intermediate code compatible, so you might need to recompile your
source code between product releases.

When using the ACCEPT or DISPLAY statements with this windowing syntax, you must include the AT
LINE NUMBER syntax (see your Language Reference) or items do not appear in the windows.

You should not use cobprintf() with these DISPLAY statements.

You should not use COPY REPLACING or REPLACE statements.

The windowing syntax is supported only for fixed format COBOL source.

The following reserved words have been introduced by the windowing syntax, so you should avoid
specifying them as user-defined words:

BOX BOXED CENTERED COLOR (if COLOR directive used) POP-UP SCROLLSHADOW WINDOW
WRAP

You should use only the ACCEPT and DISPLAY statements documented in your Language Reference
with this windowing syntax.

When using windowing syntax, the ANS85 Compiler directive is implied. You must not unset this
directive either explicitly or implicitly.

Alphanumeric literals must not be continued over the end of any line which includes a windowing
statement.

Some syntax errors, for example, spelling PROCEDURE DIVISION incorrectly, are flagged, but might
result in spurious error messages for following source lines.

Windowing syntax errors are serious errors, but are flagged in the form:

The -P cob flag should not be used with windowing syntax . You should instead use "-C list".

Column 73 must not be used within source programs which use windowing syntax, as this column is
always treated as being set to a space character.

The Compiler asks if you wish to continue after any error occurs. You can disable this function by using
the NOERRQ directive. You should not, however, use the NOERRQ directive when compiling from
within the Development Environment.

If no error occurred, or if an error occurred but you replied "no" to the question "do you wish to
continue”, the Compiler returns a zero error return code.
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« Each of the following statements must appear on a line by itself:

DISPLAY WINDOW DISPLAY BOX DISPLAY LINE CLOSE WINDOW EXIT PROGRAM
« The windowing subsystem is initialized automatically upon encountering the first windowing statement.
< If an application switches between using windowing syntax and other types of Accept/Display syntax, it
must close down the windowing system completely before starting to use other types of Accept/Display
syntax; otherwise the ACCEPT and DISPLAY statements may not have the desired effects.

You can create a subroutine to explicitly close the windowing system by compiling the following
subprogram:

$set preprocess "windowl"™ autoclose
procedure division

para-1.

exit program.

You then call this subprogram before switching to another type of Accept/Display syntax. The
AUTOCLOSE preprocessor directive causes the EXIT PROGRAM statement to close down the
windowing system before exiting the subprogram. The windowing subsystem is reinitialized upon
encountering another windowing statement. Each time the windowing subsystem initializes, the
background screen and contents are redisplayed.

*  When a window is active, or has been active in the run unit, use of the DISPLAY SPACES UPON CRT
statement clears the window to spaces but leaves attributes unchanged.

Windowing Error Messages

The following errors might be encountered during preprocessing.

Unexpected numeric literal

Unexpected alphanumeric literal

Unsupported keyword or noise word
Unrecognized clause to DISPLAY WINDOW
Unrecognized clause to DISPLAY LINE
Unrecognized clause to DISPLAY BOX
Unrecognized clause to ACCEPT FROM SCREEN
This keyword has already been used

This keyword conflicts with another

This reserved word is used incorrectly

Wrongly formed or ordered clause with keyword
Error during preprocessing - no further details
Unknown COPY file specified

WINDOW1 preprocessor cannot handle free format

SCROLL/WRAP clause processed as comment The edit/compile/animate loop returns to an
incorrect line within your source program after
returning an error.

Windowing Supplementary Information

When the first windowing statement in your program is encountered the screen is redisplayed. This is
expected behavior and does not affect your program in any way.
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Upgrading from RM/COBOL®

There are a number of settings in Enterprise Developer that are designed specifically to ensure that your
existing RM/COBOL source code can compile and run in Enterprise Developer.

Refer to the Compatibility with RM/COBOL section for guidance and best practice on moving your
applications to Enterprise Developer. It covers:

* Supported RM/COBOL features, including detailed information on support for data types and
subprograms.

» Syntactical differences between the two COBOL dialects, including workarounds or equivalent syntax
where applicable.

« Details on how to configure your applications to continue using your RM/COBOL data files.

Compatibility with RM/COBOL

Enterprise Developer provides compatibility with the RM/COBOL programming language:
This enables you to migrate programs from this environment. You can:

e Convert applications written in RM/COBOL to the Micro Focus COBOL language, and enhance them
using the advanced language and development features offered by Enterprise Developer.

* Retain the use of the selected COBOL on some machine environments while moving to Enterprise
Developer on others. You might want to maintain a common set of source programs which are suitable
for all environments.

Note: Any error messages and numbers that are returned when you compile your program in
Enterprise Developer or when you execute the resulting code are different in the two environments.
This should present no problems, but is something of which you should be aware.

Converting RM/COBOL Applications

By default, this COBOL system already supports much of the RM/COBOL syntax and behavior. Additional
RM/COBOL-specific syntax that has been added for compatibility is documented in the section RM/COBOL
Syntax Support in your Language Reference.

You can also enable additional RM/COBOL behavior using certain Compiler directives. Using these
directives when you submit your RM/COBOL source programs to this COBOL system ensures that most of
the programs are accepted the first time they are submitted. There are still certain compatibility issues
between the two COBOL systems, which are detailed, with any possible workarounds, in the RM/COBOL
Conversion Issues section.

There is also a modernization tool available that helps to locate and transform incompatibilities in your
legacy projects, and makes them compliant in this COBOL system. This tool is available as an AddPack;
see the Product Updates section of the SupportLine website (http://supportline.microfocus.com) for details
on the ACUCOBOL-GT to Visual COBOL Modernization AddPack.

Users of this AddPack should also join the ACUCOBOL-GT Modernization community group. Through this
group, you will have direct access to Micro Focus SupportLine, Technical Services, and Development staff
members, as well as other users who are modernizing their code. To join the group, first join the Micro
Focus Community (community.microfocus.com) if you have not already done so, then provide your
Community account name to your sales representative, who will request access on your behalf. You will
receive email notification when you have been added to the group.

Note: The AddPack was originally developed for ACUCOBOL-GT users, hence the naming of the
AddPack and community group.
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Compiler Directives for RM/COBOL Compatibility
You can set a number of Compiler directives in your RM/COBOL source programs that enable a program
to emulate RM/COBOL behavior.

The main directive that sets the majority of RM/COBOL behavior is DIALECT(RM).

Setting the DIALECT(RM) directive automatically sets additional Compiler directives, such as RM,
NOTRUNC, OLDINDEX, NOOPTIONAL-FILE, RETRYLOCK, ALIGN"2" and SEQUENTIAL"LINE". See the
topic RM Dialect Settings for full details of the directives set.

The system will also behave as if you had specified the following syntax:

sign trailing separate

for signed numeric data items, and:
lock mode is automatic

Previously, compatibility was achieved by compiling with the RM Compiler directive. The newer
DIALECT(RM) directive sets and extends the compatibility given by RM, and should be used for all new
migrations from RM/COBOL, unless you normally set the ANSI switch when you submit your RM/COBOL
source programs to the RM/COBOL system. If you do, set the RM"ANSI" directive when you compile your
programs.

We also recommend that you set the NOMF directive when you submit your RM/COBOL source programs
to this COBOL system. This ensures that only those words which are treated as reserved words under the
ANSI '74 COBOL standard are regarded as reserved words by this COBOL system.

Setting the NORM directive disables the syntax enabled when the RM directive was set, and automatically
resets the additional Compiler directives to NOSPZERO, TRUNC"ANSI", NOOLDINDEX, OPTIONAL-FILE,
NORETRYLOCK, ALIGN"8" and SEQUENTIAL"RECORD". Additionally, the system behaves as if you had
specified the syntax:

sign trailing included

for signed numeric display data items, and:
lock mode is exclusive
for each file in the program which has no explicit locking syntax declared.

The final states of the additional directives set when you use the NORM directive are not necessarily the
same as their initial default states.

RM/COBOL Data Types

When you compile your programs with the DIALECT"RM" Compiler directive, all data types behave in the
same way that they do in RM/COBOL.

If you do not compile with the DIALECT directive, you can still preserve RM/COBOL behavior for certain
data types by using certain other Compiler directives: COMP, COMP1, COMP2, and COMP-6.

RM/COBOL Conversion Issues

The syntax of most RM/COBOL source programs when submitted to run on this COBOL system will be
accepted and run successfully. However, sometimes this COBOL system might reject some of the syntax
in your original RM/COBOL source program, or might cause your program to behave unexpectedly at run-
time.

This section contains the known problems which you may encounter. Hints are also given on how you can
either rectify the cause of such errors, or emulate the RM/COBOL type of behavior in this COBOL system.
Producing Executable Code

The following section covers the known issues when submitting RM/COBOL source programs to this
COBOL system. Where possible, work-arounds and resolutions are also provided.
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Perform Statements

PERFORM statements are not treated in the same way by both COBOL systems. This COBOL system
uses a stack-based perform handling system, while the RM/COBOL system associates a return address
with a specific procedure name.

As a result, under the RM/COBOL system, all end-points to PERFORM statements are always active until
they are used. However, under this system, only the end-point of the last PERFORM statement is active at
any one time.

You must set the PERFORM-TYPE directive with the RM parameter if this COBOL system is to emulate
the behavior of RM/COBOL PERFORM statements.

ACCEPT FROM CENTURY-DATE and FROM CENTURY-DAY
In Enterprise Developer, to use the FROM CENTURY-DATE and FROM CENTURY-DAY phrases with the
ACCEPT statement, set the RM Compiler directive.

Alternatively, use the following equivalent phrases with the ACCEPT statement:

+ FROM DATE YYYYMMDD, which is the equivalent of FROM CENTURY-DATE.
« FROM DAY YYYYDDD, which is the equivalent of FROM CENTURY-DAY.

procedure division.
ACCEPT data-name-1 FROM DATE YYYYMMDD.
ACCEPT data-name-2 FROM DAY YYYYDDD.

Nested COPY statements with REPLACING phrase
In Enterprise Developer, you cannot specify text replacement as part of a nested COPY statement when
text replacement is already active as part of a COPY statement.

If you attempt to use COPY REPLACING in a file copied with a COPY REPLACING statement, an error
code COBCHO0062 COPY replacement not supported is displayed on compilation.

Duplicate Paragraph-names

In Enterprise Developer, if you have duplicate paragraph-names, in different sections, and then call a
paragraph-name from outside its section, an error is produced unless you have explicitly referenced the
paragraph-name and its section. In RM/COBOL, by just calling the paragraph-name, it assumes you are
calling the next declaration of the paragraph-name found.

To ensure that references to duplicate paragraph-names are correctly resolved, you must qualify a
reference to a duplicate paragraph-name by adding the section-name in which it is declared.

Example
If your source code contains the following:
perform para-2.

sect-1 section.
para-1.

para-2.
sect-2 section.

para-2.

RM/COBOL will resolve the reference to para-2 in the PERFORM statement by using the declaration of
para-2 in the sect-1 SECTION. In Enterprise Developer, however, you must qualify the reference to the
duplicate paragraph-name in your source code by using the PERFORM para-2 OF sect-1 statement.
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Empty Groups
In Enterprise Developer, if you have any empty groups specified in your source code, you must set the
DIALECT"RM" Compiler directive.

Figurative Constants and the USING Phrase
In Enterprise Developer, to use figurative constants in the USING phrase of a CALL statement or as values
of level 78 constants, set the DIALECT"RM" Compiler directive.

Alternatively, the figurative constant can be replaced by the equivalent non-numeric literal, such as " " for

SPACE or "0" for ZERO.

File Not Found Errors
Enterprise Developer and RM/COBOL differ in the environment variables that they use to locate program
and data files.

If your source code produces a file not found error, ensure the correct paths are set in the correct
environment variables. In Enterprise Developer, set COBPATH to locate program files and COBDATA to
locate data files. The RUNPATH environment variable used in RM/COBOL, is not used in Enterprise
Developer.

Indexed File Error on Open
Enterprise Developer and RM/COBOL differ in how they handle record length fields and some data fields
when you open an RM/COBOL indexed file.

In Enterprise Developer, when you try to open an RM/COBOL indexed file, you may receive either a run-
time error COBRT161 Illegal intermediate code or a file status code 39 A conflict has been
detected between the fixed file attributes and the attributes specified for
that file in the program.

You must ensure that you read in the same size records that were created in RM/COBOL.

If the length of the file description does not match that which was processed in RM/COBOL, check the
following:

* In RM/COBOL, you can set the RECORD CONTAINS nn CHARACTERS clause to be a different length
than the actual length specified in the record description. If this clause is greater than the actual
description, you must pad the record description with filler bytes to match the RECORD CONTAINS
clause.

« If you have signed numeric display data in your file, Enterprise Developer will treat the sign as a
separate byte if you are using the RM directive without "ANSI" specified. If these fields are stored as
sign internal, you must use RM"ANSI" or do not use the RM directive at all.

Linkage Section in Main Program

In RM/COBOL, if the main program has a Linkage Section, it is initialized by the parameter passed on the
command line. In Enterprise Developer, you must use the command_line_linkage tunable to pass
parameters from the command line to the Linkage Section.

Nested OCCURS DEPENDING Clauses
In Enterprise Developer, if you are using nested OCCURS DEPENDING clauses, you must set the
ODOSL IDE Compiler directive.

Numbering of Segments

In Enterprise Developer, you can only specify segment numbers in the range 0 to 99 inclusive, which
conforms to segment number limit specified in the ANS X3.23-1985 COBOL standard. In RM/COBOL, you
can specify segment numbers greater than 99.

If your source code has segment numbers greater than 99, recode the program. Make sure that any new
segment numbers you allocate do not clash with an already existing segment number. Segment numbers
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between 0 and 49 inclusive are used by Enterprise Developer to indicate fixed portions of your object
program, while segment numbers 50 to 99 inclusive indicate independent segments.

For details on the use of segmentation and segment numbers in your source programs, see COBOL
Language Reference in the product Help.

Program Identification and Data Names

In Enterprise Developer, you cannot use the same name for the Program-ID and a data item in the
program; each name should be unique. RM/COBOL permits the name of the Program-ID paragraph and a
data item to share the same name.

REMARKS Paragraph
In Enterprise Developer, if your program uses the REMARKS paragraph in the Identification Division, you
must set the DIALECT"RM" Compiler directive.

Alternatively, mark the paragraph as comment lines.

Reserved Words
In Enterprise Developer, setting certain Compiler directives (such as RM and ANS85) activates certain
reserved words that you cannot use as nhames for your data items.

If you attempt to use a reserved word, you receive a COBCH0666 ('Reserved word used as data
name or unknown data description qualifier'™) COBOL syntax error.

To continue to use the reserved word as a data name, you can;

* Use the REMOVE Compiler directive, to unreserve that particular keyword.
e Set the MFLEVEL Compiler directive to an appropriate level, to unreserve all keywords above that level.

See Compiler Directives in the product Help.

Example

Your RM/COBOL source program may contain the following lines of code:
03 sort pic 99.
ﬁé&é 1 to sort
If you submit this to Enterprise Developer, you will receive an error because the SORT verb is reserved.

However, if you specify the REMOVE"SORT" Compiler directive when you submit this source program,
you will not receive the error.

SAME AS Clause Not Available When Defining Data Structures
Enterprise Developer and RM/COBOL differ in the way that they allow you to reuse existing data
structures.

In Enterprise Developer, use the TYPEDEF clause to define your base data structure, and then use the
USAGE clause to create data structures of the same type.

data division.

working-storage section.

01 atype is typedef.
03 varl pic x(10) value "brown™.
03 var2 pic x(10) value "blue™.
03 var3 pic x(10) value SPACE.

01 al usage atype.

procedure division.

display var2 of al.

The result of the display statement is blue.
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The SAME AS clause used in RM/COBOL is not supported in Enterprise Developer.

Source Code in Columns 73 to 80
Enterprise Developer ignores any of the code in your source programs which lies within columns 73-80
inclusive.

Code in these columns could be the result of expanding TAB characters in your source program, instead of
standard TAB stops. If your source program contains TAB stops, convert them to spaces.

Undeclared Data Items in Clauses

In Enterprise Developer, you receive a COBCH0250 STATUS field data-name missing or
il legal error if a data item used in the File Status clause is not declared in the Working-Storage section.
In RM/COBOL, you do not have to declare the data item in Working Storage.

User-names Longer than 127 Bytes are Truncated

In RM/COBOL, you can specify user-names (data-names, procedure-names, program-names, etc) up to
240 characters long. In this COBOL system, user-names longer than 127 bytes in length are truncated and
a warning message is produced.

Solution:

Results may be affected if the truncated user-name is used with XML Extensions, to export or import XML
documents; therefore, we recommend that you keep user-names to 127 bytes or less.

Running the Code

Once you have successfully submitted your RM/COBOL source program to this COBOL system and
produced executable code, you might encounter difficulties when you try to run this code under this
system. Alternatively, the code might run but you might find that its behavior under this COBOL system is
not exactly the same as under the RM/COBOL system. The following sections detail known areas of
difficulty you might encounter, and offer hints on how you can avoid them.

Table Bound Checking

If you try to run a program under this COBOL system which contains a subscript value greater than the
size of the table to which it refers, the run-time system will produce an error indicating this. Under the RM/
COBOL system, however, no such table bound checking is done.

Therefore, if you wish to disable table bound checking in this COBOL system, you must use the
NOBOUND directive.

If you use the NOBOUND directive when running intermediate code, you will be able to access data
beyond a table's bounds by using a subscript value greater than the table size. Use of the NOBOUND
directive when you are producing intermediate code will also disable bound checking when running
generated code. However, if you wish to access data beyond a table's bounds when running generated
code, you must also use the directive NOBOUNDOPT.

Note: When you use the NOBOUNDOPT directive, performance will be impaired.

ACCEPT Fields at the Edge of the Screen

If your program contains an ACCEPT statement for a numeric data item at a position on the screen where
the definition of the numeric data item would cause the ACCEPT field to go beyond the right-hand edge of
the screen, both COBOL systems will truncate the input value. In RM/COBOL, the input value will be
aligned into the ACCEPT field as an alphanumeric field, whereas in Enterprise Developer, the input value
is aligned as a numeric field.

Change the definition of the relevant PICTURE clause from numeric to alphanumeric. Alternatively, change
the PICTURE clause so that the field does not go beyond the edge of the screen.

Upgrading to Enterprise Developer for Eclipse | 95



Example

If your program contains the following statement:
ACCEPT data-item AT COLUMN NUMBER 75.

where dat a- i t em is a numeric data item defined as PIC 9(10), a value of 123456 entered into the
ACCEPT field will be held under Enterprise Developer as **0000123456"". However, in RM/COBOL, the
value in the ACCEPT field would be held as ""1234560000"". To allow Enterprise Developer to emulate
the RM/COBOL behavior, alter the definition of the data item in your program to PIC X(10) or PIC 9(6).

Display of Input Data in Concealed ACCEPT Fields

If you have specified OFF and ECHO clauses for the same ACCEPT statement in your program, RM/
COBOL will conceal any data entered during input for that statement but on completion of input will display
the data. Enterprise Developer will not display the data for this ACCEPT statement once input has been
completed.

If you want to display the data input for an ACCEPT statement with the OFF and ECHO clauses specified,
you must add a DISPLAY statement after the ACCEPT statement.

Embedded Control Sequences in DISPLAY Statements
In Enterprise Developer, you cannot embedded control sequences within data items that you want to be
displayed.

Such characters are ignored at run time as they are hardware dependent.

Remove the control sequences from your source program and replace with the equivalent Micro Focus
COBOL syntax; for example, use the syntax WITH UNDERLINE to replace <left-arrow>]4m.

End of File Notification

The first time you unsuccessfully try to READ a sequential file in either COBOL system because you have
reached the end of the file, status key 1 in the FILE STATUS is set to 1 and status key 2 is set to 0. This
indicates that there is no next logical record. If you try to READ the same file again, without it either having
been previously closed and reopened, or it having been successfully started, Enterprise Developer
continues to indicate that there is no next logical record. However, if you try to READ the same file again
under RM/COBOL, status key 1 is set to 9 and status key 2 is set to 6.

A solution to the different file statuses returned for the circumstances given above will depend on the way
in which your source program is coded. We suggest that you include tests for the values 1 and 0 in status
key 1 and 2 of the file status, respectively, at the same time as you test for the values 9 and 6 in these
status keys.

Field Wrap-Around

If, when using binary data items (that is, RM/COBOL COMPUTATIONAL-1 format items) an arithmetic
operation gives a value which exceeds the capacity of the data item, and there is no ON SIZE ERROR
clause, Enterprise Developer wraps-around the value of the item. However, in RM/COBOL, the data item is
set to the limit of its capacity.

You should specify an ON SIZE ERROR clause to highlight such problems.

Example

In RM/COBOL, the following lines of code result in the value +32767 being stored in the data item, CALC-
ITEM. However, Enterprise Developer sets CALC-ITEM to -32768:

01 calc-item pic s9(4) comp-1.

procedure division.

96 | Upgrading to Enterprise Developer for Eclipse



move 32767 to calc-item.
add 1 to calc-item.

File and Record Locking
Certain versions of RM/COBOL contain some software errors in the way in which locks for files and
records are handled. These errors do not occur in Enterprise Developer.

The errors fixed when upgrading to Enterprise Developer are:

» Indexed files do not detect or acquire locks if they are opened for output. This is regardless of whether
you specify the WITH LOCK phrase

« Relative and sequential files cannot be locked exclusively

« Files which are opened for input can detect record locks, although the RM/COBOL documentation
states that they cannot. When the RM directive is set in Enterprise Developer, record locks can still be
detected by files opened for input

» The first record in a sequential file opened for input-output is locked whenever any other record in that
file is locked

Initialization of Working Storage

Enterprise Developer initializes all working storage items without VALUE clauses to SPACES .The RM/
COBOL system initializes all working storage items to SPACES, unless you have placed numeric data
items between data items with VALUE clauses.

If this feature causes you any problems, because your program relies on the initial value given to the
system, add a VALUE clause with the appropriate value to your source program and resubmit it.
Example

The RM/COBOL system initializes the following group item to SPACES:
01 group-item.
0]

3 item-1 pic X.
03 item-2 pic 99.
03 item-3 pic X.

However, if item-1 and item-3 have value clauses associated with them, the RM/COBOL system initializes
the second byte of item-2 to hexadecimal value 0 when item-2 is defined as USAGE COMP (signed or
unsigned) or USAGE DISPLAY (unsigned only).

Numeric Fields Containing lllegal Characters When Using a DEPENDING ON Phrase of an OCCURS
Clause

In Enterprise Developer, if you fail to initialize a numeric data item that is used in a DEPENDING ON
phrase of an OCCURS clause appropriately, a COBRT163 Il1legal character in numeric field
error is displayed at run time, because the data item is initialized to SPACES if no value is specified. In
RM/COBOL, the data item is initialized to ZERO, and therefore, the error does not occur.

ON SIZE ERROR Phrase

In Enterprise Developer, the ON SIZE ERROR condition exists when the value resulting from an arithmetic
operation exceeds the capacity of the specified picture-string. In RM/COBOL, the ON SIZE ERROR
condition exists when the value resulting from an arithmetic operation exceeds the capacity for the
associated data item.

Ensure that the capacity of any data items in your source programs is specified by a picture-string; for
example, COMPUTATIONAL-1 data items.
Open EXTEND of Nonexistent File

In Enterprise Developer, because setting the RM Compiler directive sets the NOOPTIONAL-FILE Compiler
directive, if you try to open a non-existent file for I-O or EXTEND the run-time system will give an error
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message. For I-O, RM/COBOL does the same. However, for EXTEND, RM/COBOL creates the file and
opens it as if you had specified OUTPUT.

The following options are available:

e Add the keyword OPTIONAL to the SELECT statement. This makes Enterprise Developer create the
file and open it for OUTPUT

« Create the empty file before running your program

« Specify the OPTIONAL-FILE Compiler directive. This makes Enterprise Developer create the file and
open it for OUTPUT. However, the behavior with files opened for I-O will now differ from RM/COBOL

Printer Output is Written to Disk
By default, Enterprise Developer writes all output intended for a printer to disk.

To send output to a physical printer, you must map the filename using the dd_LPT1 environment variable
or, if your system supports the Ip printer spooler, you should use:

dd_LPT1=">Ip";export dd_ LPT1

Screen Column Number Specification

Enterprise Developer permits you to specify screen column numbers up to and including 999, but RM/
COBOL permits you to specify column numbers greater than 999. If you try to run an RM/COBOL source
program containing a column number greater than 999 in Enterprise Developer, the column number is
truncated so that only the last three digits are used. If truncation of the column number occurs for an item
to be displayed on the screen, the position of that item on the screen in Enterprise Developer will differ
from its position in RM/COBOL.

Trailing Blanks in Line Sequential Files

Enterprise Developer always removes trailing blanks from line sequential records before writing the record.
RM/COBOL removes trailing blanks from such records only if the FD entry contains 01 level records of
different sizes. This will not cause you any problems when you run your converted RM/COBOL programs
in Enterprise Developer. However, you may receive errors at run time if any REWRITE operations on line
sequential files change the length of the records.

Change the file organization to sequential, or move an alternative padding character (for example, LOW-
VALUES) to the end of the record before it is written. This ensures that full-length records are written.

You also need to ensure that the T run-time switch is not set, as this might also change the size of the
record. See Run-time Switches in the product Help.

Undefined Results of MOVE and Arithmetic Operations
Enterprise Developer and RM/COBOL differ in the results of MOVE statements, arithmetic operations, and
comparisons that involve numeric and alphanumeric data items.

You can overcome most of these incompatibilities by redefining the data items involved, or by recoding the
comparisons. If you submit a program in Enterprise Developer containing an alphanumeric to numeric data
item MOVE statement, a warning message will be displayed indicating this.

Example

If you submit a source program containing the following data items and procedural statements, the
specified test will fail at run time:
01 numeric-field pic 9(5).
procedure division.
move "abc" to numeric-field.
if numeric-field = "00abc™

When the RM Compiler directive is set, Enterprise Developer partially emulates the behavior of RM/
COBOL for alphanumeric to numeric MOVES by treating the numeric item as an alphanumeric item which
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is right justified. However, the above example will still fail because RM/COBOL treats the literal ABC as
numeric, and places 00ABC in the numeric item. To make the statement run successfully in Enterprise
Developer, amend the test in the source program to:

if numeric-field = " abc"

and resubmit the source program.

Using the Correct Calling Convention

We recommend that to use the RM/COBOL library routines provided in Enterprise Developer, you explicitly
set the 1024 call-convention in the CALL statement.

program-id. Programl.
Special-Names.
call-convention 1024 is RM.

procedure division.

call RM "SYSTEM" using "cmd.exe /c mkdir sys02".

goback.
end program Programl.

RM/COBOL Library Routines
The following RM/COBOL routines are available in this COBOL system.

C$Century
Updates your COBOL programs to handle the year 2000 issue.

f Note: When calling this routine, ensure you are using the 1024 calling convention.
This library routine retrieves the first two digits of the current year.

Syntax:
CALL "C$Century' USING value-buffer

Parameters:
value-buffer

A two-byte data item with a format of either unsigned numeric display (NSU) or
alphanumeric display (ANS).
On Exit:

value-buffer The first two digits of the current year.

Comments:

You can achieve the same result using the standard COBOL command ACCEPT data-name FROM DATE
YYYYMMDD and then referencing the data name.

C$ConvertAnsiToOem
Converts a buffer containing ANSI characters to a buffer containing the corresponding OEM characters.

When calling this routine, ensure you are using the 1024 calling convention.

This is supported on Windows only.
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Syntax:

CALL ""C$ConvertAnsiToOem™ USING ansi-buffer, oem-buffer
[, char-count]

Parameters:
ansi-buffer

PIC X(n)
oem-buffer
PIC X(n)

char-count
PIC 9(n)

On Entry:
ansi-buffer The ANSI characters to be converted to OEM characters.
char-count The number of characters to be converted.

Note: If omitted or if the value is invalid, the actual size of the shorter of ansi-buffer
and oem-buffer is used.

On Exit:

oem-buffer The converted OEM characters.

C$ConvertOemToAnsi
Converts a buffer containing OEM characters to a buffer containing the corresponding ANSI characters.

y Note: When calling this routine, ensure you are using the 1024 calling convention.

Syntax:

CALL "C$ConvertOemToAnsi' USING oem-buffer, ansi-buffer
[, char-count]

Parameters:
oem-buffer

PIC X(n)
ansi-buffer

PIC X(n)
char-count

PIC 9(n)

On Entry:

oem-buffer The OEM characters to be converted to ANSI characters.
char-count The number of characters to be converted.

Note: If omitted or if the value is invalid, the actual size of the shorter of ansi-buffer
and oem-buffer is used.
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On Exit:

ansi-buffer The converted ANSI characters.

C$DARG
Returns information about a parameter passed in the USING or GIVING phrases of the CALL statement
that called a subprogram.

f Restriction: This routine is supported in native COBOL only.

When calling this routine, ensure you are using the 1024 calling convention.

This information identifies the type and length of the argument and, when the argument is numeric or
numeric edited, the number of digits and scale factor for the argument.

Syntax:
CALL "C$DARG"™ USING argument-number, argument-description

Parameters:
argument-number

pic 9(n)
argument-description

01 ARGUMENT-DESCRIPTION.
02 ARGUMENT-TYPE PIC 9(2) BINARY(2).
02 ARGUMENT-LENGTH PIC 9(8) BINARY(4).
02 ARGUMENT-DIGIT-COUNT PIC 9(2) BINARY(2).
02 ARGUMENT-SCALE PIC S9(2) BINARY(2).
02 ARGUMENT-POINTER POINTER.
02 ARGUMENT-PICTURE POINTER.

On Entry:
argument- The ordinal position of the argument in the USING phrase of the CALL statement. The
number value zero returns the description of the GIVING phrase of the CALL statement.
On Exit:
argument- Details of the passed parameter. Those details include:
description i ) )
argument- The type of data item; see the table in the Comments section.
type
argument- The number of character positions of the data item.
length
argument- The number of digits defined in the PICTURE character-string for an

digit-count argument that is a numeric or numeric edited data item as indicated by
the ARGUMENT-TYPE field value; otherwise, the value zero is
returned for nonnumeric data items. The digit count for a numeric or
numeric edited data item does not include any positions defined by the
PICTURE symbol P, which represents a scaling position.

argument- The power of 10 scale factor (that is, the position of the implied or

scale actual decimal point) for an argument that is a numeric or numeric
edited data item as indicated by the ARGUMENT-TYPE field value;
otherwise, the value zero is returned for nonnumeric data items. If the
PICTURE symbol P was used in the description of the data item, the
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absolute value of the ARGUMENTSCALE value will exceed the
ARGUMENT-DIGIT-COUNT value; in this case, a positive scale value
indicates an integer with P scaling positions on the right of the
PICTURE character-string and a negative scale value indicates a
fraction with P scaling positions on the left of the PICTURE character-

string
argument- This parameter is not returned in this COBOL system.
pointer
argument- This parameter is not returned in this COBOL system.
picture

Comments:
Use the C$NARG library routine to obtain the number of arguments passed in the CALL statement.

The actual number of arguments may exceed the number of formal arguments declared in the Procedure
Division header of the program that calls C$DARG. All of the actual arguments can be accessed using C
$DARG even though there is no formal argument name available for accessing the actual arguments
beyond the number of formal arguments.

The following table is used to indicate the data type specified in the ARGUMENT TYPE field:

Type Number RM/COBOL Data Type Type Number RM/COBOL Data Type
0 NSE 16 ANS

1 NSU 17 ANS (justified right)

2 NTS 18 ABS

3 NTC 19 ABS (justified right)

4 NLS 20 ANSE

5 NLC 21 ABSE

6 NCS 22 GRP (fixed length)

7 NCU 23 GRPV (variable length)
8 NPP 25 PTR

9 NPS 26 NBSN

10 NPU 27 NBUN

11 NBS 32 OMITTED

12 NBU

f Restriction: Data type OMITTED (type number 32) is not supported in this COBOL system.

Cs$Delay
Relinquishes the CPU for a length of time specified in seconds.

y Note: When calling this routine, ensure you are using the 1024 calling convention.
This library routine allows other programs to run while the current program waits.

Syntax:
CALL ""C$Delay' USING seconds
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Parameters:

seconds

PIC 9(n)v999, where n is a digit from 1 to 7
On Entry:
seconds The number of seconds.
Comments:

The amount of delay is not exact. It depends upon the particular machine configuration and the load on the
machine.

C$GetEnv
Returns the value of an environment variable.

y Note: When calling this routine, ensure you are using the 1024 calling convention.

Syntax:
CALL "C$GetEnv'" USING name, value [, return]

Parameters:
name

PIC X(n)
value

PIC X (n)
return

PIC 9(n) BINARY, where n can be a digit from 1to 9

On Entry:

name The name of the environment variable.

On Exit:
value The value of the environment variable, returned from the call.

return The result code returned from the call: zero for success and non-zero for failure.

Comments:

On UNIX, environment variable names are case-sensitive. On Windows, environment variable names are
not case-sensitive.

C$GetLastFileName

Retrieves the last filename used in a COBOL I/O statement (including OPEN and CLOSE).

i Note: When calling this routine, ensure you are using the 1024 calling convention.

Syntax:
CALL "C$GetLastFileName'™ USING filename

Parameters:
filename
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PIC X(30)

On Exit:

filename The name of the filename used in the last I/O operation.

Comments:

For REWRITE and WRITE statements, the COBOL filename associated with the specified file record-name
is provided.

If the filename is longer than 30 characters, it is truncated to the right.

C$GetLastFileOp
Retrieves the last COBOL I/O operation performed.

f Note: When calling this routine, ensure you are using the 1024 calling convention.
Use this library routine within a declarative procedure after an 1/O error has occurred.

Syntax:
CALL "C$GetLastFileOp™ USING operation

Parameters:
operation

PIC X(20)

On Exit:

operation The name of the last I/O operation performed. The valid operations returned are:

Close ReadRandom
CloseUnit Rewrite

Delete RewriteRandom
DeleteFile Start
DeleteRandom Unlock

Open Write

ReadNext WriteRandom
ReadPrevious

Comments:
If the operation is longer than 20 characters, it is truncated to the right.

If the value SPACES is returned that indicates that no operation is available.

C$GetNativeCharset
Retrieves information about the native character set in effect for the current run unit.

i Note: When calling this routine, ensure you are using the 1024 calling convention.

The native character set specifies how non-numeric data is encoded in memory and on data files.
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Syntax:
CALL ""C$GetNativeCharset" USING charset-name [, codepage-number]

Parameters:
charset-name

PIC X(n)

codepage-number
PIC 9(n)

On Exit:

charset-name The name of the character set in use for the current run unit after the call.
Note: For Windows, the name will have a value of “ANSI” or “OEM”. On UNIX,
the value will be “NONE".

codepage- The codepage number of the character set in use for the current run unit after the call.

number Note: For Windows, the codepage number will be the system ANSI codepage

number if charset-name contains “ANSI” and will be the system OEM codepage
number if charset-name contains “OEM”. On UNIX, the value will be 0.

Comments:
The native character set for a run unit on Windows can be either ANSI or OEM.

The native character set for a run unit on UNIX is determined by the locale settings for the system.

C$LogicalAnd
Performs a bitwise logical AND operation on two or more non-numeric or numeric operands.

When calling this routine, ensure you are using the 1024 calling convention.

Syntax:

CALL "CS$LogicalAnd"
[GIVING result]
USING operandl {operand2} ...

Parameters:
result

PIC 9(n)
operandl
A non-numeric or numeric operand

operand?2, 3, etc
A non-numeric or numeric operand that must be of the same data type as operandl

i Note: If any non-numeric operand2 is shorter than operandi, it is assumed
to be padded on the right with binary zeroes.

On Entry:

operandl, 2, 3, etc Non-numeric or numeric operands, which must be of the same data type as
operandl.
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On Exit:

result The result of the operation or operand1l.

Comments:

For non-numeric USING operands, the bitwise logical AND of all the operands replaces the value of
operandl. The value of result is set to a non-zero value if any character of operandl is non-zero after the
operation completes and zero otherwise.

For numeric USING operands, each operand is converted, if necessary, to a 32-bit binary integer. These
32-bit binary values are logically ANDed together. If the GIVING phrase is specified, the result of this
operation is stored in result and the value of operandl is not modified. If the GIVING phrase is not
specified, the result of this operation is stored in operandl.

C$LogicalComplement
Performs a bitwise logical One's Complement operation on a non-numeric or numeric operand.

When calling this routine, ensure you are using the 1024 calling convention.

Syntax:

CALL "C$LogicalComplement"
[GIVING result]
USING operand

Parameters:
result

PIC 9(n)

operand
A non-numeric or numeric operand

On Entry:

operand A non-numeric or numeric operand.
On Exit:

result The result of the operation or operand.
Comments:

If operand refers to a non-numeric data item, the bitwise logical One’s Complement of the value of operand
replaces the value of operand. The value of result is set to a non-zero value if any character of operand is
non-zero after the operation completes and zero otherwise.

If operand refers to a numeric data item, the operand is converted, if necessary, to a 32-bit binary integer.
The 32-bit binary value is logically One’s Complemented. If the GIVING phrase is specified, the result of
this operation is stored in result and the value of operand is not modified. If the GIVING phrase is not
specified, the result of this operation is stored in operand.

C$LogicalOr
Performs a bitwise logical OR operation on two or more non-numeric or numeric operands.

When calling this routine, ensure you are using the 1024 calling convention.
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Syntax:

CALL "C$LogicalOr™
[GIVING result]
USING operandl {operand2} ...

Parameters:
result

PIC 9(n)
operandl
A non-numeric or numeric operand
operand2, 3, etc
A non-numeric or numeric operand that must be of the same data type as operandl

i Note: If any non-numeric operand2 is shorter than operandi, it is assumed
to be padded on the right with binary zeroes.

On Entry:

operandl, 2, 3, etc Non-numeric or numeric operands, which must be of the same data type as

operandl.

On Exit:

result The result of the operation or operand1l.

Comments:

For non-numeric USING operands, the bitwise logical inclusive OR of all the operands replaces the value
of operandl. The value of result is set to a non-zero value if any character of operandl is non-zero after
the operation completes and zero otherwise.

For numeric USING operands, each operand is converted, if necessary, to a 32-bit binary integer. These
32-bit binary values are logically inclusive OR'd together. If the GIVING phrase is specified, the result of
this operation is stored in result and the value of operandl is not modified. If the GIVING phrase is not
specified, the result of this operation is stored in operand1l.

C$LogicalXor
Performs a bitwise logical exclusive OR operation on two or more non-numeric or numeric operands.

When calling this routine, ensure you are using the 1024 calling convention.

Syntax:

CALL "C$LogicalXor"
[GIVING result]
USING operandl {operand2} ...

Parameters:
result

PIC 9(n)

operandl
A non-numeric or numeric operand

operand?2, 3, etc
A non-numeric or numeric operand that must be of the same data type as operandl
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i Note: If any non-numeric operand2 is shorter than operandi, it is assumed
to be padded on the right with binary zeroes.

On Entry:

operandl, 2, 3, etc Non-numeric or numeric operands, which must be of the same data type as
operandl.

On Exit:

result The result of the operation or operand1.

Comments:

For non-numeric USING operands, the bitwise logical exclusive OR of all the operands replaces the value
of operandl. The value of result is set to a non-zero value if any character of operandl is non-zero after
the operation completes and zero otherwise.

For numeric USING operands, each operand is converted, if necessary, to a 32-bit binary integer. These
32-bit binary values are logically exclusive OR'd together. If the GIVING phrase is specified, the result of
this operation is stored in result and the value of operandl is not modified. If the GIVING phrase is not
specified, the result of this operation is stored in operand1l.

C$LogicalShiftLeft
Performs a logical shift left operation on a non-numeric or numeric operand.

When calling this routine, ensure you are using the 1024 calling convention.

Syntax:

CALL "CS$LogicalShiftLeft"
[GIVING result]
USING operand [shiftcount]

Parameters:
result

PIC 9(n)
operand
A non-numeric or numeric operand

shiftcount
PIC 9(n)
On Entry:

operand A non-numeric or numeric operand.

shiftcount The number of positions to shift during the operation.

On Exit:

result The result of the operation.
Comments:

If operand refers to a non-numeric data item, the value of the data item is shifted left by the number of bit
positions specified by shiftcount. Any bits shifted off the left end are lost and zero-valued bits are shifted
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into the right end. The value of result is set to a non-zero value if any character of operand is non-zero after
the operation completes and zero otherwise.

If operand refers to a numeric data item, the operand is converted, if necessary, to a 32-bit binary integer.
The 32-bit binary value is logically shifted left by the number of bit positions specified by shiftcount. If the
GIVING phrase is specified, the result of this operation is stored in result and the value of operand is not
modified. If the GIVING phrase is not specified, the result of this operation is stored in operand.

C$LogicalShiftRight
Performs a logical shift right operation on a non-numeric or numeric operand.

When calling this routine, ensure you are using the 1024 calling convention.

Syntax:

CALL ""C$LogicalsShiftRight"
[GIVING result]
USING operand [shiftcount]

Parameters:
result

PIC 9(n)

operand
A non-numeric or numeric operand

shiftcount
PIC 9(n)

On Entry:

operand A non-numeric or numeric operand.

shiftcount The number of positions to shift during the operation.

On Exit:

result The result of the operation.

Comments:

If operandrefers to a non-numeric data item, the value of the data item is shifted right by the number of bit
positions specified by shiftcount. Any bits shifted off the right end are lost and zero-valued bits are shifted
into the left end. The value of Result is set to a non-zero value if any character of operand is non-zero after
the operation completes and zero otherwise.

If operand refers to a numeric data item, the operand is converted, if necessary, to a 32-bit binary integer.
The 32-bit binary value is logically shifted right by the number of bit positions specified by shiftcount. If the
GIVING phrase is specified, the result of this operation is stored in result and the value of operand is not
modified. If the GIVING phrase is not specified, the result of this operation is stored in operand.

CSNARG
Returns the number of parameters passed in the USING phrase of a CALL statement to the
subprogram that contains the call to CENARG.

Arguments specified explicitly as OMITTED in the USING list of the CALL statement are included in the
count. The GIVING argument is not included in the count.

f Note: When calling this routine, ensure you are using the 1024 calling convention.
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Syntax:
CALL "C$NARG'" USING parameter-count

Parameters:
parameter-count

PIC 9(3) BINARY, COMP-4 or COMP-1

On Exit:

parameter-count The number of parameters passed.

C$0SLocklInfo
Returns the process ID of the process that has the record locked when a lock request fails. This routine
should be called immediately after a lock request has failed.

y Note: When calling this routine, ensure you are using the 1024 calling convention.

f Note: This routine is supported on UNIX only.

Syntax:
CALL "C$0SLockInfo™ USING processid

Parameters:
processid

A four-byte, unsigned COMP-4 numeric item.

On Exit:

processid The ID of the process that has the record locked.

Comments:

This routine will return a zero if run on Windows.

C$SecureHash
Produces a 20-byte message digest from an input text string using the secure hash algorithm (SHA-1).

f Note: When calling this routine, ensure you compile using DIALECT"RM".

Syntax:

CALL "'C$SecureHash'™ USING message-text [message-length]
GIVING message-digest

Parameters:
message-text

PIC X(n)

message-length
PIC 9(n)

message-digest
PIC X(n)
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On Entry:

message- Its value is the input text string to the secure hash algorithm. While the secure hash

text algorithm supports messages of length 2**64 or less bits (2**61 or less bytes), this
implementation is limited to messages of length 2**32 or less bits (2**29 or less bytes).

message- Its value specifies the number of bytes of message-text to be considered when producing

length the message digest. Thus, the value must be less than or equal to the length of data item

referenced by message-text. If message-length is omitted, the entire value of the data item
referenced by message-text is used, as if LENGTH OF message-text had been specified
for message-length.

On Exit:

message- |t must be an identifier that references a nonnumeric data item of exactly 20 bytes in length.

digest The message digest result from the secure hash algorithm is returned in the referenced data
item. The message digest value is stored in the form most significant byte at lowest address
to least significant byte at highest address regardless of the memory architecture of the
machine on which C$SecureHash is called.

When there is insufficient memory for C$SecureHash to do its work, the contents of
message-digest are set to all binary zeroes. This only occurs when a memory area slightly
larger than the size of the message text cannot be allocated. The secure hash algorithm
used by C$SecureHash, other than the length limitation, is the one defined as the secure
hash standard by Federal Information Processing Standard (FIPS) Publication 180-1, which
is often referred to as SHA-1.

Comments:

One example of the usefulness of a message digest is storing a password in a secure form. Since
message-digest is produced using a one-way hash of the password, it is computationally infeasible to
recover the password from the message-digest value. (However, if the password is easy to guess or find in
a dictionary, a computer program can be used to search for a password that hashes to a given message-
digest value.)

Note: The input text string “abc” (length = 3 bytes) produces the hash value:
x"A9993E364706816ABA3E25717850C26C9CD0OD89D"

Since this is a well-known test result for the secure hash algorithm (documented in FIPS Pub 180-1), “abc”
is not recommended as a password value. Message digests are also often used to verify that a message
has not been changed from its original value. This involves computing the message-digest of the original
message-text and transmitting it in a secure manner, either on a separate secure channel or by using
encryption of message-digest to guarantee that it is not modified during transmission. The receiver of the
message can then compute the message digest from the received message-text and verify that the
resulting message-digest matches the one supplied. If they match, it is extremely unlikely that the message
text has been modified during transmission.

C$SetEnv
Sets or clears the value of an environment variable.

f Note: When calling this routine, ensure you are using the 1024 calling convention.

Setting the value of an environment variable with C$SetEnv updates the corresponding environment
variable immediately in the process space of the current run unit. Thus, when the RM/COBOL runtime
system uses environment variables for such actions as file access name resolution, the call to C$SetEnv
will have an immediate effect on that run unit.
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Syntax:
CALL "'C$SetEnv' USING name, value [, return]

Parameters:
name

PIC X(n)
value

PIC X(n)
return

PIC 9(n) BINARY, where n can be a digit from 1 to 9

On Entry:

name The name of the environment variable to set or clear.

value The value to which the environment variable is set. A value of SPACES indicates that the
environment variable should be deleted.

On Exit:

return The result code returned from the call: zero for success and non-zero for failure.

Comments:

On UNIX, environment variable names are case-sensitive. On Windows, environment variable names are
not case-sensitive.

C$RERR
Returns the expanded I/O completion status, based on an error code received at run-time.

This routine returns either a four-character or an eleven-character extended status code, depending upon
the length of the data item specified in the USING phrase. This status is for the last attempted I/O
operation. The value returned conforms to ANSI COBOL 1985.

Syntax:
CALL "C$RERR™ USING extended-status

Parameters:
extended-status

PIC X(4) or PIC X(11)

On Exit:

extended-status The data item into which the expanded I/O completion status is stored in ASCII
characters.

Comments:

If extended-status is four characters in length, the first two character positions contain the same digits as
would the file status data item on completion of the I/O operation. The last two character positions provide
additional information about the file status. In cases where only two digits for a status are shown, the last
two character positions will contain ASCII zeroes. Although most statuses contain only the decimal digits 0
to 9, note that the hexadecimal digits A to F are possible in some character positions. Refer to Appendix A:
Runtime Messages of the RM/COBOL User's Guide for a full list of status codes.
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If extended-status is eleven characters in length, the first two character positions (positions one and two)
contain the same digits as would the file status data item on completion of the 1/O operation. In cases
where Appendix A shows only two digits for a status, the remaining nine character positions contain ASCII
blanks. In cases where Appendix A shows four digits for a status, character position three contains an
ASCII comma, character positions four and five contain the last two digits of the status, and the remaining
six character positions contain ASCII blanks. For permanent errors, that is, when the first two digits are 30,
character position three contains an ASCII comma, character positions four and five contain a two-digit OS
code (see the table below), character position six contains an ASCIl comma, and character positions seven
through eleven contain a five-digit, OS-specific error code. Refer to the Input/Output Errors section of the
RM/COBOL User's Guide.

Table 1: The two-digit OS codes

Code Description

00 Unknown OS error

01 File Manager Detected error
04 UNIX error

06 Btrieve error

10 Open File Manager error

11 C Library error

12 MS-Windows error

15 RM/InfoExpress Server error
16 RM/InfoExpress Client error
21 RM/InfoExpress WinSock error
DELETE

Deletes a file.

f Note: When calling this routine, ensure you are using the 1024 calling convention.

Syntax:
CALL "DELETE'™ USING file-name [exit-code]

Parameters:
file-name

PIC X(n)
exit-code
PIC S9(4) BINARY

On Entry:

file-name The full or relative pathname of the file to be deleted.

On Exit:

exit-code The exit code of the command upon return from the operating system: zero for success and
non-zero for failure.
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Comments:

The values for the old-name parameter may be quoted with double quotes (*) or single quotes (*). When
the name is quoted, the quotes are removed, but the name is not otherwise modified. If the name is not
quoted, the first control character terminates the name on Windows and the first white space character

terminates the name on UNIX. On Windows, trailing spaces are removed from unquoted names.

The old-name data item must be less than 1024 characters in length.

RENAME
Renames a file.

f Note: When calling this routine, ensure you are using the 1024 calling convention.

Syntax:
CALL "RENAME™ USING old-name new-name [exit-code]

Parameters:
old-name

PIC X(n)
new-name

PIC X(n)
exit-code

PIC S9(4) BINARY

On Entry:

old-name The source filename.
new-name The target filename.
On Exit:

exit-code The exit code of the command upon return from the operating system: zero for success and
non-zero for failure.

Comments:

The values for the old-name and new-name parameters may be quoted with double quotes (") or single
quotes ('). When the name is quoted, the quotes are removed, but the name is not otherwise modified. If
the name is not quoted, the first control character terminates the name on Windows and the first white
space character terminates the name on UNIX. On Windows, trailing spaces are removed from unquoted
names.

The old- and new-name data item must be less than 1024 characters in length.

SYSTEM
Executes an arbitrary operating system command.

Syntax:
CALL "SYSTEM'™ USING command-line [repaint-screen] [exit-code]

Parameters:

command-line
PIC X(n)
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repaint-screen
This parameter is ignored in this COBOL system.

exit-code
This parameter is ignored in this COBOL system.

On Entry:

command-line An alphanumeric data item that contains the command line to be passed to the operating
system.

repaint-screen This parameter is ignored in this COBOL system.

On Exit:

exit-code This parameter is ignored in this COBOL system.

Comments:

The implementation of this library routine is identical to the existing Micro Focus version of SYSTEM.

RM/COBOL File Handling

When you migrate your RM/COBOL applications to Enterprise Developer, you can continue to use the
same data files.

Alternatively, you can use a data migration tool to convert an RM/COBOL data file to Micro Focus format.
The data migration tool is available as a product sample, as a solution named RMMFDataMigration.

Configuring Access to RM/COBOL Indexed Data Files

To handle RM/COBOL indexed data files, you map a file to IDXFORMAT=21 in the File Handler
configuration file.

Within the configuration file, you can apply IDXFORMAT 21 to all files in a particular folder, all files with a
specific file extension, or a single file. See Format of the Configuration File for the tags that you can use for
the mapping, and the order in which settings in these tags are applied.

The order that the mapping is applied is important, as conflicting settings can be overwritten; for example,
the following excerpt of the configuration file sets all files in c:\Files\rmfiles (Windows) or usr/
files/rmfiles (UNIX) to IDXFORMAT 21 and all files with a .DAT extension to IDXFORMAT 17:

Windows:

[FOLDER:C:\\files\\rmfiles]
IDXFORMAT=21

[*.DAT]
IDXFORMAT=17
UNIX:

[FOLDER:usr/files/rmfiles]
IDXFORMAT=21

[*.DAT]
IDXFORMAT=17

If there is a .DAT file in c:\Files\rmfiles (Windows) or usr/files/rmfiles (UNIX), the mappings
are applied according to the type of tag. In the case above, mappings in the extension tag are applied after
mappings in the FOLDER tag, and so the .DAT file in that directory has an IDXFORMAT of 17.

By default, the File Handler handles all sequential and relative data files, but if you want to handle them
through the RM/COBOL file handler, use the INTEROP=RM configuration option; however, in cases where
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the INTEROP and IDXFORMAT mappings conflict, the INTEROP setting will override IDXFORMAT for

your RM/COBOL indexed data files.

RM/COBOL File Status Codes

RM/COBOL file status codes take a 2-digit form in the file status variable, by combining the values of the
Status Key 1 and 2 columns, or a 4-character or 11-character extended file status code, which can be

retrieved using the C3RERR standard library routine.
To always return RM/COBOL file status codes:

e Set environment variable COBFSTATCONYV to the RM/COBOL setting:
set COBFSTATCONV=rmstat
* Setthe COBFSTATCONYV Compiler directive.

Status Key 1 Status Key 2 Extended File Status Description
Code

3 5 9/013 File not found.

3 5 9/188 Filename too large.

3 7 9/035 Incorrect access
permission.

3 7 9/037 File access denied.

3 8 9/138 File is closed with lock -
cannot open.

3 8 9/210 File is closed with lock.

4 1 9/141 File already open - cannot
be opened.

4 2 9/142 File not open - cannot be
closed.

4 3 9/143 REWRITE/DELETE not
after successful READ

4 6 9/146 No current record defined
for sequential read.

4 7 9/147 Wrong open or access
mode for READ/ START.

4 8 9/148 Wrong open or access
mode for WRITE.

4 9 9/149 Wrong open or access
mode for REWRITE/
DELETE.

9 3 9/065 File locked.

9 8 9/071 Bad indexed file format.

9 8 9/139 Record length or key
inconsistent.

9 9 9/068 Record is locked.

Enabling CTF to Trace RM/COBOL Data Files

Enable the Micro Focus Consolidated Tracing Facility (CTF) to trace activity with your RM/COBOL data

files.
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To enable CTF:

« Set the following environment variables:

set MFTRACE_CONFIG=ctf.cfg
set MFTRACE_LOGS=pat hnane *> if not set, logs are stored in the current
folder.

* In ctf.cfg, set the following:

mftrace.dest = textfile
mftrace.level .mf.rts = info
mftrace.comp.mf.rts#eprintf = true

» Set the following environment variable:
set A CONFIG=rmfm.cfg *> rmfm is your RMFM configuration file
* In rmfm.cfg, set the following:
DEFAULT_FILESYSTEM RMFM
FILE_TRACE 3 *> values 0-9 set amount of activity traced.
When you run your program, a log-file is produced that includes the activity with the RM/COBOL data files.

For more information on CTF, see Introduction to the Consolidated Tracing Facility.

Data File Utilities

The following utilities are available to use with your RM/COBOL data files:

Indexed File Recovery (recoverl) utility

The recoverl utility recovers data stored in an RM/COBOL indexed file . It is a standalone program; that
is, it does not require use of the Runtime Command to be executed.

i Note:

* Unless specifically stated otherwise, the name recover1 refers to both the UNIX (recoverl) and
Windows (recoverl.exe) versions of the recover1 program.

 If the output window of the Windows version of the recover1 program disappears upon
successful completion and you want that window to remain visible, set the Persistent property
to True for the recover1 program.

* The recoverl utility does not use the environment variable RUNPATH to locate files. It is best to
specify the full pathname of the indexed file to be recovered or to run recoverl from the current
directory in which the indexed file resides.

Recovery command

The Indexed File Recovery (recoverl) utility is executed by issuing the following command:
recoverl indexed-file drop-file [options]

indexed-file
The filename of the indexed file to be recovered. The name is not resolved through any
environment variables.

drop-file
The name of the file where recoverl places any unrecoverable records found in the
indexed file, as discussed in Recovery process description. If drop-file specifies an
environment variable name, the environment variable value will be resolved before
opening the dropped record file.

options
Zero or more command line options, as described in Recovery command options. Options

are specified with letters that must be preceded with a hyphen (-) or a slash (/). Option
letters may be specified in uppercase or lowercase. Certain option letters allow an optional
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pathname as part of the option format. The presence or absence of the pathname is
determined by whether or not the next non-white space character following the option letter
is a hyphen or slash, whichever one was used preceding the option letter.

Note: The option introducer character slash is supported for Windows compatibility and should not be
used on UNIX, where it can be confused with an absolute pathname; that is, a pathname that begins
with a slash. Nevertheless, either the hyphen or the slash may be used to introduce option letters on
Windows and UNIX. In the option formats given, only the hyphen is shown, but the hyphen may be
replaced with a slash.

Recovery command options

Recovery command options can be specified in either of the following two ways:

» Depending on the operating system, they can be placed into the Windows registry or the UNIX resource
file:

« In the Windows registry, the Command Line Options property provides command line options for the
Indexed File Recovery utility when Recovery is selected on the Select File tab of the RM/COBOL
Properties dialog box.

« In the UNIX resource file, the Options keyword, described in Command Line Options, provides
command line options for the Indexed File Recovery utility in the global resource file /etc/default/
recoverlrc and the local resource file ~/.recoverirc.

* They can be specified in the Recovery Command itself.

The following options may be specified to modify the behavior of the Indexed File Recovery (recoverl)
utility.

| Use the | option to cause recoverl to test only the file integrity and then stop. The file will not be
modified in any way. Specifying the | option causes both the T and Z options to be ignored. If no
problems are discovered, the exit code is set to 0. If a problem is discovered, the exit code is set to 1.
The | option has the following format:

The default is for recoverl to do a complete recovery of the indexed file if the file is marked as needing
recovery. See the Y and Z options in this topic for additional options that modify the behavior of the
Indexed File Recovery utility.

Note: The integrity scan is a quick test of the file and is not comprehensive. Some problems,
such as records with invalid duplicate keys, will not be detected. Indexed files with no errors
detected by the integrity scan may still receive “98” errors or other I/O errors.

K Use the K option to indicate that the Key Information Block (KIB) should be assumed to be invalid and,
optionally, to specify a template file for recovering the KIB. The K option has the following format:

-K [template-fTile]

If no template-file is specified, the user will be prompted either for a template file or for enough
information to rebuild the KIB. If template-file is specified, it should be the name of a valid indexed file
with the same format as the file being recovered. This file will be used as a template. The required KIB
information is read from the KIB of the template file. The template file can be a backup copy of the file
being recovered, if the backup occurred before the file was damaged, or, it can be a file created by
performing an OPEN OUTPUT in a COBOL program with the proper file control entry and file
description entry for the file being recovered. An OPEN OUTPUT must have been performed on the
template file, but it need not contain any records. A template file must be specified if the KIB is corrupt
and the file uses either an enumerated code set or an enumerated collating sequence. The default is
to check the KIB for validity and, if it is found to be invalid, prompt for either a template file or
information to rebuild the KIB. The name of the template file is not resolved through any environment
variables.
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v, Warning: A template file with the wrong block size can cause the loss of a large percentage of
=*='" the recoverable records in your file.

Use the L option to write information about errors encountered while recovering the file to a log file.
The L option has the following format:

-L [log-file]

Only the first 100 errors will be logged. In addition to errors, a number of informational lines about the
indexed file and its recovery are written to the log file, including information about sort memory (see
the M option regarding sort memory). If log-file specifies an environment variable name, the
environment variable value will be resolved before opening the log file; this allows the use of the name
PRINTER to send the log information to the print device. If log-file is omitted in the L option, the default
value of log-file is PRINTER. If the L option is not specified, the default is not to write a log file.

Note: Environment variables can be set using synonyms set in the Windows registry or the
UNIX resource file.

Use the M option to specify the number of megabytes of memory to allocate to the sort algorithm used
in phase 4, build node blocks. The M option has the following format:

-M [MB-of-memory]

where MB-of memory is a number in the range 0 to 2000. Allocating more memory generally results in
faster execution of recoverl and causes fewer node blocks to be built. If this option is not specified, a
suitable number will be computed; in this case, sort memory is limited to no more than 40 million
bytes. When a log file is written (see the L option), a line is written into the log file to show the
maximum effective sort-memory size. If the M option is specified without a number of megabytes, the
default value of 50 is used.

Note: Specifying a number for MB-of-memory that is too large for your system may result in
very poor system performance.

Use the Q option to cause recoverl to perform its work without displaying information or asking the
operator questions. The Q option has the following format:

-Q
If the file is marked as needing recovery, or has a non-zero Open For Modify Count, then it will be

recovered. Otherwise, no action occurs. This behavior can be modified by using the Y option. The
default is to display information and ask questions, which must be answered by the operator.

Use the T option to indicate that unused space should be truncated and returned
to the operating system. The T option has the following format:
-T

Specifying the T option will result in a minimal size indexed file, but may reduce performance if records
are subsequently added to the indexed file. The default is not to truncate the file. When the file is not
truncated, any empty blocks remain part of the file and are available for use in adding new records to
the file.

i Note: Some versions of UNIX do not support the operating system call required to

truncate a file.

Use the Y option to cause recoverl to assume that the operator wants to answer “y” to all possible
questions and therefore not stop to wait for a response. The Y option has the following format:

=Y/

Using the Y option will cause a file to be recovered even if it is not marked for recovery, including the
case of when the Q option is also specified. The default is to wait for a response from the operator
after a question is displayed.
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Z Use the Z option to reset the Open For Modify Count to zero, without performing a full recovery. The Z
option has the following format:

-Z

If the file is marked as needing recovery, the Z option is ignored. The default is to treat a non-zero
Open For Modify Count as indicating that the file needs recovery.

Note: Use the Z option with caution. Resetting the Open For Modify Count to zero without
performing a full recovery may leave the file in a corrupted state.

Recovery process description

If the recoverl program is successful, the exit code is set to 0. If the recoverl program is canceled by the
operator, the exit code is set to 2. Otherwise, the exit code is set to 1.

You may produce a list of the support modules loaded by the recoverl program by defining the
environment variable RM_DYNAMIC_LIBRARY_TRACE. The listing will indicate which Terminal Interface
support module is used, only the terminfo module is included with Visual COBOL. The Automatic
Configuration File module is not included with Visual COBOL. This information is most helpful when
attempting to diagnose a problem with support modules.

Note: The information will be visible only if you enter the recoverl command without any parameters.
In this case, recoverl will show the proper form for the command and the list of support modules.

The recoverl program attempts to recover the indexed file in place; that is, the program rebuilds the
internal file structure in the actual file being recovered. If necessary, the Key Information Block (KIB) is
rebuilt and any corrupted data blocks are repaired. Corrupt data blocks may result in loss of some data
records. Because of this feature, it is strongly recommended that you either backup the file or copy the
indexed file to be recovered to some other directory or pathname as additional security. Any records that
cannot be successfully reindexed into the file due to invalid duplicate key values, or invalid record sizes,
are decompressed (if compression is selected for the file), converted to the native code set, and then
written to drop-file. recoverl should be able to handle most kinds of indexed file corruption problems, but
some fatal errors may still cause the recovery to fail. Any fatal error is displayed and causes the program to
terminate. Broken hardware should be suspected in many of these cases.

drop-file can be in fixed- or variable-length format; this is set by recoverl based on whether indexed-file is
fixed- or variable-length format. Records placed in drop-file were those undergoing change at the time of
the system failure that required recovery or have invalid record sizes. Investigate any records appearing in
drop-file and make the appropriate corrections to indexed-file.

The four phases of processing

The recoverl program’s processing consists of up to four separate phases, which are run in the following
order:

1. Integrity Scan. If the Q option or Y option is specified, the Integrity Scan phase is disregarded unless it
is forced to occur by the specification of the | option or L option. This phase reads the entire file in a
forward direction checking for simple errors, and produces a summary report showing the state of the
file and an estimate of the number of records recoverl can recover. The indexed file is not modified
during this phase.

2. Repair Blocks. The Repair Blocks phase, which is always run, reads and writes the file in a backward
direction repairing corrupt data blocks, converting non-data blocks to empty blocks, and rebuilding
some internal file structures.

3. Move Data Blocks. The Move Data Blocks phase is run only when the truncate file

option (T) is specified. This phase reads and writes parts of the file moving highnumbered data blocks
(near the end of the file) to lower-numbered available blocks to maximize the amount of space at the
end of the file that can be truncated and returned to the operating system when recoverl finishes.

4. Build Node Blocks. The Build Node Blocks phase, which is always run, reads data blocks and writes
node blocks in the file in a forward direction, rebuilding the entire node structure for each key of the file.
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Note:

» After the Integrity Scan phase, if the Estimated Recoverable records value is zero or very low, and
the number of corrupt data blocks is very close to the total number of data blocks found, the
number of keys that allow duplicates may be incorrect, either because the KIB is corrupt or the
user provided incorrect key information to recoverl.

» After the Integrity Scan phase, if most of the blocks are invalid, the Disk Block Size or the Disk
Block Increment may have been incorrectly specified or the KIB may be corrupt.

« During the Repair Blocks phase, a count of blocks that could be read but not written may be
displayed. This count may indicate the presence of a hardware problem with your disk.

Recovery support module version errors

During initialization, the recovery utility locates and loads various support modules, and, on UNIX, the
terminfo Terminal Interface support module. Also, at initialization, the recovery utility verifies that each
support module is the correct version for the recovery utility. If a support module is not the correct version,
the following message is displayed:

RM/COBOL: modulle-name version mismatch, expected 12.0n.nn,found n.nn.nn.

When the previous message is displayed, the recovery utility terminates with the following message:
Recoverl: Error invoking mismatched recoverl and support module.

Recovery example

An example run through the Indexed File Recovery utility is described in Figure 44 through Figure 47. The
recovery session is started in this example by the following command:

recoverl master.inx dropoutl

Figure 44 shows information about the file master.inx.

Under the name of the file to be recovered, a description of the state of the file is displayed. Any of the
following messages may appear:

« This file has not been marked as needing recovery!

* The Open For Modify Count for this file is not zero: count

« File has been marked as corrupted due to a previous error.

« KIB is corrupt. Using template file: template-file

« KIB is corrupt. Enter a template filename (press Enter for manual entry).

If the KIB is corrupt, and a template filename is not entered, recoverl will prompt the user for the required
KIB information before continuing.

If more keys exist than can appear on this screen, as many as possible appear, after which you are asked
if you want to see the remaining key descriptors. This continues until all keys are shown. You are then
asked to verify that this is the file you want to recover. Entering N terminates the program. Entering Y
continues the program.

Figure 44: Indexed File Recovery Utility: File Recovery Verification

Indexed File Recovery Utility
Recoverl for Visual COBOL
Indexed File: master.inx

This file has not been marked as needing recovery!

Disk Block Size: 1024 Minimum Record Length: 80
Disk Block Increment: 1024 Maximum Record Length: 80
Number of Index Blocks: 170 Number of Records: 150
Key Position Size Remarks
PRIME 1 8
1 9 8
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2 17 8 duplicates allowed
Is this the file you wish to recover (y/n)?

Figure 45 shows a summary of the information that is gathered during the file integrity scan.

You are then asked if you would like to proceed with the recovery process. Entering N terminates the
program. Entering Y continues the program. The “Average record length” is computed by adding the length
of all the records in the file and dividing by the number of records. The “Average data size” is computed by
adding the size that the record actually occupies in the file and dividing by the number of records. This size
allows you to determine how much your data can be compressed.

Figure 45: Indexed File Recovery Utility: recoverl Summary
Indexed File Recovery Utility
Recoverl for Visual COBOL
Indexed File: master.inx
Drop File: dropoutl

This file has not been marked as needing recovery!

Disk Block Size: 1024 Minimum Record Length: 80
Disk Block Increment: 1024 Maximum Record Length: 80
Number of Index Blocks: 170 Number of Records: 150
Phase: Integrity Scan Estimated Recoverable: 150
| Total | Total | First | Last |
Block Type | Found | Corrupt | Corrupt | Corrupt |
KIB | 1] 0| | |
Data | 102 | 0| | |
Node | 61 | 0 1 | |
Empty | 6 | 0 | | |
Invalid | 0 | 0 | | |
Unreadable | 0 | 01 | |

Average data size: 14, Average record length: 80
Do you wish to proceed with recovery (y/n)?

Figure 46 shows the information that is displayed while recoverl is rebuilding the node blocks for the prime
key.

Figure 46: Indexed File Recovery Utility: recoverl Statistics
Indexed File Recovery Utility
Recoverl for Visual COBOL
Indexed File: master.inx
Drop File: dropoutl

This file has not been marked as needing recovery!

Disk Block Size: 1024 Minimum Record Length: 80
Disk Block Increment: 1024 Maximum Record Length: 80
Number of Index Blocks: 170 Number of Records: 150
Phase: Build Node Blocks Estimated Recoverable: 150
Key being processed: PRIME
Records recovered: 100
Records written to drop file:

Block being processed: 13
Number of data blocks moved (for truncate): 5

Figure 47 shows the information that is displayed after recoverl terminates successfully. The two lines
regarding truncation are shown only when the T option is specified.
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Figure 47: Indexed File Recovery Utility: recoverl Finished Successfully
Indexed File Recovery Utility
Recoverl for Visual COBOL
Indexed File: master.inx
Drop File: dropped

This file has not been marked as needing recovery!

Disk Block Size: 1024 Minimum Record Length: 126

Disk Block Increment: 1024 Maximum Record Length: 126
Number of Index Blocks: 120 Number of Records: 100
Phase: Build Node Blocks Estimated Recoverable: 100

Key being processed: PRIME

Records recovered: 100

Records written to drop file:

Block being processed: 120

Truncate option specified - number of data blocks moved: 4

Truncate action successful - new Number of Index Blocks: 112

Recovery successful.

In the example shown in Figure 48, the KIB of the file has been corrupted, and key information must be
entered for the file to be recovered. This example shows manual entry of KIB information, however, it is
recommended that a template file be used with the -K option to recover the KIB information. Underlined
characters have been entered by the user.

The recovery session is started by the following command:
recoverl master.inx dropoutl -k

Note: Entering incorrect information about how many keys, or which keys, can have duplicate values
may cause unpredictable results.

Figure 48: Indexed File Recovery Utility: Entering Key Information
Indexed File Recovery Utility

Recoverl for Visual COBOL
Indexed File: master.inx

Last error was 98,38 at 9:29 on 03-21-2008

Are any of the keys in this file segmented (split) (y/n)? y
Key #: PRIME Segment #: 2 Starting Position? 10 Length? 5
Another Segment (y/n)? n
Total Key Length = 13 Duplicates Permitted (y/n)? n
Another Key (y/n)? n

Figure 49 shows an example of entering the remainder of the KIB information. Underlined characters have
been entered by the user

Figure 49: Indexed File Recovery Utility: Entering KIB Information

Indexed File Recovery Utility
Recoverl for Visual COBOL
Indexed File: master.inx

Last error was 98,38 at 9:29 on 03-21-2008

Minimum Record Length (in bytes)? 80

Maximum Record Length (in bytes)? 80

Disk Block Size (in bytes)? 1024

User Block Size (1=none/2=in bytes/3=in records)? 1

Data Compression (y/n)? y Space Character Value? 32 Zero Character
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Value? 48

Key Compression (y/n)? y Space Character Value? 32

File Version Number (0/2/3/4)? 4 Atomic 1/0 Enabled (y/n) y

File Lock Limit (in GB)? 2

Disk Block Increment (in bytes)? 1024

Allocation Increment (in blocks)? 8

Force Write Data Blocks (y/n)? n Force Write Index Blocks (y/n)? n
Force to Disk (y/n)? n Force File Closed (y/n)? n

Code Set (1=none/2=ASCI1/3=EBCDIC)? 1

Collating Sequence (1=none/2=ASCI1/3=EBCDIC)? 1

Is this information correct (proceed with recovery) (y/n)? y

After the key and KIB information has been successfully entered, the recovery process proceeds the same
as before, beginning with Figure 44. If a template file had been specified on the command line or a
template filename had been entered when prompted, the screens prompting for the key and KIB
information would not have been displayed. A template file must be specified if the KIB is corrupt and the
file uses either an enumerated code set or an enumerated collating sequence.

Recovery program error messages

Error status initializing file manager

recoverl was unable to initialize the RM/COBOL file management system for the reason indicated by
status. The usual cause for this error is that a buffer pool has been configured that is too large to be
allocated. See the BUFFER-POOL-SIZE keyword of the RUN-FILES-ATTR configuration record for
instructions on changing the buffer pool size.

Truncate option not supported

recoverl detected that the truncated function was not supported on the system when the user requested
file truncation. Truncation of the file is not possible.

recovery terminating - no records recoverable!

recoverl detected corruption in the indexed file and no records could be recovered. In this case, recoverl
terminates at the end of the integrity scan to protect the user from erroneously deleting all the records from
the file. This error may indicate that the block size, the block size increment, or the number of keys that
allow duplicates has been incorrectly specified, or the KIB may be corrupt.

Error status on template file

recoverl was unable to initialize the RM/COBOL file management system for the reason indicated by
status. The usual cause for this error is that a buffer pool has been configured that is too large to be
allocated. See the BUFFER-POOL-SIZE keyword of the RUN-FILES-ATTR configuration record for
instructions on changing the buffer pool size. recover 1 detected an error in the KIB of the template file
specified by the user. The user may enter another template file, may enter the KIB information manually, or
may enter a Ctrl- C to terminate recover 1.

Cannot write near end of file - check "ulimit"

recoverl detected that blocks near the end of the file can be read but not written, but other blocks of the file
may be both read and written. This error may indicate that the operating system file size limit (ulimit) may
be smaller than the size of the file. Set the file size limit correctly or use an account with sufficient privileges
and run recoverl again.

Compatibility with XML Extensions

XML Extensions has many capabilities. The major features support the ability to import and export XML
documents to and from COBOL working storage. Specifically, XML Extensions allows data to be imported
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from an XML document by converting data elements (as necessary) and storing the results into a matching
COBOL data structure. Similarly, data is exported from a COBOL data structure by converting the COBOL
data elements (as necessary) and storing the results in an XML document.

For more information about XML Extensions, refer to the XML Extensions User's Guide, available from the
SupportLine section of the Micro Focus Web site.

For RM/COBOL users that utilize XML Extensions, here is a summary of compatibility issues that you need
to be aware of when working in this COBOL system. Refer to this list and the RM/COBOL Conversion
Issues list in the Compatibility with RM/COBOL section

Click a summary title for a fuller explanation and workaround, where possible.

Additional Parameter Required with XML Extensions Processing Statements
In statements that use a Document Pointer parameter, you are also required to pass an additional
Document Length parameter.

When using XML Extensions processing statements, each Document Pointer parameter must be
immediately followed by a Document Length parameter. This applies to the following statements:

« XML EXPORT TEXT

« XML IMPORT TEXT

« XML TEST WELLFORMED-TEXT
XML VALIDATE TEXT

« XML GET TEXT

e XML PUT TEXT

¢ XML TRANSFORM TEXT

f Note: XML FREE TEXT does not require that you use the Document Length parameter.

Solution:

Ensure that the Document Length parameter (MY-DOCUMENT-LENGTH) is specified immediately
following the Document Pointer parameter (MY-DOCUMENT-POINTER) when calling an XML Extensions
processing statement:

When the statement is outputting data, the statement will set MY-DOCUMENT-LENGTH:

XML EXPORT TEXT
MY-DATA-1TEM
MY-DOCUMENT-POINTER
MY-DOCUMENT-LENGTH
""MY-MODEL-FILE™.

IF NOT XML-OK GO TO Z.

When the statement is inputting data, you must set MY-DOCUMENT-LENGTH before the statement is
processed:
XML IMPORT TEXT
MY-DATA-1TEM
MY-DOCUMENT-POINTER
MY-DOCUMENT-LENGTH *> ltem size MY-DOCUMENT-POINTER points to.
"*"MY-MODEL-FILE™.
IF NOT XML-OK GO TO Z.

COBOL programs using BIS

Programs in this COBOL system that are used with the Xcentrisity Business Information Server (BIS) must
end with the GOBACK statement, not the STOP RUN statement. Also, messages for the BIS trace log
must be generated by calling the B$Trace library program, not the DISPLAY statement.

Programs that are used with the BIS must not use the STOP RUN statement, as this will terminate the MF
run-time prematurely and the BIS will be unable to process any further web service requests.
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In RM/COBOL, programs that are used with BIS capture the output of a DISPLAY statement and place it in
the BIS trace log. In this COBOL system, to place messages in the BIS trace log, use the B$Trace library
routine.

Solutions:

To ensure that programs used with the BIS do not prematurely terminate the MF run-time, use the
GOBACK statement in those programs.

To place messages in the BIS trace log, call the B$Trace library program, using the same identifiers or
literals, but not figurative constants, that you would use in a DISPLAY statement.

i Note: Numeric data items can be of any data type and are converted to a numeric string by B$Trace.
call "B$Trace™ using "Log message: " MyMessage " " MyStatus.

Conflicts Between Model File-names and XML Data Files
In this COBOL system, model file-names, as created by the compiler, are of the form program-name.xml.
You should ensure your XML data files do not share the same name as this, to avoid any conflicts.

In this COBOL system, if the ModelFileName#DataName parameter does not include a hash, it is always
treated as a model data-name, and the model file-name is assumed to be program-name.xml for the
program (or one of its callers) that executed an XML Extensions export or import statement. With this in
mind, if you do not explicitly set a model file-name, you should ensure that your XML data files do not
share the same name as your COBOL programs when performing import and export XML Extensions
statements.

Solution:
To avoid conflicts between model file-names and XML data file-names, do one of the following:

« Ensure you set the DocumentName parameter in your import and export statements to a name other
than your COBOL program name.

< If you want to keep your XML data file-names the same as the program-name, rename the model file-
name after compilation and specify the new name in the value of the ModelFileDataName parameter
before the hash, separating it from the ModelDataName.

When using the second technique, it is recommended that the compilation be done with a script that
includes the renaming command, to avoid forgetting this step.

Notes:

In RM/COBOL, you can use the environment variable RM_MISSING_HASH to determine the meaning of
the ModelFileDataName parameter when the hash is omitted. In this COBOL system, the environment
variable is not supported.

Also, RM/COBOL v12 and later generally did not use model files because the model was embedded in the
object program file; this COBOL system is more like RM/COBOL v11 and earlier, which always used model
files. Thus, care must be taken to distribute model files with applications that use XML Extensions.

Creating an XML Model File
To create an XML model file for use with XML Extensions, compile your application with the XMLGEN
Compiler directive.

By default, this creates an XML model file, named out put - nane .xml, that includes data descriptions
from the File Section of your code. This file is created in the project's root directory.

Note: The output-name defaults to the root name of your program source file, but you can change it
in the project's properties.

There are two parameters to this directive that enable you to alter the default behavior:
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To change the location of the model file, specify:
XMLGEN(pat hnane)

where pathname is the absolute or relative path name of the .xml file, which is prefixed to the default file
name. You can also use an environment variable, which will resolve to a path name during runtime:

XMLGEN ($myXML/)

where myXML is an environment variable set to the absolute or relative path name of the _xml file, which
is prefixed to the default file name.

To include data descriptions from the Working-storage section in the model file, specify:
XMLGEN(ws)

See Restricted data items with XML Extensions for a workaround to include data descriptions from other
Data Division sections of your source code.

When using both parameters in your program, ensure you set XMLGEN(pathname) before you set
XMLGEN(ws); otherwise, XMLGEN(pathname) suppresses the XMLGEN(ws) option, which results in only
File Section data descriptions in the XML file.

Displaying the Status of XML Extensions Statements

In this COBOL system, use the XML-Status-Edited data item to display the status result of an XML
Extensions statement execution.

In RM/COBOL, XML-Status, the data item used to display the status result of an XML Extensions
statement execution, is defined as Display Usage. In this COBOL system, XML-Status is defined as:

03 XML-Status PIC S9(4) COMP-5.

Therefore, an additional declaration is made in lixmldef.cpy, so that you can easily use the status result in
your code:

03 XML-Status-Edited PIC +9(4).

When an XML Extensions statement is executed, the value of XML-Status-Edited is not set, so you need
move XML-Status to XML-Status-Edited before you can use the result.

Importing and Exporting Ambiguous Data-names

In RM/COBOL, if you attempt to export an ambiguous data-item to a model file, an error is produced. If you
attempt to import to an ambiguous data-item, the data is placed in the first occurrence of the named data-
item.

In this COBOL system, if you attempt to export an ambiguous data-item to a model file, a warning message
is produced and the first occurrence of the named data-item is exported. Similarly, If you attempt to import
to an ambiguous data-item, a warning message is displayed and the data is placed in the first occurrence
of the named data-item.

Example:
01 GroupO1.
02 GroupA.
03 Numltem PIC s9(b).
03 Stritem PIC X(5).
02 GroupB.

03 Numltem PIC s9(5).
03 Stritem PIC X(5).

<Strltem> ABCDE </Strltem> *> this produces a warning and
updates Stritem in GroupA

<GroupB><Stritem> ABCDE </Striltem></GroupB> *> this updates
Stritem in GroupB
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Invalid Characters in Condition Names
In this COBOL system, if you use mark-up characters as values for condition names, this can produce
invalid XML when exporting code using XML Extensions.

Mark-up characters, such as "<", ">" or "&" used in the values for condition names will produce invalid
model files when using XML Extensions. The model files will cause parse errors when loaded by XML
Extensions using the XML parser; XML Extensions will report the parse error and be unable to perform the
requested export or import.

88 cond-name VALUE "<br/>".

Solution:

In this COBOL system, you must modify the COBOL source code, to eliminate mark-up characters in
condition-name values.

Restricted data items with XML Extensions
In this COBOL system, you cannot use data items described in any section other than the File or Working
Storage Sections, as model data names.

To export data items from or import XML data into this COBOL system, use the XMLGEN Compiler
directive to create a model file, for use with XML Extensions.

The model data names specified in the model file are determined by XMLGEN:

« XMLGEN with no parameter specified produces model data names for data items/structures in the File
Section only.

*  XMLGEN(ws) produces model data names for data items/structures in the Working Storage Section
only.

v+, Important: Data items/structures described in the Linkage Section, Communication Section, Local-
= Storage Section and Thread-Local-Storage Section cannot be used as model data names in a model
file.

Solution:

Using a copybook containing your data items, compile a dummy program that copies the descriptions into
the Working Storage section, and then use the XMLGEN(ws) Compiler directive to create a model file
containing the required data items.

Notes:

The data items used at runtime when the model file is used can be in any section of the data division.

Unable to Use Data Items Declared in Nested Programs
In this COBOL system, you cannot use data items declared in nested programs, as model data-names.

Solution:

Using a copybook containing your data items, compile a dummy program that copies the descriptions into
the Working Storage section of your top-level program, and then use the XMLGEN(ws) Compiler directive
to create a model file containing the required data items.

User-names Longer than 127 Bytes are Truncated

In RM/COBOL, you can specify user-names (data-names, procedure-names, program-names, etc) up to
240 characters long. In this COBOL system, user-names longer than 127 bytes in length are truncated and
a warning message is produced.
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Solution:

Results may be affected if the truncated user-name is used with XML Extensions, to export or import XML
documents; therefore, we recommend that you keep user-names to 127 bytes or less.

Using the Correct Calling Convention

In this COBOL system, XML Extensions uses the standard COBOL calling convention. If your programs
are also using the standard library routines implemented for RM/COBOL compatibility, you need to be
aware that these are called using the 1024 calling convention.

Solution:

Generally, you should explicitly use the 1024 calling convention when calling your RM/COBOL standard
library routines, but if you are using the DEFAULTCALLS Compiler directive to set this calling convention,
you will need to override it when calling to XML Extensions.

Native COBOL compared with managed COBOL

Native COBOL and managed COBOL differ in how they compile and how the run-time management
services, such as security, threading and memory management are provided.

Managed COBOL for JVM compiles to Java bytecode, and native COBOL compiles to machine code. Both
managed and native COBOL can run on any platform when compiled.

For JVM managed code, the management services are provided by JVM. For native COBOL, the
management services are available in the operating system, and your code has to call the appropriate
services depending on the operating system. The management services enable seamless interoperation of
COBOL programs with programs in other JVM languages.

Building native and managed COBOL applications

You use the IDE to develop, compile and debug your applications, for both native and managed code. You
can write new COBOL code or you can recompile existing COBOL as managed or native code, potentially
without any code changes.

You can deploy and further debug the application under the run-time system provided by Enterprise
Server. JVM COBOL applications are deployed to the platform running the JVM.

Customer Feedback

We welcome your feedback regarding Micro Focus documentation.
Submit feedback regarding this Help

Click the above link to email your comments to Micro Focus.

Disclaimer

This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fitness for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.

Micro Focus is a registered trademark.
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